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FOREWORD 
 
This Handbook succeeds the popular publication The CDS/ISIS Handbook by the same 
authors which was published by the UK Library Association in 1994. 
 
Since then CDS/ISIS for Windows has appeared on the scene and many requests have been 
made of the authors and of UNESCO for something similar to help users of the Windows 
version. 
 
This Handbook has been produced at the request of UNESCO and is to be made available via 
the internet. 
 
We can do no better than recall the words of the late Giampaolo Del Bigio who stated in the 
foreword to the original Handbook:  

 
The authors have produced a handbook that is complementary to the official Reference manual. It 
explains in greater detail than a reference manual can the features on which a beginner needs to 
concentrate and it highlights a few more advanced points which are not too difficult for the beginner to 
grasp and which the more advanced user may not appreciate. 

 
In short we feel that this applies equally to this new Handbook and we are proud to be able to 
contribute to the promotion of the world’s most widely used bibliographic information 
retrieval package. 
 
Andrew Buxton 
Alan Hopkinson 
London,  2 August 2001 
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PREFACE 
 
• AIMS OF THIS HANDBOOK   
 
UNESCO's CDS/ISIS for Microcomputers is one of the most widely used information 
retrieval packages in the world. In India where it is distributed free-of-charge by the 
Department of Scientific and Industrial Research there are thought to be several thousand 
users. In the United Kingdom it is used by libraries as different as the British Library for 
Development Studies, the Commonwealth Secretariat, the International Maritime 
Organization, Middlesex University, the Marine Biological Association and the Tate Gallery. 
Museums and archives are using the package to record their collections. Library schools are 
using it in their teaching programmes.  
 
Many users of the package – and even potential users – have regretted the lack of a user-
friendly manual. There is, of course, the Reference manual1 published by UNESCO and 
supplied with the package, but the current English edition was developed at the same time as 
version 1.3 and has to be updated with WINISIS - Supplement to the Reference manual: 
versions 1.0 to 1. 32 and CDS/ISIS for Windows - version 1.4 January 2001: notes and format 
examples3. With this Handbook, our main aim is to provide the novice user with the 
information needed to start using CDS/ISIS for Windows. We have followed the structure of 
our previous publication The CDS/ISIS handbook (for the DOS version: now out-of-print) 
which was well received. This Handbook will also be suitable for those users who have 
established CDS/ISIS databases, but wish to extend their competence in the software. As with 
all user manuals written by others than the developers, a different approach from the 
supplier's manual will give the reader new ideas, so many existing users will benefit. We 
have not forgotten the more experienced user and from time to time we include more 
advanced hints. Many of these are not difficult to understand or implement but they may not 
be easily gleaned from the Reference manual. We have placed these texts in boxes; the 
beginner may therefore ignore them as not being essential for a straightforward use of 
CDS/ISIS. 
 
We have also included chapter 11 "Programming with CDS/ISIS" as an introduction to ISIS 
Pascal and the extended formatting language. Although writing Pascal programs is for the 
advanced user, a large number of Pascal programs are now available.  
 
Some words of warning: this handbook is a user manual for the librarian or any other non-
computer professional who needs to set up a CDS/ISIS system.  It may as noted above be of 
interest to the advanced user and we hope that computer professionals coming to CDS/ISIS 
for the first time will find it useful.  It is not intended as a work of scholarship but as a 
practical guide, so we have not attempted exhaustive references, though in Chapter 14 there is 
a selective list of further reading material. We have not covered the need to be consistent in 
the use of index terms, such as subject index terms or personal or corporate names in 
bibliographic records since in our experience most users are librarians who are very much 
aware of the need for this. Nor have we included a separate section on the general theory of 
setting up databases since the points are included in the appropriate sections dealing with the 
software. We have also included sample applications in Chapter 13. 
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• CONVENTIONS USED IN THIS BOOK 
 
In the text we have emboldened filenames, folder names and menu choices. Special keys on 
the keyboard like 'Enter', 'Tab', 'Page Up' or function keys (usually labelled F1 to F12) are 
written in this book in braces, i.e. {Enter}, {Tab}, {Page Up}, and {F1}. Do not 
type the braces or type E-n-t-e-r! {Alt} is always pressed at the same time as the following 
letter which will be shown within the braces thus {Alt c}. Buttons or words to click on are 
also in bold. Other text you type in is in shown in the Courier font. If we are suggesting you 
make a choice from the menu bar followed by a further choice we show the name of the 
choices in bold and follow each with the ⇒ sign. 
 
In some places in the text, the vertical bar is used which is printed like this: |. It may appear 
on your screen or printer as a broken line or continuous line.  You can check how it appears 
on your screen by holding down the {Alt} key and typing 124 on the numeric keypad.  If 
you cannot find the right key on the keyboard, use this method to type it. 
 
 
 
REFERENCES 
 
1. CDS/ISIS for Windows Reference manual (version 1.3), Paris, UNESCO, 1998. 
2. Winisis - supplement to the Reference Manual: versions 1.0-1.3. Paris, UNESCO, 
November 1998 
3. CDS/ISIS for Windows - version 1.4 January 2001: notes and format examples. Paris: UNESCO, 2001
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1 INTRODUCTION 
 
1.1  VERSIONS OF CDS/ISIS FOR DOS AND WINDOWS 
 
CDS/ISIS for Windows is an information retrieval package developed by UNESCO (the 
United Nations Educational, Scientific and Cultural Organization) which runs under 
Microsoft Windows. Version 1.4 (release 19) was circulated on CD-ROM to distributors in 
March 2001 and is dated January 2001. This followed version 1.3 which appeared in January 
1999 and was the first formally-released version of the package, though beta-test versions had 
been available to existing licence holders for some time. Version 1.0 was released in 1998 but 
was only a beta-test version. 
 
The version referred to in this handbook is release 19b which is available to licence holders 
from UNESCO’s FTP site and which corrected some bugs in release 19. 
 
The package has many features which distinguish it from commercially-produced software. 
To understand why, it is necessary to look at the history of the package.  
 
CDS/ISIS for Microcomputers was released by UNESCO in 1985. It was called officially 
CDS/ISIS Mini-Micro Version but is usually called CDS/ISIS or simply ISIS. In Latin 
America, where the minicomputer package MINISIS (developed in Ottawa, Canada, by the 
International Development Research Centre) is prevalent, the original DOS version was 
always called Micro-ISIS; the Windows version is called Micro-ISIS or WINISIS. 
 
1.1.1 CDS/ISIS FOR DOS 
 
The first version of the package consisted in effect of five programs which were run 
separately, but which acted on the same database. One program included data entry and 
information retrieval and the remaining corresponded to the other options on the main menu 
of later DOS versions, Sorting and Printing, Data Base Definition, Masterfile Services and 
System Utility Services. 
 
In 1988 version 2.0 was released. It was little more than an amalgamation of the different 
programs into one but with the addition of Pascal programming to enable additional functions 
to be added to the basic package. 
 
The next public release was version 2.3 which included improvements in the speed of the 
indexing and in the space used by the indexes. This was achieved in part by setting up two 
indexes, one for short and one for long terms. At the same time the package was made more 
resilient; hitherto a database could be irreparably corrupted if a power failure occurred while 
a record was being entered. The database then had to be restored from the previous back-up. 
This changed because from version 2.3 the files containing a database are closed after each 
record is modified or added.  
 
A further feature from this version onwards was syspar.par, a system parameter file. The 
program checks values in this as soon as it is loaded. It allows sets of files used by the 
program to be placed in different folders. The program can be set to open in any language for  
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which a menu is available or to start up in any particular database. It also permits in the case 
of the DOS version a Pascal program to be loaded and run before the main program itself.  
Further information on this file is found in Section 3.2. At the same time as syspar.par was 
introduced, it became possible to set up a parameter file for each database so that the separate 
files which make up the database can be allocated to different folders, drives or devices. The 
initial reason for the introduction of this feature was to enable CDS/ISIS to be used as the 
search software for CD-ROM databases. CD-ROM is a read-only device and CDS/ISIS 
requires that certain files should be capable of being written to. These files have to be placed 
on the hard disk of the computer (they can be copied from a CD-ROM): the large files 
containing the data and indexes remain on the CD-ROM. 
 
The syspar.par file also allowed CDS/ISIS to be run on a network, and version 3.0 was 
released in May 1992 as a 'network sensitive' version. Under version 2.3 it was possible to 
run the software on a network, by specifying certain parameters of syspar.par as being 
network drives. However, a network allows multi-user access, and files could be corrupted if 
two users tried to make changes to the same database at the same time. An individual record 
would certainly be corrupted if two users tried to update it at the same time. This problem 
was overcome with the introduction of record locking and database locking in version 3.0 
onwards. 
 
As CDS/ISIS was developed, new Pascal routines and functions were used in its compilation 
and were added to a Pascal programming library.  
 
One important use of Pascal was for enhancing the print formatting language. This has been 
retained in ISIS for Windows. Users can develop their own Pascal programs to undertake 
functions which are not in the core program.  
 
1.1.2 CDS/ISIS FOR WINDOWS 
 
Since 1989, when most new microcomputers were supplied with a new operating system 
called Microsoft Windows, it was inevitable that the users of CDS/ISIS would call for a 
Windows version, and UNESCO began to develop one in 1995.  
 
Unlike the DOS version, ISIS for Windows is not written in Pascal but in a combination of 
languages, primarily C and C++. Following the philosophy of the DOS version, a program 
library is available of programs which can be utilized in the user’s own routines in a similar 
way to that in which Pascal was used in the DOS version. BIREME (the Latin American and 
Caribbean Center for Health Sciences Information) has cooperated with UNESCO in 
developing this 'library' and a Dynamic Linked Library (ISIS_DLL) is available containing 
these routines.  This can be downloaded from the BIREME website at http://www.bireme.br. 
 
1.1.3 WWWISIS 
 
Mention of BIREME obliges us to note the existence of a version of CDS/ISIS which allows 
CDS/ISIS databases to be searched in client / server mode, the 'server' being a web-server and 
the 'client' a personal computer running any web-browser: Netscape and Microsoft Internet 
Explorer are the most common. Little experience is required by the user of the client to 
search the database but the setting up of the WWWISIS software on the server requires 
technical skills which will usually be found in organisations which have their own a 
connection to the internet and hence in-house expertise in computer systems and software. 
WWWISIS relies on a print formatting language which is a combination of the CDS/ISIS 
language and Hypertext Markup Language (HTML). Beyond that, the setting up of the  
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database is quite different though it operates with data which have originated from a 
CDS/ISIS database for DOS or Windows. BIREME, incidentally, rewrote the original DOS  
version in the C programming language and developed C-ISIS on which they based their 
work for ISIS_DLL and WWWISIS. 
 
1.1.4 JAVAISIS 
 
JavaISIS is another method of client / server operation which allows access to a CDS/ISIS 
database on any machine attached to the internet even if it not a webserver. It requires the 
WWWISIS server from BIREME to be on the same machine. Information on this is found at 
http://web.tiscalinet.it/javaisis/. 
 
1.1.5 OTHER VERSIONS 
 
UNESCO has produced versions of CDS/ISIS for VMS and UNIX operating systems. VMS 
is now obsolete, but the UNIX version is well used. We are not here covering any other 
version than the Windows version.  
 
 
1.2  GENERAL OVERVIEW OF CDS/ISIS FOR WINDOWS 
 
CDS/ISIS for Windows is, as its name implies, a Windows-based system. Windows programs 
have many distinctive features as a result of the Windows operating system. Microsoft 
Windows is described as a graphical user environment which gives you more control over 
the way you work as well as enabling you to use more of the power of the computer. It allows 
you, for example, to run more than one program at the same time. Thus it allows you to have 
more than one CDS/ISIS database open. Your work appears in a window which may be 
enlarged, diminished, activated or put on hold whilst other windows are opened and programs 
there run. Because more than one program may be available on the screen it is possible to 
transfer data or images from one to another. As well as using the computer's keyboard, the 
user can employ a mouse to move windows around the screen and to activate or de-activate 
windows. Within a Window there are drop down menus also activated by the mouse. A 
number of drop-down menus are accessible from the bar at the top of each window. They are 
accessed by a single click of the mouse with the pointer controlled by the mouse on the 
relevant word at the top of the window. Alternatively pressing the {Alt} key and keying the 
underlined letter in that word will 'open' the menu. 
 
From the early development of the DOS version, CDS/ISIS was developed for bibliographic 
information, i.e. information about documents such as books, journal articles or conference 
proceedings. Usually each record in the database contains information about one document. 
Many of the features of CDS/ISIS are different from those in database management systems 
which have been designed for general purposes. 
 
Technically speaking, the major differentiating feature of CDS/ISIS when compared with 
other database management systems is in its use of variable length text fields. Data in 
database management systems are entered into fields. In many database management 
packages such as dBase or Microsoft Access, the fields are of fixed length. It is easier to 
design a system where fields are fixed length and for many applications that is not a problem. 
For a personnel system, the attributes of an individual in the system can be abbreviated to fit 
the space available, or codes can be used. For a financial system, codes can be used for  
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commodities and their number or value can be stored in a limited number of digits, and so 
variable length data is not a requirement for those systems. 
 

 
Figure 1.1 Program with drop down menu 
 
Bibliographic data tend to be treated differently from other kinds of data, with less recourse 
to abbreviation. Moreover, titles of books and other works which are contained in a 
bibliographic record may be of any length, from one word to many. As a result, a method has 
to be found of allowing variable length fields, which many database packages do not permit. 
This is done by means of a directory, which is also found in the ISO 2709 format2 and in the 
MARC and other formats based on it (see Section 1.8). At the beginning of each record is a 
list of fields and pointers to the position of the data belonging to each field. 
 
Another feature of bibliographic data is the need for repeatable fields. One book may have a 
number of authors. Each author needs to be of equal status. Many bibliographic databases 
implemented on general database management systems have one field for 'authors'; all 
authors are entered in one field, but only the first is searchable. In CDS/ISIS, each attribute 
which has more than one value is entered in its own field. In other words, each field may be 
repeated – up to 999 times. 
 
Bibliographic data may make extensive use of subfields. This facility is available in the ISO 
2709 format, and CDS/ISIS has implemented it too. It is a very useful feature when a field is 
divided into different parts to be treated in different ways. An author's name may appear in an 
index as Smith, John, but sometimes it might be desirable to print it out as John Smith, for 
instance when producing data in different reference styles. 
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Subfields enable the different parts of the name to be separately manipulated. They are 
designated by a single letter and when entering data in CDS/ISIS, you prefix this letter with a 
circumflex, ^. Thus you might enter the name Simon Maxwell as ^aMaxwell^bSimon.  
The system can treat both parts separately and may print them out in either order, place 
punctuation between the parts, capitalize one part and not another, and so on. The exchange 
formats mentioned above include rules for the formulation of fields and subfields. 
 
Critics of subfields say that they are difficult to enter. However, CDS/ISIS for Windows has a 
useful help facility which can display for any individual field on a data entry worksheet two 
lines of help message at the foot of the Data Entry window. Subfields are of great benefit to 
the organization and manipulation of data. They enable repeated data elements to be 
associated correctly with other data elements. If forenames and surnames were entered in 
separate fields, the software would require a more complicated mechanism to associate each 
forename with the corresponding surname. 
 
CDS/ISIS uses inverted files to enable faster searching of the database. An inverted file is just 
another name for an index. The expression refers to the fact that the records are turned inside 
out to bring different elements from the contents to the fore in a file. 
 
It is possible to index each field in a number of ways using different indexing techniques: the 
complete field, each individual subfield, or each word. There are also two indexing 
techniques which index text enclosed by <...> or /.../. This flexibility in indexing is not 
normally found in database management systems. 
 
In addition, it is possible to search for a string of data in any field, or to search for fields with 
a numerical value greater than, less than or equal to a particular value. You can also search 
for those records containing or lacking a particular field. 
 
A further feature of the package is the flexibility of the screen and printed displays. This is 
achieved by a sophisticated algebra-like formatting language. The formatting language has 
been criticized for its complexity and unfriendliness but we try to show in chapter 5 that this 
is not too complex even for the user who is not very computer literate. (We mentioned above 
that this can be extended by the use of a Pascal language, since a Pascal compiler is contained 
within the package.) The formatting language serves a number of purposes in addition to its 
function of providing instructions for screen display and printout.  
 
(i) It is used to specify the rules for the extraction of data from the database records to go into 
the index. 
 
(ii) It is used for the extraction of data for export to another database or for converting 
records to a MARC format if data have not been entered precisely according to the rules of 
that MARC format. 
 
(iii) It is used as the basis of the search language to provide the package with a very powerful 
free text searching feature, including the searching on values mentioned above.  
 
(iv) It is used in the creation of statements in a validation file for data entry validation. Note 
that this was introduced into CDS/ISIS for Windows and is not available in the DOS version. 
 
This formatting language gives users of CDS/ISIS a higher level of control over their data 
than is found probably in any commercial library automation package. 
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Another important feature, considering that the program is the product of UNESCO, is the 
multi-lingual nature of the package. Text on menus and worksheets can easily be changed by 
a proficient user. Message files are stored as databases and can be edited in the same way as  
other databases. They can be changed to make use of different terminology or adapted to 
different languages. 
 
It is not necessary for users to know about the technical features of the package in order to 
use it (and this handbook is not aimed primarily at the user with a high level of technical 
knowledge). However, it does help since a broad understanding of specialist terminology can 
be beneficial particularly when things go wrong. (Happily this is not very often for users who 
use CDS/ISIS in a straightforward way). 
 
1.3  RECORD STRUCTURE AND RECORD LINKING 
 
Each database includes a masterfile and cross-reference file. The masterfile contains the data 
and the cross-reference file includes for each record, by sequential master file number, a 
pointer to where the data belonging to that record occur in the Master file and indicates 
whether that record is used, unused or deleted, whether it may need to have its entries in the 
inverted file updated and whether the record is locked. Database records are numbered from 1 
but the system also has in each database, invisible to the user, a record 0 which holds control 
information about the database, such as the next record number to be assigned to a new 
record and whether the database is a normal database or a message file. 
 
CDS/ISIS includes features to allow it to function well in a multi-access environment. These 
require a certain level of technical understanding to comprehend them, but if you have a 
network or are using Windows in a sophisticated way, the network manager or technical 
support staff will be aware of their implications. One thinks mainly of networks, but when 
running a personal computer under an operating system like Microsoft Windows, it is 
possible to start the program, leave it in the middle, and start the program again so that it is 
running more than once simultaneously. The main features that make this possible are record 
locking and database locking. Record locking prevents more than one user from accessing a 
record to edit it. If it were possible for more than one user to edit a record at the same time, 
chaos could arise as editing is performed by copying the record into the local workstation, 
and the version ending up would be the version of the record that was completed the latest. 
Database locking prevents a user from accessing a database when certain system functions 
are being performed such as inverting the file. This is necessary because if a record was 
edited during a full inversion, it could result in a loss of integrity for the index being created, 
since the file inversion looks at each record a number of times during its operation. 
Sometimes problems arise with locking, and CDS/ISIS for Windows has utilities which can 
help you then which are described in Section 3.4.3. 
 
UNESCO produced a special version of the DOS package for databases on CD-ROM (called 
ISISCD) which allows read only, and includes the facilities to search and retrieve and to sort 
and print from the database. This can also be used on a multi-user system to prevent 
unauthorized editing of the database. These restrictions can also be applied to CDS/ISIS for 
Windows and are achieved by means of parameters in the syspar.par file as described in 
section 3.4.2.   
 
The DOS program from version 3 onwards and the Windows program both operate on the 
same database structure. A database can be set up to allow access from both versions and 
users may choose their preferred method of accessing the functions available. Indeed, early 
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versions of CDS/ISIS for Windows did not contain Database Definition Services; databases 
therefore had to be developed under the DOS version though all other functions were  
available in the Windows version. If you cannot find the Database Definition Wizard denoted 
by a light-bulb icon, make sure you have the latest version of CDS/ISIS for Windows. 
 
1.4  THE WINDOWS VERSION: THE MAIN MENU 
 
At this point we are assuming that CDS/ISIS for Windows has been loaded on your computer 
(as described in Chapter 3) and that the machine has been switched on and Windows is 
running. Open the CDS/ISIS for Windows program by clicking on the WINISIS icon. This 
will run the program and display the main menu. 
 
Let us look at the drop-down menus from left to right. 
 
Database leads to the functions associated with a database. In other Windows programs, this 
would usually be F for File. 
 
If you have just opened the program by clicking on the WINISIS icon, you will have only 
four options, Open, New, Printer Setup and Exit. Other options are greyed out as shown in  
Figure 1.2. You will see them in a light shade of grey in contrast with the black of other 
menus. This is a convention used by most programs which run under Windows which 
indicates that that option is not at that time available. There may also be a list of the last five 
databases open on which you may also click to retrieve one. These will always be in black. 

 
Figure 1.2 Opening screen with database drop-down menu 
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You open a database by choosing Open, or the icon on the very left of the tool bar, a picture 
of an open card file. This brings up a Window entitled File Selection (Figure 1.3). This is in 
the usual Windows format giving the possibility of browsing through drives and folders to 
find the appropriate 'file name' which will be an mst file or a par file. It will be set to the 
folder named in parameter 4 of the syspar.par: this is described in section 3.2. When you 
have clicked on a database to open it, all options under Database will become accessible as 
in Figure 1.1. You will see at the same time as a database is opened that more icons appear on 
the tool bar. 

 
Figure 1.3 File selection window 
 
 
Close and Close All are self explanatory and result in the closing of one or all databases. The 
other functions which become available are Import, Export, I/F Update (i.e. Inverted File 
Update) and Print. Print is conventionally found on the left hand drop down menu in 
Windows applications and the other options here are for file maintenance, adding to a file, 
extracting a file and indexing the database. Exit will close the CDS/ISIS for Windows 
program and take you back to the Windows desktop. 
 
Browse ({Alt b} from the menu bar) has nine functions which cannot be operated unless 
a database has been opened. Click on Database to view the records in a database in database 
order. Click on Search results... to go to a list of previous searches from where you may  
view the records retrieved by any earlier search in that session. You may mark any records 
that you view. Then you can click on Marked records to view only those that have been 
marked. Or you can revert to all records retrieved by selecting All records. You may open 
the dictionary by clicking on Open dictionary to see which terms have been indexed in 
which fields (Figure 1.4). Split/Unsplit view allows you to toggle with the lower portion  
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Figure 1.4 Dictionary open  
 
showing either the display in ASCII characters only or the print format specification. Print 
current page will print the record you are viewing though may not always print it quite how 
you see it on the screen. Zoom In and Zoom out will make the font larger or smaller. Along 
with Search, this menu is equivalent to Information Retrieval Services in CDS/ISIS for DOS.  
 
Choose Search {Alt s} and you will have access to two kinds of search, Expert Search 
or Guided Search. It also allows you to go back to a previously saved search (the search may 
have been saved at any previous occasion) Recall saved search or to save the results of the 
present search for future use: Save search. Close Search Window is no mystery: it allows 
you to close the expert or guided search window when you wish to look through the records 
you have retrieved. 
 
Edit {Alt e} is the gateway to Data entry and modifying the database structure. (If you are 
running in read only mode, you will not have access to this menu.) Data entry functions are 
accessed by Data entry to call up the Data Entry window which lets you edit the record you 
were looking at in the browse or search window or lets you create a new record. Delete will 
delete the record you are looking at in the data entry window. You can also copy the record 
you have on screen into the Windows clipboard with Copy to clipboard or clear the 
clipboard by choosing Clear clipboard.  
 
From this drop down menu, you can modify the database you are in via the Field Definition 
Table or Field Selection Tables. You can also edit or add new Print Formats. 
 
Configure {Alt c} allows you to change the language of the menus and other features of 
the database including removing the ability to edit a database from the menus, to make the 
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database read-only for that user. (The ability to read and write to the database will return next 
time the software is run.) You can also change many other system settings. 
 
Utilities {Alt u} includes global additions and deletions based on record number or a 
previous search. Also included is the facility to compile ISIS/Pascal programs (in CDS/ISIS 
for Windows these are all print format programs). You can also export records to an XML 
file and unlock databases or records. These unlocking functions will be greyed out and 
inaccessible if Data entry is open. 
 
Windows {Alt w} allows the windows open to be arranged on the screen. This is the usual 
Windows program facility. The windows on the screen may be arranged from left to right 
(horizontally) one above the other (vertically) or cascaded (one above the other but 
diagonally offset so that all may be seen in part and the top one in full). 
 
Finally there is a Help drop down menu in the usual Windows style with a contents list and a 
keyword search. At the time of writing, the Help text is considerably lagging behind the 
current version. 
 
1.5  AVAILABILITY OF CDS/ISIS 
 
CDS/ISIS is protected by copyright and is in no way shareware or public domain. It can be 
used legally only by licence holders. This licence is not as restrictive as some commercially-
produced software packages, in that multiple copying of the software is permitted within an 
institution that is a licence holder. Nevertheless, the software should not be copied to persons 
or institutions which are not licence holders. When once a licence is obtained, it is valid for 
all versions, so new versions may legally be obtained from any source. 
 
UNESCO does not distribute the software from its website. 
 
Although UNESCO are overall responsible for the development of the CDS/ISIS package, 
they have appointed distributors throughout the world to assist in supplying it to those who 
wish to use it. These distributors are in many cases national focal points for UNESCO's 
Intergovernmental Programme for the General Information Programme. If you write to 
UNESCO for a copy of CDS/ISIS and are in a country with a national distributor, your 
request will be forwarded to that distributor. News of distributors is published in UNESCO 
Information and Informatics Division UNISIST Newsletter1 which is available from 
UNESCO and there is a list on UNESCO’s website at http://www.unesco.org/ 
webworld/isis/distributors.htm. You can usually discover who is your distributor from the 
person or organization who told you about the software or alternatively write to UNESCO 
(address in Section 14.4). We are not giving a list of distributors in this Handbook due to lack 
of space and the fact that distributors are subject to change.  
 
As well as national distributors, there are distributors for organizations in specific sectors; 
these cover such areas as agricultural information and energy information. These distributors 
will also require you to sign a licence before they can supply a copy of the CDS/ISIS 
software. 
 
Distributors may distribute the software on CD, floppy disk or via file transfer (FTP) from 
their computers. Please note that a distributor may supply the package with languages other 
than the five languages English, French, Spanish, Italian and Latin American Spanish in 
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which it is distributed by UNESCO. Versions are also available for Arabic and CJK (Chinese, 
Japanese and Korean) and Cyrillic.  
 
1.6  SOFTWARE CONTRIBUTED BY USERS 
 
We have already mentioned the Pascal programming feature which is extremely important to 
the development and use of the DOS version of CDS/ISIS. Both DOS and Windows versions 
of the package include a Pascal compiler; in the case of the Windows version it can be used 
only for format exits: see Chapter 11 for more information 
 
Programs written by CDS/ISIS users to be used in conjunction with the DOS version have 
been made generally available. Some are offered for sale. Others are printed in journals or 
circulated at user group meetings. The result is that many sophisticated library automation 
packages have been designed, built on the basic framework of CDS/ISIS for DOS. Packages 
are now being developed based on CDS/ISIS for Windows and ISIS_DLL. Chapter 11 offers 
an introduction to format exits written in Pascal for CDS/ISIS for Windows.  Chapter 12 
shows you how to customize the package and includes information on other language 
versions and Chapter 13 includes some CDS/ISIS applications. Chapter 14 includes a list of 
sources of useful addresses. 
 
 
1.7  USER GROUPS 
 
Many user groups have been set up world-wide. These are listed at 
http://www.unesco.org/webworld/isis/cds_isis_sites.htm and are also reported from time to 
time in the UNISIST newsletter1. Given that support from UNESCO is necessarily limited, 
participating in such a group is of great benefit to the user and provides a measure of security 
in the event of problems. Since these are very much country-based and contact points and 
officers for the groups are constantly changing, we have not included them here and 
recommend that you find information on them from the World Wide Web.  
 
To find out the most up-to-date information, there is an electronic mailing list run by Melqui 
Vargas Rivera from Chile, Henk Rutten from the Netherlands and Raymond Gimilio from 
France. It is known as the CDS/ISIS Mailing List and is hosted by SURFnet. 
  
Users from around the world exchange information about any issue ranging from the simple 
to the more complex areas of CDS/ISIS like the writing of Pascal programs and problems in 
the formatting language. 
 
If you are on the internet, you can subscribe to the CDS/ISIS list by sending a message to: 
 
LISTSERV@NIC.SURFNET.NL 
 
with the following message in the main text: 
 
SUBSCRIBE CDS-ISIS Firstname Lastname 
 
The host computer will pick up your email address and add it to a 'mailing list'. You may 
receive more information than you expected!! 
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There are also specialist lists for other aspects of CDS/ISIS such as ISIS_DLL and 
WWWISIS. 
 
 
1.8  EXCHANGE FORMATS 
 
The term 'format' occurs so frequently throughout this Handbook that we have decided to 
explain it in this introduction. The term 'format' is used in many different ways in computing 
in general. In data processing, particularly in information retrieval packages like CDS/ISIS, it 
has two specialized uses. A format is an arrangement of data, and in CDS/ISIS it refers both 
to an international exchange format, especially one that is a standard format for the exchange 
of data between systems and to the layout of data as seen by the user on the screen or in 
printed form, called a print format or display format. Both these kinds of format are, in the 
bibliographic data processing field, governed by standards. 
 
UNESCO through the Information and Informatics Division and its predecessors including 
the General Information Programme has as part of its remit the promotion of library and 
information services and systems, internationally and nationally within its member states. 
One way in which it achieves this is by the promotion of appropriate standards. The UNISIST 
Reference manual3 was devised as an international standard format for the exchange of data 
between abstracting and indexing services on the lines of the MARC formats, which had been 
developed by national libraries. This was followed by the Common Communication Format 
which is now available for factual data and bibliographic data4. At the same time IFLA has 
developed UNIMARC5, an international format which enables exchange between users of 
different national formats. More recently MARC 21 (formerly known as US MARC) has 
been promoted as an international format6. The idea of these formats is that catalogue records 
may be copied from one system to another. Two organizations may share the production of 
records between them and even though they might have different software they can mount 
records from each other's databases on their own systems. 
 
All these formats are based on a standard record structure, ISO 27092. From the beginning, 
CDS/ISIS implemented this structure and owes a number of features to this standard. Each 
record as it is stored on the database contains a directory to tell the system where each field is 
found, which is based on the same principle as the ISO 2709 record directory. 
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2 OVERVIEW OF WINDOWS 
 
2.1  INTRODUCTION 
 
Your microcomputer runs two kinds of software: operating system software, which is usually 
bought with the machine, and applications, which you usually buy individually depending on 
what you want to use your machine for. Examples of applications software are Microsoft 
Word for word processing, Lotus 1-2-3 for spreadsheets, and dBase III or Microsoft Access 
for database management. Most of this book is about applications software, the package 
CDS/ISIS for Microcomputers, but it is helpful to know something about operating systems 
first.  
 
CDS/ISIS for Windows, as its name implies, runs under Microsoft Windows. It will run 
under Windows 3.1 or 3.11, Windows 95, Windows 98, Windows 2000 and Windows NT. 
Windows in all its different versions is a graphical user interface or GUI. This is 
distinguished from the earlier method of interfacing or interacting with computers which was 
by typing commands at a screen prompt.  
 

 
Figure 2.1 MS-DOS prompt beneath access route to the prompt 
 
This is still available on computers running Windows but is less user-friendly than the 
graphical user interface and not commonly used. If you wish to use the command line 
interface in machines running under Windows 95 onwards, you have to run the MS DOS 
prompt. Point the cursor to the Start button by moving the mouse and click the left mouse 
button; click on Programs and a list of programs appears on the screen. Move the mouse 
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over MS-DOS prompt so that it changes colour and press the left mouse button. (In this 
handbook, we will abbreviate this set of procedures to 'Select Start ⇒ Programs ⇒ MS-
DOS prompt'.) You will see on the screen a window with an MS-DOS prompt as in Figure 
2.1. To leave this, type exit and the window will close. 
 
Windows, however, makes your computer easier to use than that so you should try and stay 
with the Windows tools rather than using MS-DOS. Windows owes its name to the fact that 
you run each program in a separate 'window' on the screen. Each program may, indeed, open 
a separate window for different functions. You can move between one program and another 
without having to stop one program before starting the next. You can run a word processing 
program and edit more than one document at the same time; you can run a database program 
like CDS/ISIS and have two databases open at the same time. You can also transfer data from 
one program to another by cutting and pasting material from one window to another. We will 
tell you how to do this later in this chapter. 
 
This handbook describes the use of CDS/ISIS on microcomputers which use the Windows 
operating system developed by Microsoft. There are also versions of CDS/ISIS for different 
operating systems: DOS which was the earlier operating system for Personal Computers; 
VMS (which is used on the VAX and Alpha models) and Unix, which runs on a variety of 
microcomputers and minicomputers. These versions are not dealt with in this book. The DOS 
version is covered in our earlier book The CDS/ISIS handbook (London: Library Association 
Publishing, 1994). 
 
Windows includes procedures for working with files: setting up files, arranging them in 
folders, copying them, editing them, deleting them, and so on. In Section 2.9 we look at how 
to use these procedures.  
 
2.2  DISK DRIVES  
 
First, it is necessary to understand a little about the hardware. Microcomputers are fitted with 
a floppy disk drive (which allows you to take data from floppy disks as required), a hard disk 
drive and a compact disk (CD) drive. The hard disk is not removable by the user and 
generally holds a lot more than a floppy disk. A CD drive can contain a CD with a large 
amount of information which is usually read-only and therefore cannot be changed by the 
user. 
 
Disk drives are referred to by letters. The first floppy drive is known as A and a second one 
(if fitted) is known as B. The hard disk drive is generally known as C. Sometimes it may be 
partitioned and will have a D drive as well. The CD drive will usually be D (if not already 
used) or E. There may be other large capacity removable disks as well at D or E. If your 
computer is connected to a network, you may have access to files on a file server which will 
be on storage devices allocated other letters. 
 
2.3  THE MOUSE 
 
One feature of computers which use Windows is the mouse, a small device enabling you to 
perform many actions. As you move the mouse around on your desk (or preferably on a 
mouse mat on your desk), a pointer moves in the same direction on the screen. Lifting the 
mouse does not move the pointer. If your mouse comes to the edge of the table, or is blocked 
by the computer, you can lift it up and put it down again where you have more room and 
continue moving the pointer in the direction you wish. A mouse has two or three buttons. In 
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Windows 3.1 you will use only the left button (unless you have configured it to use the right 
button for left handed users) - we will call this the main mouse button; in Windows 95 
onwards you usually use the left button but for some purposes the right button is used. 
 
Using a mouse requires the following actions: pointing: moving a pointer around on the 
screen; clicking - pressing and releasing the mouse button once (when you point to an object 
on the screen and press the left mouse button, that is called clicking and you select that 
object); double-clicking - clicking twice in rapid succession; and dragging - moving things 
around the desk top (holding down the main mouse button while moving the mouse). 
 
2.4  FILES AND FILE NAMES 
 
Computer disks hold programs and data in the form of files. For example, one file could hold 
a database program and another could hold a list of names and addresses. Every file has a 
name, which in Windows 3.1 can be up to eight characters. Although the names may be 
longer in Windows 95 onwards, it is best to keep file names to 8 characters when using 
CDS/ISIS. Upper and lower case letters are not distinguished by Windows, so sally, Sally, 
and SALLY would all refer to the same file. A file name can have an extension (limited to 
three characters in Windows 3.1), which can be used to indicate what sort of file it is. The 
extension is separated from the main part of the name by a full stop. Thus sally.doc might be 
a word-processed document, while sally.pas might be a program written in the Pascal 
language. 
 
The extension .exe is used for 'executable' files, that is programs in a form which makes them 
ready to run just by typing their names. The main program of CDS/ISIS for Windows is in a 
file called wisis.exe but you do not need to know this as you will normally start the program 
by clicking on an icon labelled CDS/ISIS for Windows, or WINISIS.  
 
 
2.5  FOLDERS 
 
A computer disk may contain hundreds or thousands of files. Files for different purposes 
could be jumbled together, but that would make the computer rather difficult to use. It is 
better to group related files together into folders (called directories in DOS). This is 
somewhat like arranging books in a library: you could have all the books mixed up, but it 
makes them easier to use if you separate them into categories such as fiction, biography, 
science, travel, etc. 
 
An obvious first step is to group files according to the application they belong to, such as 
spreadsheet files, word processor files, database files, etc. The files could be placed in folders 
called, for example, lotus, word, dbase.  
 
Just as the categories of books could be further divided into subcategories, e.g. fiction could 
be separated into novels, plays, poetry, etc., so folders can themselves contain other folders. 
We could have one folder on drive C to hold the application software and one to hold the data 
files which go with it, or perhaps folders for different types of data files. This is shown in the 
diagram below. 
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     C drive 
 
 
              
      System files                                  Program files                      Data files 
 
                                                            Word 
                                                                                              Documents      Databases 
 
 
Figure 2.2 Folders 
 
 
The structure can go down to further levels if required, for example Documents could have 
sub-folders such as letters, papers, faxes, etc. The top folder (into which files go if you do 
not set up any other folders) is sometimes known as the root folder. In the display from 
Windows Explorer (Figure 2.3) the root folder appears as ‘Model 16sp (C:)’ “Model 16sp” 
was the name given to this hard disk when it was formatted. 

 
Figure 2.3 C: drive as displayed in Windows Explorer 
 
 
When you are using an application such as CDS/ISIS, there is a default folder in which the 
program looks for and saves files unless you specifically choose otherwise. This is called the 
working folder. 
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2.6  FEATURES OF WINDOWS 
 
Windows like all specialisms has its own terminology. Desktop is the screen as presented to 
you when you have started up the computer (the background coloured green in figure 2.4); 
we deal with that in more detail later. 

 
 
Figure 2.4 Features of Windows 
 
We dealt above with other features of Windows that relate to the use of the mouse. Now we 
can deal with features that appear on the desktop which we will refer to later on. 
 
2.6.1 THE WINDOW BAR 
 
A Window has at the top a bar with the title of the activity or program represented in the 
window. 
 
If you click on this it makes the bar a different colour and activates that window if there are 
other windows open, one of which is previously activated. (You will see in the example in 
Figure 2.4 that 'Print setup' has been activated.) 
 
2.6.2 THE TASK BAR 
 
Versions of Windows 95 onwards have a task bar which is usually displayed at the foot of 
the screen but may be to right or left or at the top. The start button is on this bar. Any 
programs or windows currently open appear here and you can activate one by clicking on its 
button. 
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2.6.3 TABS 
 
A window may include 'tabs' designed by analogy with a card index where identifiers of a 
card can protrude above the general level of the top of the cards. You can click on a tab to 
select the dialog box to which it is attached. In Figure 2.4, these are shown as General, 
Presentation, Margins, Layout and Sorting. 
 
2.6.4 OTHER FEATURES OF THE BAR 
 
At the left of the bar you can see a miniature icon, usually a reduction of the larger icon on 
the desktop which indicates that that window can be opened (see the miniature of the CDS-
ISIS for Windows icon which appears at the left end of the CDS/ISIS for Windows bar and in 
a larger version at the bottom left-hand corner on the desktop reproduced in figure 2.4). Click 
on the small icon and you will get a drop-down menu of actions which duplicate icons 
elsewhere. 
 
At the right of the bar you can see some small buttons. There will be a square (as in figure 
2.4) or a smaller square overlapping another one. The square on its own means maximize and 
if you click on it the window will fill the whole of the screen or at least more of the screen. If 
you click on the overlapping squares the window will become smaller again. A line at the 
foot of the button means 'minimize'. The window will close and there will appear in place of 
it a small image of the program or program group on the task bar. 
 
Clicking on X will close the window. The application may ask you if you wish to save any 
data before closing it down. 
 
Additionally there may be a question mark button which when clicked will bring up a help 
function. 
 
2.6.5 MENU BAR 
 
This appears below the main bar, and includes names of menus. Most programs include File, 
Edit, View, Tools, Windows and Help. These options will be dealt with more fully for 
CDS/ISIS for Windows in later chapters.  
 
A letter in many of the options in underlined. If your mouse is not working you can press 
{Alt} and that letter to activate the dropdown menu. 
 
2.6.6 TOOLBAR 
 
On the next line you see a toolbar, with icons representing activities relating to the program 
running in the Window. These are program specific and the ones in CDS/ISIS for Windows 
will be explained in the appropriate chapters. 
 
2.7  DIALOG BOXES 
 
The way you supply information to a program running under Windows is through a special 
kind of window known as a Dialog box. The Print setup window in Figure 2.4 is an example. 
The window has a number of boxes and buttons for you to enter your information. The  
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technical name for these is controls and some of the important ones are described below. 
 
2.7.1 TEXT ENTRY BOX 
 
A text entry box is a box for entering text (any text you like) and the cursor is positioned at 
the point where what you type will appear. 
 
2.7.2 LIST BOX 
 
A listbox is a box where you can only choose from the list on the screen. (If it's a long list you 
may need to scroll.) An example is the choice of languages you get from Configure ⇒ 
Change language. 
 
2.7.3 COMBO BOX 
 
A combo box is a combination of a text box and list box - you can choose from a drop-down 
list or type the value in yourself. When you open the form it shows only one value with an 
arrow button next to it, whereas a list box shows all the values with the chosen one 
highlighted (so it takes more space). Combo boxes are therefore much more commonly used 
than list boxes. 
 

 
Figure 2.5 Combo box and scroll bar 
 
2.7.4 COMMAND BUTTONS 
 
A command button carries out some command when you click it, such as Print or Exit. When 
it is highlighted (made darker) this indicates that it is the default option – the one that is most 
likely to be the one you need, or even the only one. Pressing {Enter} will carry out the  
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command as will pointing and clicking with the mouse. Pressing {Tab} will usually 
highlight the next button if there is more than one. Some buttons may be harder to see with 
lettering a very close shade of the colour of the button. We say they are greyed out and these 
options are not available to us at that point.  
 
2.7.5 RADIO BUTTONS 
 
A radio button is one of a set of two or more buttons representing choices. When you click 
on one of the buttons it will fill with a black dot to indicate that that is the choice you have 
made. Unlike check boxes, you can select only one of the choices. 
 
2.7.6 SPIN BOX 
 
A spin box is associated with a choice of a range of numeric values. Click on the up or down 
arrow to change the value or type it in the box. The tag is controlled by a spin box in figure 
2.5. 
 
2.7.7 CHECK BOX  

Figure 2.6 Check box  
 
 
Click on a check box and a tick appears, to indicate the associated text is selected. Here Don't 
clear current format will be implemented if the box is ticked. 
 
2.8  YOU NEED TO KNOW!... 
 
We are going to concentrate on the commands required in Windows 95 onwards since most 
users have now abandoned Windows 3.1.  
 
2.8.1 LOGGING ON 
 
When you switch on the machine, you will usually be presented with a login screen. The first 
time you use the machine, if it is on a network, you will have been told what your login name 
and password are. Enter these. Otherwise, enter a username of your own choice, key {Tab} 
and enter a memorable password. Use these each time you want to use the computer. If your 
computer is on a network, things might be a little different from what is described here. Ask 
your computer manager or network manager for help if necessary. 
 
2.8.2 THE DESKTOP 
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After logging in you will be presented with the desktop. You will see some small labelled 
pictures called icons. Top left will usually be an icon named 'My computer'. Point to that and 
click and a window will open displaying icons representing drive A, drive C and possibly 
more. You can usually access and configure resources such as printers, the control panel and 
dial-up modem access from this window. Click on the cross on the top right corner of the 
window to close it. Looking at the desktop again, you will probably have an icon labelled 
'Recycle Bin' which holds any deleted files until it is cleared out. There may be other icons. 
There may be one titled CDS/ISIS for Windows if the package has been installed. 
Alternatively it may be listed under programs (see Section 2.8.4).  
 
2.8.3 THE START BUTTON 
 
At the bottom left of the screen (usually) you will see a Start button. Click on this and you 
will see a pop-up menu which displays Shut Down, Run, Help, Find, Settings, Documents, 
Programs, and possibly other options. 
 
2.8.4 THE PROGRAMS OPTION  
 
If you click on Programs you will see a list of programs available to you. CDS/ISIS for 
Windows may be there as a program or as a folder with the program in it. If it is not, go to 
Chapter 3 and read how to install CDS/ISIS. To run a program you double click on its icon. If 
you click on an icon which belongs to a word-processed file, the computer will try to run 
your wordprocessor and display the file ready to be edited in that word processor (see Section 
2.9.3). 
 
2.8.5 THE RUN OPTION 
 
Choose Run to type a command or to run a program which is accessible from your computer 
but not listed under Programs. If you don't know where the program is you can browse for it 
by clicking on browse. It might be easier to use Find first and then click on the program 
when it is displayed in the window. 
 
2.8.6 FIND 
 
If you select the Find button you can search for a file on your hard disk or on other attached 
storage devices such as a floppy disk. A text entry box appears entitled Named (see Figure 
2.7). Type in there the name of a file, wisis.exe or just wisis. The results will be as specific as 
what you type in the text box. If you typed in 's' you would get every file whose name 
included 's'. Under this text entry box you will see a drop-down menu  
indicated by a v-shaped arrow with text 'C’. Click on that and it will indicate other devices to 
look in. 
 
 
2.9  WORKING WITH FILES AND FOLDERS 
 
In order to work with files and folders which already exist, you need to find them and 
determine the folder structure. 
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Figure 2.7 FIND 
 
2.9.1 FINDING FILES: Find 
 
If you want to find a file you can use Find as described in Section 2.8.6.  
 
2.9.2 FINDING FILES AND FOLDERS: Explorer 
 
If you want to view the folder structure the best way is to use Windows Explorer. Choose 
Programs ⇒ Explorer and a window will open enclosing two separate windows. Select any 
folder in the left window and clicking on it will display any subfolders. The contents of the 
current subfolders will display in the right-hand window along with their name, and 
optionally their size, type and date of creation or latest modification. See Figure 2.3. 
 
2.9.3 DISPLAYING THE CONTENTS OF A FILE 
 
If the file is a text file or created by a program which is on the computer you can click on it 
and it will be opened by the appropriate program, such as Wordpad or Notepad or a word 
processor. You can then change the file and save it again in its new form. 
 
You may want only to view it, not to change it. Follow the same procedure but be careful not 
to click on a Save button if offered it. 
 
2.9.4 COPYING FILES 
 
In Explorer (or Find) click on Edit or click the 'other' mouse button (usually the left). Select 
copy. The file is now in the clipboard. Move the mouse to another folder unless you want to 
give the copy a new name. Choose Paste and a copy of the icon will appear. If that folder 
contains a file with the same name, you will be offered the chance to change it. The cursor 
will occur at the start of the name. If you press {Enter}, the new file will be called Copy of 
xyz if xyz was the original. 
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Sometimes it is necessary to copy all files from one folder to another. Click on the folder, 
Copy and Paste as you did with a single file. You can select all files with {Ctrl a}. Or 
drag and drop it into another folder. Point to it with the mouse and with the right mouse 
button held down move it to the folder you wish to contain it. A new subfolder will be 
created. If you want to copy a selection of files, so long as they are adjacent in the display, 
point to the first, hold down the {Shift} key and point to the last. They will be highlighted. 
Select Edit and Copy and move the pointer to the desired folder and select Paste. You can 
select non-adjacent files using {Ctrl} and clicking on the filenames. 
 
2.9.5 MOVING FILES 
 
Moving files is as for copying, but select Cut rather than Copy from the Edit dropdown 
menu. Then remember to paste them or else they will disappear into your Recycle bin with 
the danger of losing them unless you click on the bin and follow instructions. 
 
You can open Explorer more than once to make it easier to copy files from one folder to 
another. 
 
2.9.6 DELETING FILES 
 
As for move, but use Cut only. Or you can select Delete from the list which is displayed 
when you point to a file and click the right mouse button. 
 
2.9.7 RECOVERING A FILE FROM THE ‘RECYCLE BIN’ 
 
It is usually possible to 'recover' a file after it has been deleted, especially if you take action 
straight away since it is accessible through the ‘recycle bin’. Click on the recycle bin icon and 
click on Restore. The files may be deleted by the user (click with the right mouse button on 
the recycling bin icon and select Empty recycle bin. Your computer will empty it 
automatically if it needs to make more space when the hard disk is almost full.  
 
2.9.8  EDITING TEXT FILES 
 
It is sometimes necessary to create or edit text files. For example, if you want to stop certain 
words from being indexed you have to make a text file which lists these words and which is 
known as a stopword file.  
 
Text files are sometimes referred to as ASCII files. ASCII stands for the American Standard 
Code for Information Interchange. This is a standard covering how characters such as 'A', 'm', 
or '6' are represented in a computer file. This standard makes it possible to pass data between 
different computers which use this standard (most do). However, the standard does not 
include codes for formatting instructions such as 'underline' or 'italic': you can put such 
instructions into text when you are using a word processor but their coding varies between 
different software packages. 
 
CDS/ISIS does not have its own program for creating text files. You can edit text files by 
choosing Programs ⇒ Accessories ⇒ Notepad. Type in the text of the file. If you want to 
copy, move or delete you can highlight text by dragging the mouse down holding the left 
button from start to finish of the text in question. It will appear 'highlighted' black on white 
instead of white on black (substitute for black and white the colours your screen is set to).  
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Then from the Edit menu select Cut to move or delete, Copy to copy. If you want to move or 
copy the text move the mouse to the point at which you want the text to appear and select 
Paste. You can also use {Ctrl x} to delete{Ctrl c} to copy and {Ctrl x} to paste. 
 
The text selected in this way by delete or copy is said to be on the Clipboard and will remain 
there until you Cut or Copy again or until you switch off your computer 
 
2.10  SWITCHING OFF YOUR COMPUTER 
 
Finally we should explain how to switch off your computer, since switching off a Windows 
computer in the wrong way can damage it. Make sure that you save any data files you may 
have been working on. It is a good idea to close all programs. Then, click the Start button 
and click Shutdown. 
 
You will then get a number of options. Selecting any of these options by clicking on the radio 
button will ensure that the current session is terminated without corrupting the data. 
 

Figure 2.8 Shut down  
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3 INSTALLATION 
 
If you are in a hurry to start running CDS/ISIS as soon as possible, read Section 3.3. Sections 
3.1 and 3.2 are intended for users who want to know what is happening during the installation 
process. Section 3.4 deals with installation on a network. 
 
 
3.1  FOLDER STRUCTURE 
 
The Windows version of CDS/ISIS is normally installed on a hard disk in a folder (directory) 
called winisis. As we have seen in chapter 2, the hard disk is usually referred to as C: so this 
folder will be c:\winisis. It is also possible to install the software on a network – see Section 
3.4. 
 
The package comes with over 200 files and these are usually installed into a number of 
subfolders of winisis as shown below. 
 

winisis 
 
 

bg ctl3d   data doc  menu   msg  plugin prog  work 
 
 
The winisis folder itself contains the main ISIS program, wisis.exe and an important 
parameter file, syspar.par, discussed in the next section. It also contains the help file, 
isishlp.hlp, a readme file with the latest release notes, and some configuration files. 
 
The bg subfolder contains about 30 bitmap (image) files used by the sample database 
provided. The subfolder called ctl3d contains two Dynamic Link Library files (with the 
filename extension .dll) of which more later. The data subfolder is intended to hold 
CDS/ISIS databases, and two are usually provided on the installation disks: CDS, which 
consists of 150 records from UNESCO’s Library database; and THES, which consists of 
about 20 thesaurus terms to show how a thesaurus system might be implemented in 
CDS/ISIS. Each database consists of at least 13 files with different file extensions, e.g.: 
 
 cds.mst The masterfile for CDS 
 cds.fdt  The Field Definition Table for CDS 
 cds.pft  The default print format for CDS 

cds.ifp  The inverted file postings for CDS 
 
There are also a few files whose names do not consist of the database name plus a file 
extension. acds.fmt is the first page of the data entry worksheet for CDS. In the DOS version 
of CDS/ISIS a worksheet could extend over several pages and these were named acds.fmt, 
bcds.fmt, ccds.fmt, etc. The database structure in the Windows version has been kept the 
same as in the DOS version. 
 
To start with, you can keep all your database files in the data subfolder, but if you have 
several databases they might be better in sub-subfolders, e.g. c:\winisis\data\cds. The 
Reference Manual explains how to do this with a dbn.par file in the data folder. With early  
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Windows versions of CDS/ISIS you could run into trouble if you put databases elsewhere 
without using a par file but this has been fixed in Version 1.4. 
 
The doc subfolder is intended to hold documentation files and the contents will depend on 
exactly which version you have. Documentation is discussed in Chapter 14. 
  
The menu subfolder contains the menu items in various languages used by CDS/ISIS.  They 
are held in CDS/ISIS databases with names like MNENDF (the English-language menus for 
the Full version) and MNITSH (the Italian-language menus for the Short version). If you are 
short of space on your disk and you want to work in only one language, you could delete the 
other files after installation. If you open one of the databases in CDS/ISIS you will find that 
each menu item is followed by a number or keyword in square brackets, e.g. 
 
 &Expert search[10113]. 
 
It is possible to change the wording of each item (keeping the same number or keyword) or 
indeed to create a completely new set of choices in another language. 
 
There are two other important files in this subfolder. isisuc.tab is a table for converting 
letters from lower case to their upper-case equivalents and isisac.tab defines the characters 
which are considered as alphabetic.  The Reference manual gives more information about 
these. 
 
The msg subfolder contains one database for each language. These databases contain all the 
messages which CDS/ISIS can give in that language, whether good news or bad. Record 90 
in MSEN, for example, contains the messages 
 

05: Unable to create the database. File already exists! 
and 

08: Data base has been created! 
 
You can edit the messages if you do not find them very friendly or informative (see Section 
12.3). You could also remove all the files for languages you do not need. 
 
The plugin subfolder is provided to hold plugin programs which will enhance the abilities of 
CDS/ISIS. However, it is empty when you first install Version 1.4 and implementing plugins 
is beyond the scope of this book. 
 
The prog subfolder is intended for holding additional Pascal programs to be used in 
conjunction with CDS/ISIS. The source code files have the extension .pas and the compiled 
files have the extension .pcd. The Windows version of CDS/ISIS can only run one type of 
Pascal program, called a Format Exit (see Section 11.2), and one example is included on the 
installation disks called isispt.pcd. 
 
The final subfolder is work and is used to hold workfiles created by CDS/ISIS. Some of these 
exist only during a CDS/ISIS session whilst others remain after you exit the program, e.g. hit 
files and intermediate files produced during the inversion process. It is a good idea to clear 
these out from time to time. 
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3.2  SYSTEM PARAMETER FILE, SYSPAR.PAR 
 
Fundamental to the working of CDS/ISIS is the system parameter file called syspar.par. The 
installation program will set up a standard version for you. However, the file gives a lot of 
flexibility in the way that CDS/ISIS is set up and if your requirements are not completely 
standard (e.g. installation on a network, or running two versions on the same computer) it 
would be useful to learn a bit about how it works. If you are familiar with ini files for early 
Windows programs, it is a similar idea. Quite a lot of the settings can be altered by choosing 
Configure ⇒ System Settings, and you do not even need to know the parameter number. 
 
The file itself has a number of lines, each of which sets a numbered parameter to a particular 
value, e.g. 
 
 3=c:\winisis\msg\ 
 
This means ‘parameter 3 is set to c:\winisis\msg\’. Note that there is no space before or after 
the equals sign. There must be a backslash at the end of the folder name. The parameters do 
not all need to be present (if not, default values apply) and do not need to be in numerical 
order. You can include comments if you wish by starting the line with a semi-colon, e.g. 
 
 ; The next parameter controls the default database. 
 
The Reference manual and the Supplement give details of many possible parameters (up to 
number 1005!) so only the most important ones are considered here. 
 
(a) Parameter 1: program path. This defines where the CDS/ISIS Pascal programs (with .pas 
or .pcd extensions) are located. It is normally: 
 
 1=c:\winisis\prog\ 
 
(b) Parameter 2: menus path. This defines where the menu files and the files isisuc.tab and 
isisac.tab are located. It normally reads: 
 
 2=c:\winisis\menu\ 
 
(c) Parameter 3: message path. This defines where the system message files (enmsg.*, 
frmsg.*, esmsg.*, etc.) are located. The usual value is: 
 
 3=c:\winisis\msg\ 
 
(d) Parameter 4: work files path. This defines where any work files are stored. The usual 
value is: 
 

4=c:\winisis\work 
 If it is not specified, the current folder is used. With networked installations, it is important 
to make sure that work files created by different users are kept in different folders. 
 
(e) Parameter 5: database path. This defines where database files are held. It normally reads: 
 
 5=c:\winisis\data\ 
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If you already have databases created with the DOS version of CDS/ISIS, you may wish to 
specify: 
 
 5=c:\isis\data\ 
 
 
If you want to run databases on the floppy disk drive, parameter 5 should read: 
 
 5=a:\ 
 
This is very useful for training courses; students can use their own personal floppy disks and will not be affected 
by any work that has been done previously by other course participants. 
 
(f) Parameter 6: default database name. If you generally use the same database, you can 
arrange for CDS/ISIS to load it automatically. This is done by means of parameter 6, e.g. 
 
 6=books 
 
 
If you need to alter one of the syspar.par settings that is not accessible from System 
Settings, you can use a text editor such as Notepad or Wordpad. 
 
 
3.3  LOADING THE PACKAGE 
 
The package may be distributed on CD-ROM or on two 3.5 inch disks called 'Disk 1' and 
'Disk 2’. If the distributor has included several sample databases or other programs, it may 
run to more disks, but there should be some instructions to explain what to do. 
 
The system requirements as stated in UNESCO’s documentation are an Intel Pentium 
processor, 16Mb of RAM, 10Mb hard disk space, 3.5 inch high-density floppy disk drive, 
and the operating system Windows 3.1, 95, 98, Me, NT or 2000. However, the authors of this 
handbook have successfully run a version for test purposes under Windows 3.11 on a 
computer with a 486 (not Pentium) processor. If your computer does not meet this standard, 
you should run the DOS version which will support a database compatible with CDS/ISIS for 
Windows (if you later upgrade). 
 
If you are installing from CD-ROM, place the CD in your drive and it should load 
automatically. (If not, run the program install.exe in its root directory.)  Then choose 
CDS/ISIS Version 1.4 from the menu. Note that if you have the CD-ROM containing Version 
1.4 build 19, this version has some bugs and you should download winisis1_4.exe from the 
UNESCO FTP site  (ftp://ftp.unesco.org/pub/winisis/windows/v1_4) to obtain some 
replacement files to correct them. 
 
If you are installing from floppy disks, insert Disk 1 in the floppy disk drive and run the 
program setup.exe. You can do this from the Run dialog box (enter a:\setup.exe), or from 
My computer or from Windows Explorer. 
 
In either case, you will be asked various questions about the installation: just click Continue 
if you are happy with the defaults. If you already have some CDS/ISIS databases from the 
DOS version, you should set the Default Database Directory (i.e. Folder) as appropriate – 
probably 
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 C:\isis\data 
 
With floppy disks, at the appropriate juncture you will be asked to insert Disk Number 2 and 
click OK. When all the files have been copied from both disks, click OK to accept the 
licence conditions. Hopefully you will be told “The setup process was successful!” and you 
can click OK to finish. 
 
If the shortcut (icon) for CDS/ISIS has not appeared, you can create one using the values: 
 
 Target:  c:\winisis\wisis.exe 
 Start in: c:\winisis 
 
Now you can try starting CDS/ISIS for Windows by clicking its icon. Quite likely you will be 
told that there are some files missing. In that case, copy (or move) the files ctl3d.dll and 
ctl3dv2.dll from the folder c:\winisis\ctl3d to the folder c:\windows\system (or 
c:\winnt\system if you are running Windows NT.)  You can do this with My Computer or 
Windows Explorer as described in Chapter 2. Programs other than CDS/ISIS use these dll 
files and the install program expects to find them already in the right place.  There can also be 
a problem with ctl3d.dll not being properly expanded during the installation program, which 
results in a message about being unable to run 16-bit programs.  In this case download 
ctl3d.dll file from the UNESCO FTP site mentioned above and copy it to the right directory 
(replacing the existing file if necessary). 
 
If you are running CDS/ISIS under Windows NT, you should right-click on the Winisis icon, 
left-click on Properties and then on Shortcut. Check the box against Run in Separate 
Memory Space. This should correct problems that can occur with parts of the screen display 
going blank when CDS/ISIS windows are opened and closed. 
 
Versions 1.31 of CDS/ISIS onwards came with a new style of displaying search results 
(described in Section 7.2). If you find it confusing, or you have got used to the old one and 
want to get it back, choose Configure on the menu bar, then System Settings, then Options. 
Click the radio button against Default search display and confirm the change. This has the 
effect of changing Parameter 980 of syspar.par back to 0. 
 
 
3.4  NETWORKING CDS/ISIS 
 
A PC network consists of a number of PCs connected by wires. Usually, one of the 
computers has a large hard disk and contains the programs and associated files used by the 
other computers; this is known as a fileserver. The computers using the programs on the 
fileserver are known as workstations. Data are stored on the fileserver if they are for use by 
everyone, otherwise they may be stored on the workstations or the server. Programs which 
may be run on networks have a facility for directing data to either the local hard disk drive 
known as the C drive or to the fileserver which may be designated any letter between D and 
Z. In the case of CDS/ISIS, this facility came in with the DOS version 2.3: the syspar.par 
file does just that. However, in version 2.3, problems would arise if two users attempted to 
update the same database at the same time.  
 
Version 3 allowed users to mount CDS/ISIS more effectively on a network by providing 
record locking and database locking, and CDS/ISIS for Windows works in the same way. 
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Record locking prevents more than one user from accessing a record at the same time and 
database locking prevents a second user from accessing the whole database. Record locking 
is operational during record entry whilst database locking is effective when records are being 
exported or imported. 
 
Record and database locking are controlled by parameter 14 of syspar.par. If parameter 14 is 
zero (or not specified) CDS/ISIS operates in single-user mode with no locking. When  
parameter 14 is set to 1, it operates in multi-user mode with full network support, i.e. it 
manages searching and updating of both the master and inverted file by two or more users. 
 
3.4.1 INSTALLATION ON A NETWORK 
 
CDS/ISIS should work on most types of networks. The DOS version was successfully tested 
on Novell, Windows for Workgroups, Windows NT, 3COM and Banyan Vines networks. 
 
To ensure CDS/ISIS functions correctly on a network you must: 
 
(a) set up the proper user access rights to the CDS/ISIS directories and files and ensure that 
these are shareable. 
 
(b) ensure that no two users have the same physical work files folder (as defined by 
parameter 4 of syspar.par). One way of doing this is to set parameter 4 to point to the local 
disk, e.g. 
 

4=c:\temp\ 
 

Alternatively, if your network software allows you to do so, you may establish a separate 
folder for each user on the server and map one of the workstation drive letters to it. For 
instance, Margaret may have her G: drive mapped to f:\users\margaret and this could be 
used for work files. 
  
(c) set parameter 14 in syspar.par and, if necessary, parameter 0 in the dbname.par of each 
shared database as mentioned above. 
 
The installation to the fileserver can be done in the same way as to a hard disk, but you would 
specify a folder on the server’s disk rather than your hard disk. You may need to have 
Administrator or Supervisor rights to be allowed to write applications to the server. 
 
If the installation is done to a folder WINISIS on the server F: drive, syspar.par will look 
like this: 
 
 1=f:\winisis\prog\ 
 2=f:\winisis\menu\ 
 3=f:\winisis\msg\ 
 4=c:\temp\ 
 5=f:\winisis\data\ 
 
The program will be run from F: (f:\winisis\wisis.exe) and syspar.par should be in the same 
folder as wisis.exe.  
 
Remember that parameter 4 should direct work files to a folder for which the user has 
exclusive use. CDS/ISIS creates a number of temporary files while it is being used. If these 
files are put into a shared folder, the system will try and create a file for one user that already 
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exists for another user. Since this is not permitted, the second user will be unable to run 
CDS/ISIS. Therefore, you should set parameter 4 to use a specially allocated folder on the 
fileserver or to use a folder on the workstation, e.g. c:\temp\. In either case, make sure that 
the folder already exists or the user will not be able to run CDS/ISIS. 
 
3.4.2 SEARCH ONLY CONFIGURATION 
 
If you are putting your database on a network, you may want some people (e.g. cataloguers) 
to be able to create and edit records but others (e.g. library readers) to be able only to search 
and browse the records. One way to do this is to install CDS/ISIS on the hard disks of the 
computers that are to have write permission but to use a networked copy on the computers 
that are to have only read permission. Alternatively you can use a password system with 
different passwords for the full and read-only versions (see Section 12.8). 
 
The choice Configure on the menu bar allows you to go to Change Profile, from where you 
have the options Full Version or Search Only Version. The Search Only version, as its 
name implies, allows for browsing, searching (in guided or expert mode) and exporting, but it 
does not allow data entry or modification of the database definition. It also cunningly 
removes the option to change back to the Full Version or to change language (which would 
allow access to another set of menus). So on a workstation that is to be read only, you can 
make this change and users will then not be able to alter your database. Unfortunately if you 
make this change from Change Profile it reverts back next time you open CDS/ISIS. To 
make the change permanent, you need to change parameter 102 in syspar.par using a text 
editor to read: 
 
 102=SH 
 
(SH is the short version, using the menu database MNENSH. DF is the default (long) version 
using the database MNENDF.) 
 
If you have a friendly network manager (or perhaps you are the network manager!) you could 
also arrange extra security by restricting permission to the database files for certain userIDs 
by means of the network operating system. But remember that all users must have write 
access for the folder holding their work files (specified in parameter 4 of syspar.par). 
 
 
3.4.3 DATABASES OR RECORDS LOCKED IN ERROR 
 
Should a system failure occur while a record or database is locked, it will remain locked 
afterwards.  
 
In Multi-user Mode, a message will appear if you try to undertake certain functions such as 
updating the inverted file whilst a database is locked. When you select Update in the Inverted 
File Maintenance dialog box, or when leaving a database, the update will not in fact take 
place. This message reads: 
 
 Permission denied: someone is performing Data Entry! 
 
If this happens repeatedly and you know that there is actually noone entering data in that 
database, then the database has become locked in error. Having checked that there is really no 
user accessing that database, choose Utils and Advanced Database Utilities. The Multi User 
Information dialog box will show you whether files or records are locked, and there are three 
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buttons – Unlock DBase, Unlock Recs, and Clear Entry Locks. The one needed in this 
example is Unlock DBase. 
 
 If you are attempting to edit, for example, record 1456 and you see the message 
 
 1456: Record is currently being updated by another 

user. Please retry later! 
 
you should make a note of the MFN, go to the Multi User Information dialog box   and 
choose Clear  Entry Locks or Unlock Recs as necessary. The second option allows you to 
unlock all records or one(s) specified by MFN. 
 
 
 

3.5  IMPORTING DATABASE STRUCTURES FROM OTHER INSTALLATIONS 
 
Quite often CDS/ISIS users want to take a copy of a database structure, with or without the 
data, from another installation. Although this is a fairly straight-forward operation, there are 
one or two things to be careful of. 
 
If the database has some records in it but is fairly small and fits on to one floppy disk, the 
easiest way is just to copy all the files associated with the database to the a: drive. You can 
use My Computer, Windows Explorer or the DOS xcopy command – whichever you feel 
happiest with. On the source computer, these files will probably be in the folder c:\isis\data if 
it uses the DOS version of CDS/ISIS or c:\winisis\data if it uses the Windows version. Go 
into that folder and check. As explained above, the database consists of at least thirteen 
separate files. If the database is called BOOK, for example, most of the files will have the 
name book followed by various extensions. However, the worksheet files have names like 
abook.fmt, bbook.fmt, etc. so make sure you copy those too. 
 
If you are using DOS commands, you must use xcopy rather than copy. This is because of a complication if 
you try to copy database files before any records have been entered in the source database. Using the DOS 
command dir, you can see that although the master file (e.g. book.mst) has a size of 512 bytes, five of the files 
(with extensions .n01, .n02, .l01, .l02, and .any) have a size of 0 bytes. If you use the copy command, these 
five files will not be copied on to the floppy disk and so will not reach the destination computer: when you try to 
enter the database, you will get an error message (possibly a General Protection Fault). The xcopy command 
copies all files, including those of size 0. 
 
There could be other files used by the database which have quite different names. For 
example, there could be display formats called SHORT, MEDIUM and LONG. You can find 
out what worksheets, display formats and Field Selection Tables are associated with a 
database by looking in the appropriate drop-down lists that you get when you choose Edit 
and select that type of object. 
 
When you have all the files on the floppy disk, you can transfer them to the correct folder on 
the destination computer. Again you can use My Computer, Windows Explorer or the DOS 
command xcopy. You will then have an exact copy of the source database. 
 
If you want to empty out the existing records, you need to reinitialize the database. This facility is built into 
CDS/ISIS for Windows version 1.4 but because it could be rather dangerous (wiping out years of cataloguing 
toil!) it is not included on the menus. If you do want to use it, you need to edit one of the Menu database records 
(perhaps record 2 which is the menu under Database) as in Section 12.2 and add a field : 
 
&Reinitialize database [11107]. 
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Save the record, close the Menu database, and exit from CDS/ISIS. When you go back in, you should find the 
choice Reinitialize database under Database. 
 
Make sure you are in the right database, then choose Reinitialize database. You will get a message box 
warning you “Database will be ERASED! ARE YOU SURE?”: answer Yes. This is followed by another 
warning that “There will be NO WAY to recover your data. Do you want to continue?”: draw a deep breath and 
answer Yes again. The data will then be cleared and you will have a database containing zero records. 
 
If the source database is very large, it will not fit on to one floppy disk. In this case you need 
to use a utility such as Winzip, which can split files across disks, use a larger-capacity 
medium such as a Zip disk or CD-R, or else transfer the files across a network (assuming that 
both PCs are connected). There is a Windows Backup program, but it may not have been 
installed on your computer and it is not easy to set up. 
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4   CREATING A DATABASE 
 
 
4.1  INTRODUCTION 
 
A database is usually constructed to store information about some things or persons. For 
example, a bibliographic database contains information about documents, such as journal 
articles or conference proceedings. A personnel database contains information about 
employees. The database consists of records and there is generally a one-to-one 
correspondence between the records and the things described. In a bibliographic database one 
record may correspond to one journal article: in a personnel database one record may 
correspond to one employee. 
 
In CDS/ISIS terms, a record is made up of a number of fields. Each field contains data about 
some particular aspect or attribute of the thing or person, for example the author, title and 
date in a bibliographic database, or the name, address and grade in a personnel database. A 
sample record from a bibliographic database is shown below. 
 
 ISBN:              0853658994 
 Authors:           Gredley, Ellen;  Hopkinson, Alan 
 Title:             Exchanging bibliographic data: MARC  

and other international formats 
 Imprint:           London: Library Association, 1990 
 Dewey class no.:   025.3028 
 
It is possible that you might need to store more than one value in a field − for example two 
authors in the record above. As explained in Chapter 1, CDS/ISIS has special provision for 
this by allowing fields to be defined as repeatable: the author field is repeated to contain the 
second author. 
 
CDS/ISIS also allows you to divide up fields into subfields: for instance the author field 
could be divided into subfields for surname and forenames, or an address could be divided 
into subfields for street, town, country, etc. Subfields are designated by a single letter and 
when entering data this letter is prefixed by a circumflex, ^. Thus the name Malee Siengthai 
might be entered as 
 
 ^aSiengthai^bMalee 
 
and an address might be entered: 
 
 ^a12 Ralph Bunche Road^bNairobi^cKenya 
 
If data are divided up like this, the user can specify different treatment of different parts of 
the field. For example, the surname could be made searchable but not the forename, or the 
town could be printed in capitals and the country omitted in a printout. 
 
Many of the standard bibliographic formats make use of subfields, but if you are a beginner 
at designing databases it would be advisable not to use them. Either the data in the field can 
be divided by punctuation such as commas, or separate fields can be used for the different 
data elements, e.g. one for street, one for town, and one for country if they need to be treated 
differently. 
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4.2  CHOICE OF TAGGING SCHEME 
 
Before you create a database with CDS/ISIS you need to decide on a format, i.e. what fields 
will be used and how you will record the data in them. The choice of fields is not final: you 
can modify them later. 
 
If you are setting up a database for the first time, it is a good idea to use a very simple format 
to gain some familiarity. For example, with a bibliographic database you could use nothing 
more than Author, Title and Year. 
 
There are quite a lot of 'standard' bibliographic and other formats existing, such as the 
national MARC formats, UNIMARC and the Common Communication Format. If you are 
contemplating exchanging data with other organizations, it would be a good idea to find out 
what they are using and to agree on a common format. However, if you expect to be quite 
self-contained you are at liberty to make up your own format to suit your own purposes. 
 
Each field in CDS/ISIS must have a numeric 'tag' to identify it. This is a number between 1 
and 999. If you are making up your own format you could number your fields 10, 20, 30, etc., 
so there is room to slot others in between them later. If you are using a data structure already 
set up by another CDS/ISIS user, please refer to 3.5. 
 
When you have decided on your format you can start up CDS/ISIS and choose Database ⎪ 
New.  You are then asked to give the database a name of up to six characters. (This limit is to 
maintain compatibility with the DOS version.)  Then choose OK. 
 
You will be required to complete four forms in setting up the database: 
 
• the Field Definition Table (FDT) 
• the Data Entry Worksheet 
• the Display Format 
• the Field Selection Table (FST). 

 
Fortunately you can summon an assistant to help you with some of these – especially if you 
are new to CDS/ISIS. 
 
 
4.3  FIELD DEFINITION TABLE  (FDT) 
 
The FDT defines the fields that may be present in the database and certain parameters for 
each field. You enter the values in the boxes at the top of the dialog box. In the DOS version, 
the FDT had little effect – you could repeat a field or enter subfields regardless of what the 
FDT said. The Windows version is much stricter and you need to be more careful about your 
definition (although you can always change it later). 
 
The boxes are as follows: 
 
(a) Tag -- see above. You can use the up and down arrows if you like to select the number, or 
type it in. 
 
(b) Name -- this is to help you identify the field. It can be up to 31 characters long and can 
contain spaces. When you come to set up the data entry worksheet, this name will be used as  
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the prompt for the field, but you can override it there. It is also used to specify the field in the 
“Guided Search” form. 
 
 (d) Type. Unless you can predict that the field will contain only letters (no spaces or 
punctuation) or only figures (no symbols or decimal point) it is best to leave this as 
Alphanumeric. The other possible values are Alphabetic or Numeric. The beginner is strongly 
advised to use Alphanumeric. 
 
(e) Rep[eatable]. If you want to allow multiple occurrences of this field, e.g. several authors 
or several descriptors, click this checkbox. 
 
(f) Pattern/subfields. If you are dividing the field into subfields, you should list the subfields 
here (without punctuation or spaces) e.g.  
 
 abc 
 
If you are not using subfields, press the ™ key to leave this box blank. Pattern fields are not 
supported in Version 1.4. 
 
When you have entered the data for each field, the focus will be on the Add button. Either 
click the button or press {Enter} to add the field to the table (displayed in the large box). If 
you need to correct the details for any field, just click on that entry in the large box and the 
details will be copied into the boxes used for editing. If you need to remove an entry, 
highlight it and click the Delete Entry button. You can alter the order of fields by selecting a 
field and clicking the up-arrow or down-arrow key: they do not have to be in numeric order, 
though that is usually clearest. An example of an FDT is shown in Figure 4.1. 

 
 
Figure 4.1  Example of a Field Definition Table (FDT) 
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After entering all the fields, click the button with the green arrow to go on.  
 
 
4.4  DATA ENTRY WORKSHEET 
 
You will enter data into the database using a worksheet, rather like an input form. Whereas in 
the DOS version of CDS/ISIS you had to specify a lot about the layout of the form, in the 
Windows version you need to do very little.  The main choice is which fields you want to be 
on the worksheet. If you only have one worksheet then normally you will want them all, and 
you need only to click the button with the double arrow to effect this. If you want to be more 
choosy, or to change the order of fields on the worksheet, you can select fields one at a time 
and either double-click the field or click the button with the single arrow. The order does not 
have to be by ascending tag number. 
 
You can make the worksheet do more by highlighting one of the Data Entry Fields (when you 
have moved some onto the worksheet) and clicking the button showing a pencil and paper. 
This brings up a dialog box with some further options: 
 
Description. This allows you to use a different name on the worksheet from the name you 
have used in the FDT.  
 
In an integrated database of books and research projects you might have a field for corporate name, used for the 
corporate author of a book or the host institution of a project. You could have two worksheets, one describing 
the field as “Corporate author” and the other describing it as “Host institution”. 
 
 Default value. If the field will nearly always contain the same value, e.g. 'eng' for language 
'English', you can put this in as a default value. It will then already be filled when you use the 
worksheet, but you can alter the value when it does not apply. 
 
Help. You may enter a 'Help' message for this field that will be displayed at the bottom of the 
data entry window when the user is entering data in that field. It is often useful to give an 
example, e.g. 
 
 Enter surname, comma, initials, e.g. Walton, C.J. 
 
Validation format. You can put in a rule to check the format of the data entered, e.g. the 
length must be a certain number of characters, or the field may only be present if another 
field is absent. The rule is written using the formatting language described in Chapter 5 and 
an example that might be used in the specification for field 110 is shown below: 
 

if p(v100) and p(v110) then 'You cannot have two main entries' fi  
 

The if expression p(v100) tests for field 100 being present and field 110 being present. It will 
cause a message box to appear after the user tries to enter data in field 110 if there is already 
a field 100 present. Data entry cannot proceed until the data are removed from field 110. 
 
Another easy kind of validation is to test that the contents of a field are the right length, e.g. 
 
 if size(v8) > 40 then 'Field 8 is too long' fi 
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However, if you make a mistake in writing a validation rule it may be impossible ever to 
satisfy it and you will never be able to get beyond this field in data entry. It is therefore not 
recommended for beginners. 
 
Pick-list definition. A pick-list enables the user to display a list giving a choice of values for a 
particular field during data entry. In the pick-list definition box you enter choice followed by 
two colons and a format that will produce the list. The first line produced by the format will 
appear as the title of the listbox during data entry. For example: 
 

choice::'Languages'/'English'/'French'/'German'/'Spanish' 
 
The values here are all unconditional literals. ‘Languages’ will be taken as the title and 
‘English’, ‘French’, ‘German’, and ‘Spanish’ will be the choices displayed as shown in 
Figure 4.2. 
 

 
 
 
Figure 4.2  Example of a pick-list  
 
The first box below the title is to allow the person doing data entry to search for a desired 
value: he/she can enter the term or the beginning of the term and click the button with the 
magnifying glass. 
 
You can allow the user to select more than one item from the list by using the multi keyword 
and repeat puts each value into a separate occurrence of the field: 
 

choice:multi:repeat::'Languages'/'English'/'French'/ 
'German'/'Spanish' 

 
Unfortunately at the time of writing there is a small bug in this part of the program and you 
may have to enter the data twice during data entry to get the desired result. An alternative is 
to specify that each value is enclosed in angle brackets: 
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choice:multi:<>::'Languages'/'English'/'French'/'German'/ 'Spanish' 
You will then need to index the field with Indexing Technique 2. 
 
If you follow a standard format for bibliographic records, you may wish to hold the language 
as a code but display the full name in the pick-list. This can be done using the firstdescribe 
keyword: each entry consists of its name followed by its code: 
 

choice:firstdescribe::'Languages'/'French'/'fre'/ 
'Portuguese'/'por'/'Spanish'/'spa' 

 
 
 
There are other more sophisticated possibilities in creating pick-lists, thanks to the list being 
generated by the CDS/ISIS formatting language. However, we will mention one final one: 
you can keep the list in a separate text file and give the file name here. Each line in the text 
file is treated as an entry in the list. 
 
 choice:files::'Languages'/'langs.txt' 
 
The possibilities described here can be combined, i.e. you can use several keywords separated 
by colons and the order does not matter, but remember to put two colons before the list values 
or file name. 
 
Pick-lists are not recommended for long lists (hundreds or thousands of terms) because of the 
processing time and memory limitations: a better solution is to develop a plug-in application 
using ISIS_DLL. 
 
 
OK. Click the OK button to go back to the Worksheet definition screen. 
 
 If you have entered any Data Entry Fields by mistake, you can remove them using the button 
with the left-pointing arrow. You can alter the order of fields on the worksheet by selecting 
the field to be moved and clicking the ↑or ↓ button. A validation rule applying to the record, 
rather than an individual field, can be entered by clicking the Record Validation button. For 
example in Format you could have: 
 
 if a(v200) then 'Record must contain a title.' fi 
 
This will generate an error message if the user has entered a record without any data in field 
200 and then tries to save it. Again caution is advised: a badly written rule may mean that you 
can never save the record. The use of Begin code and End code allows editing to be done 
automatically on the record when it is opened or closed in the worksheet, e.g. today’s date 
could be entered in one of the fields, but it is beyond the scope of this Handbook. 
 
When you have set up the worksheet, click the button with the green arrow pointing right. 
 
 
4.5  DEFAULT DISPLAY FORMAT 
 
The display format means the way that the records will appear when you use browse the 
database or display search results.  Display formats can also be used in producing printed 
output.  There must be at least one display format for the database and that must have the 
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same filename as the database. You can always create more formats, or modify existing ones, 
later. 
 
A message box appears asking “Do you want Winisis to launch the Print Format Assistant?” 
and you can choose Yes or No. If you are new to CDS/ISIS, or if you just want an off-the-peg 
format to save time, click Yes. You are then given the choice of five pre-defined formats. The 
order of fields will be the same as in the Field Definition Table. 
 
Normal style. This uses font 2 (normally Times Roman) and colour 4 (normally blue) and 
gives a display with the field names in one column and the data in the next. 
 
CDS/ISIS DOS compatible format. This is similar to the Normal style but it uses only black 
text and Courier font, and features which are within the capabilities of the DOS version of 
CDS/ISIS. 
 
Decorated format. Three fonts and various colours feature in the format. The record number 
(MFN) and the name of the database appear in a box and the field names appear in italics. 
 
HTML normal. This is a format using very basic HTML (HyperText Markup Language), the 
language used to create pages for the World Wide Web. No HTML tags are included to 
separate the contents of one record from the next. 
 
HTML table with headers. This again incorporates HTML tags and displays field names and 
their contents in the form of a table. 
 
Once the format has been created, it will be displayed in case you wish to edit it. The next 
chapter describes the formatting language in some detail, but just to give you a taste: 
 
(a) Fields are specified by using v (for variable) in front of the tag: thus v10 means 

display the contents of field 10. 
 
(b) Text between single or double inverted commas forms a literal and will appear in the 

display just as it is written. 
 
(c) The slash (/) means start a new line here. 
 
A simple format for a database containing fields 10, 20 and 30 could be: 
 

v10,v20,v30 
 

This would display field 10, immediately followed by field 20, immediately followed by field 
30, e.g. 
 
 Walton, C.Good office management practice1990 
 
To display the fields on different lines, they should be separated by slashes, e.g. 
 
 v10/v20/v30 
 
This would display the above example as: 
 
 Walton, C. 
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 Good office management practice 
 1990 
 
Unlike in the DOS version of CDS/ISIS, you can use carriage returns in the format to make it 
easier to read, e.g. 
 

'Author: ' v10/ 
'Title: ' v20/ 
'Date: '  v30 

 
Do not worry about getting your display format right first time. It is best to try the format out 
when you have entered a few records and then edit it as necessary. When you have used the 
services of the Assistant, or you have written your own format, click the green arrow to go 
on. 
 
 
4.6  FIELD SELECTION TABLE (FST) 
 
This is perhaps the most difficult of the four forms to understand. 
 
CDS/ISIS has two ways of finding information in the database, which can be compared with 
the two ways of finding information in a book. Suppose we have a book on architecture and 
we want to find any mention of cathedrals. One method is to start at page 1 and scan each 
page in turn to see whether 'cathedrals' occurs on that page. This is known as a 'serial' or 
'sequential' search, because we are searching through the pages in sequence. It would be quite 
a reliable method (provided we could keep up the concentration) but it would take a long time 
if the book had several hundred pages. 
 
A much quicker method is to make use of the index (provided that the book has one). We 
look under C, find 'cathedrals', and then see an entry something like: 
 
 cathedrals    30, 212, 360 
 
Now we can go straight to those page numbers and read what is said about cathedrals. This 
method might not be quite so reliable, since it depends on the skills of the indexer. He or she 
might have considered some mentions of 'cathedrals' to be too insignificant to index. 
 
CDS/ISIS allows both these approaches to information retrieval. The first method, scanning 
through the records sequentially examining the text contained in the record is known as free-
text searching. It is likely to be a slow process when the database contains more than a few 
hundred records. The second method, using an index, is the normal way of searching. 
CDS/ISIS allows you to set up the index automatically and refers to it as the index or inverted 
file. (The list of terms in the index without the details of their occurrences is also referred to 
as the terms dictionary.) 
 
The selection of terms from the database records to go on to the index file is controlled by the 
Field Selection Table. It is not possible for the computer to select terms according to their 
significance. Instead the selection depends upon three rules: 
 
 i. Which fields from the record are to be indexed (e.g. you probably want authors 
indexed but not the publisher or the number of pages). 
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 ii. How the index terms are to be constructed from the data in these fields (called the 
indexing technique). For example, do you want the title 'Good secretarial practice' as a whole  
field under 'G', or do you want it split up into separate words so that 'secretarial' can be 
searched under 's'? 
 
 iii. You can specify a list of stopwords which are not to be used on their own as index 
terms, e.g. 'in', 'of' and 'the'. 
 
CDS/ISIS allows much flexibility in specifying each of these three rules. It is important to 
consider them carefully, since they determine what searches will be possible on the database. 
For instance, if you index authors as separate words, then 'Walpole, Horace' will appear under 
'Horace' and under 'Walpole': you cannot search him as 'Walpole, Horace'. If you index titles 
as whole fields, then 'The Concise Oxford Dictionary of Quotations' cannot be searched 
under 'Dictionary' or under 'Quotations'. It is, in fact, possible in CDS/ISIS to index the same 
field in more than one way. 
 
If you have divided the field into subfields, you can index different subfields by different 
techniques (or some subfields but not others). 
 
Each line of the Field Selection Table comprises three elements: the Tag or Name, the 
Technique and the Format. You need to make an entry in the table for each field you want to 
index (i.e. to make searchable) and if the same field is indexed in two ways you need two 
entries for it. 
 
Again if you are unsure about writing FSTs it would be a good idea to engage the services of 
the Dictionary Assistant. This will give you a dialog box like the one in Figure 4.3. 
 

 
Figure 4.3  Dictionary Assistant dialog box 
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All you need do is to choose which technique to apply and which fields to index. The listbox 
on the right shows the techniques available. The two most commonly used are 0 – by line and 
4 – by word.  
 
0 means that the whole field contents will be indexed as a single term. 
 
1 means index each subfield separately and so is relevant only if the field is divided into 
subfields. 
 
2 means index only words or phrases which have been entered between angle brackets, e.g. 
<inflation rate>. This technique can be used to select particular terms from a lengthy 
piece of text such as an abstract. Some CDS/ISIS users like to enter descriptors this way and 
use technique 2 to index them. 
 
3 is similar to 2 but indexes terms entered between slashes, e.g. /Windward Islands/ 
 
4 signifies that each word in the field will be indexed separately (except stopwords – see 
Section 4.7). If the field is divided into subfields, you must specify mode mhl or mdl in the 
extraction format – see Section 5.2. 
 
Other values are also available and are explained in the Reference manual. If you choose one 
of the values 5 to 8 you will have to edit the format manually to put in the required prefix. 
For help on choosing the right technique please see Section 4.8. 
 
Now click the check boxes against the fields you want to be indexed (i.e. searchable) and 
finally click OK. The FST is then displayed and you can edit it if necessary. Using the 
Dictionary Assistant, all the fields selected are indexed by the same technique: if you want to 
apply different techniques to different fields, you will need to make changes here. 
 
Each entry in the FST has three parts. In the top part of the dialog box the entry being edited 
is shown in three separate boxes. In the Entries box each entry is shown on one line with 
spaces between the three parts.  
 
The first value, which was called the ID in the DOS version of CDS/ISIS, is normally the 
same as the tag of the field from which the terms come. (It does not have to be, but this 
usually makes searching easier.)   It can be used to specify the type of term when searching, 
as we shall see in chapter 7. If you choose a number that corresponds to a field tag, Winisis 
will show the field name in the Tag/Name box when you are editing it. If you choose a 
number that does not correspond to a field tag, it will be shown as the number followed by 
“FST Tag”. 
 
The second value, the indexing technique, specifies how the index terms are to be extracted 
as explained above. 
 
The third column, the format, shows which field in the record the terms are to come from. As 
in the display format, fields are specified with v in front of their tags. 
 
So, if the title field has a tag 200 and we want to index each individual word, the entries 
would be: 
 

Tag/Name: 200 Title Technique: 4  Format:  v200 
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and if the author field is 100 and we want to index the author name as a whole: 
 Tag/Name: 100 Author Technique: 0  Format: v100 
 
If we want to index only subfield a of field 100 we could specify 
 Tag/Name: 100 Author Technique: 0  Format: v100^a 
 
This dialog box works in a similar way to the one for the FDT. When you have entered the 
data for each field, the focus will be on the Add button. Either click on the button or press 
{Enter} to add the field to the table (displayed in the Entries box). If you need to correct the 
details for any entry, just click on that entry in the Entries box and the details will be copied 
into the boxes used for editing. If you need to remove an entry, highlight it and click the 
Delete button.  An example of an FST is shown in Figure 4.4. 

 
Figure 4.4  Example of Field Selection Table (FST ) 
 
For more information on writing the data extraction format, please see Chapter 5, especially 
Section 5.2 for dealing with subfield markers and Section 5.5 for dealing with repeated fields. 
 
Again, do not be too concerned to get the Field Selection Table right first time. It is best to 
try it out on a few sample records and look at the index terms produced. If they are not what 
you want, edit the FST and then regenerate the inverted file.  
 
When you have completed your entries in the Field Selection Table, click the Terminate 
button. You are then asked to confirm that you want the database to be created. Click Yes 
and your wish should be granted. You are then invited to select a database to work on: you 
can choose the one you have just created or a previous one. 
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4.7  STOPWORD LIST 
 
If you are indexing a field by separate words (indexing technique 4) you may want to prevent 
common, non-informative words such as 'an' or 'the' from being indexed. This can be 
achieved by setting up a stopword list for the database. Words on the stopword list will not be 
indexed using indexing techniques 4 (though they may still appear as part of phrases  
produced with other indexing techniques). Note that there can only be one stopword list for a 
given database, not different lists for different fields. 
 
The stopword file needs to be set up outside CDS/ISIS using a text editor or word processor 
(see Section 2.9.8). It must have the same name as the database and the file extension stw 
(e.g. books.stw for the database BOOKS). It must reside in the same folder as the FDT file 
for the database. 
 
The file must contain one stopword on each line with no preceding spaces, and the words 
must be in capital letters. An example is shown below. 
 
A 
AN 
AND 
BY 
FOR 
FROM 
IS 
IT 
NOT 
TO 
THE 
WITH 
_______________________________________________________ 
 
Although you may be able to think of hundreds of words that are not useful as search terms, it 
is usually not necessary to list more than the most common twenty or so. Beyond that the 
words occur relatively rarely, and it is not worth the extra computer processing needed to try 
and stop them. You need to be especially careful if you have data in different languages. AN 
means 'year' in French and DIE could be a stopword in German but not in English. 
 
If you create or modify a stopword list after you have inverted your database, do not expect 
the stopwords to disappear magically from the inverted file. You will have to re-invert the 
database. 
 
Note that if you wish to produce printed lists with articles (such as a, an, the, French le, la les 
l’) ignored at the beginning of titles (e.g. ‘The Tempest’ listed as ‘Tempest’), this cannot be 
achieved by stop words. Instead, each time you enter a word you wish to be ignored, you may 
place <..> around it, e.g. <The> Tempest. When you print the list as described in 
Section 8.8, if you have sorted by the title field you will see that the titles with articles in <..> 
will appear in the list as if the articles were not present, although the articles will actually be 
printed at the start of the titles in the list. Unless you use proof mode in the print format, < > 
will not appear in the printed record. A similar feature is achieved with <xxx=yyy> where 
‘xxx’ will be printed but the field will be sorted as if it were ‘yyy’. For example, if you enter  
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<101=One hundred and one> dalmatians  
 
it will have the effect of printing 101 in the list at ‘one’. 
 
 
4.8 CHOICE OF INDEXING TECHNIQUE 
 
If you are new to setting up databases, some comments on indexing common types of 
bibliographic data might be helpful. It is assumed that you are not using subfields. 
 
Author names may be indexed with technique 0 or 4. If you use technique 0 (i.e. whole 
fields), each name will appear separately on the index file, e.g. 
 
MURGATROYD, RUPERT 
MURPHY, AMELIA Z. 
MURPHY, K.F.A. 
MURPHY, MARGARET 
MURRAY, JAMES 
 
The disadvantage is that if the searcher knows only the author's surname, or only the surname 
and initial, then he or she will have to truncate (see Section 7.4), e.g. 
 

MURPHY$ 
 

MURRAY, J$ 
 
If you use technique 4, then the index will appear as: 
 
AMELIA 
F 
JAMES 
K 
MARGARET 
MURGATROYD 
MURPHY 
MURRAY 
RUPERT 
Z 
 
(The initial A will not appear if it is a stopword.)  It will not be possible to distinguish 
between the three Murphys by searching the index, but on the other hand you can have a 
simple rule for searching: just enter the surname. 
 
For titles, it is usually best to use technique 4, since the searcher may not know the exact title, 
and also because words in titles can be useful subject terms. Thus, the title 'An introduction to 
computer based library systems' would be searchable under COMPUTER or LIBRARY, and 
could also be found if the searcher forgot that it began with 'An introduction'. 
 
If you want to be able to search numbers, e.g. dates of publication, they must be indexed as 
technique 0 or 1, since numbers are not considered as 'words' and will not be indexed in 
technique 4. 
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The definition of which characters are considered as ‘letters’ is made in the file isisac.tab. This file lists the 
ASCII codes of all alphabetic characters. (See the Reference manual.) 
 
Descriptors that are controlled (i.e. taken from a thesaurus or list of subject headings) may be 
entered in the record as separate occurrences of a repeatable field. They are then probably 
best indexed with technique 0, so that they can be searched as phrases, e.g. 
 
ECOLOGY 
ECONOMIC CONDITIONS 
ECONOMIC DEPENDENCE 
ECONOMIC HISTORY 
ECONOMIC POLICY 
ECONOMICS 
ECONOMICS OF SCALE 
ECONOMISTS 
EDUCATION 
 
However, if the descriptors are not controlled, they may be better indexed as separate words, 
i.e. technique 4. This will mean that all words in the descriptor will act as potential search 
terms. 
 
 
4.9 DATABASE PARAMETER FILE (PAR FILE) 
 
When you create a database, the system places it automatically in the data subfolder. If you 
have more than one database, there could be the danger of conflict. For example, you would 
not be able to give a print format the same name in more than one database. The way to avoid 
this problem is to place each database in its own folder. When you are creating the database 
and you are asked for its name, you can give the full path, e.g. 
 

C:\WINISIS\DATA\PATS\PATS 
 

If the folder c:\winisis\data\pats does not already exist, Winisis will offer to create it and 
will then place the PATS database files there. It will also automatically set up the required 
pats.par file in the folder c:\winisis\data.  
 
If you decide after creating a database to create a new folder and copy the files belonging to that database there 
(perhaps on a network drive) you will have to create a par file yourself. Remember also that the database files 
will begin with the name of the database except for the worksheet which begins with the name preceded by A 
(for compatibility with the DOS version). You may have created extra worksheets or print formats; you will 
have to copy these separately. 
 
You can create the PAR file using a text editor such as Notepad or Wordpad. The file should look like this 
 
1=c:\winisis\data\pats\ 
2=c:\winisis\data\pats\ 
3=c:\winisis\data\pats\ 
4=c:\winisis\data\pats\ 
5=c:\winisis\data\pats\ 
6=c:\winisis\data\pats\ 
7=c:\winisis\data\pats\ 
8=c:\winisis\data\pats\ 
9=c:\winisis\data\pats\ 
10=c:\winisis\data\pats\ 
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Copy-and-paste can save you a lot of typing!  The different parameters relate to different database files, but you 
need not worry about this. They are there to allow default files to be placed in different directories, drives or 
devices, such as when parts of a database are on CD-ROM. The ten parameters will be the same if the purpose 
of the file is to tell CDS/ISIS that the database is in a different folder from the usual data folder. Save the file as 
pats.par (or whatever your database is called plus the file extension .par) in the data folder. 
 
 
4.10 DATABASE EXP FILE 
 
Section 7.2 explains the option to Display search results in a table which is obtained by 
having parameter 980 in syspar.par set to the value 1. In this display the screen is divided  
into two panels, the left one containing a list of record numbers and the right one containing 
some tips on how to use the display window. 
 
It is possible to set some properties of the search results window for a particular database by 
setting up an EXP file. This file must have the same name as the database plus the extension 
.exp and it must be placed in the same folder as the PAR file for that database (if there is a 
PAR file) or the MST file (if there isn’t). The format of the file is just like that of syspar.par 
– a number, equals sign, and value. 
 
Parameter 500 sets the display format to be used in the right panel. Just give the format 
name, e.g. 
 
 500=ISBD 
 
Parameter 501 sets the short format to be used in the left panel. Here you should use the 
formatting language, e.g. 
 
 501=mfn(1),'…',v245 
 
There other parameters, which are described in the Reference manual and its supplements. 
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5   THE FORMATTING LANGUAGE 
 
The formatting language is used to select and rearrange data from the record for several 
purposes, so it is worth putting some effort into understanding the main features. These 
purposes include: 
 
1  Printing or displaying the record. We have already seen examples in Section 4.5 above. To 
display field 10 on one line and field 20 on the next, you would use: 
 v10/v20 
 
2  Entering terms from the record on to the index file. This was mentioned briefly in Section 
4.6 above. To select the contents of field 10 to go on to the index file, you would make an 
entry in the Field Selection Table: 
 Tag: 10    Technique: 0    Format: v10 
 
Note that again v10 is used to select data in field 10. 
 
3  Selecting parts of the record for sorting on, e.g. author names to do an author sort. This 
will be discussed further in Section 8.8. 
 
4  Select or re-format parts of the record for exporting to another database. This is discussed 
in Section 10.7. 
 
5  Writing validation rules and picklists for data entry forms – see Section 4.4. 
 
The requirements are usually most complex for printing or displaying, so this chapter is 
written from the point of view of these operations. However, the same formatting language is 
used in the other three cases. 
 
For the purposes of example, the following record will be used: 
__________________________________________________ 
 
10  ^aSinger^bHans 
20  ^aA more human way forward 
__________________________________________________ 
 
Upper or lower case letters can be used in the formatting language, e.g. 
 mhu v10 or MHU v10 or MhU V10 etc. 
 
and carriage returns can be used within a display format to make it easier to read: they have 
no effect on the display itself. 
  
 
5.1  FIELD, SUBFIELD AND OCCURRENCE SELECTORS 
 
As we have seen, the contents of a field are selected by using v and the field tag, e.g. v10. (v 
stands for 'variable'.) 
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This will select all the subfields present, if the field is divided into subfields. To specify a 
subfield, use the circumflex and the subfield tag, e.g. v10^b for field 10 subfield b. If you  
want to select several subfields from the same field, you need to repeat the field number, e.g. 
v10^a, v10^b 
 
Tag zero, i.e. v0, is used to stand for all fields in the record. This can be used in serial searching (Section 7.10) 
to search the whole record, and the format 
 
 (v0/) 
 
could be used as a display format to show the whole record, each field or occurrence of a field on a separate 
line. 
 
If you want to select a particular occurrence of a repeating field, specify it in square brackets, 
e.g. v10[1] will select the first occurrence of field 1. 
 
To select the number of the record in the database (called the Master File Number) use MFN. 
This will give a number with six digits, e.g. 000015. To make it shorter, specify the number 
of digits in brackets, e.g. MFN(3) will produce 015. 
 
To display an MFN without any leading zeros use f(mfn,0,0). The f function converts a number to a 
character string. 
 
 
5.2  MODES 
 
In general, you will only need to worry about these if you have divided your fields into 
subfields. There are three modes available. 
 
proof - data will be displayed exactly as entered in the record, i.e. 
 ^aSinger^bHans 
 A more human way forward 
 
heading - angle brackets in the data are ignored. Subfield markers are converted to 
punctuation:  
 ^a is converted to a semicolon and space (unless it comes at the beginning of a field) 
 ^b to ^i are converted to a comma and space 
 all others are converted to a full stop and space 
So, the example will come out as 
 Singer, Hans 
 A more human way forward 
 
data -  like heading mode, but each field will be followed by a full stop and two spaces. The 
example will thus appear as 
 Singer, Hans. 
 A more human way forward. 
This provides a simple way of separating the occurrences of a repeating field. 
 
Each of these modes can be specified as 'upper case' or 'lower case'. If you choose upper case, 
all letters will be converted to capitals, e.g. 
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 SINGER, HANS 
If you choose lower case, all letters will be left as they are (not all converted to small letters) 
e.g. 
 Singer, Hans 
 
The mode is specified by m; followed by p for proof, h for heading or d for data; and 
followed by u for upper case or l for lower case. Thus you could specify: 
 mhl v10 
 
The mode specification applies throughout a format until another mode is specified. Thus in 
the format 
 mhu v10, v20, v30, mhl v40 
fields v10, v20 and v30 will be converted to upper case and field 40 will be left as it is. 
 
There is no necessity to specify a mode. If you not, the 'default' mode of mpl will be used. 
 
If you are specifying data to go into an inverted file (i.e. you are writing the Field Selection 
Table) you need not worry about upper or lower case: all letters are converted into upper case 
anyway. 
 
 
5.3  LAYOUT 
 
This section describes some layout features that have been carried over from the DOS version 
of CDS/ISIS. The Windows version allows more sophisticated control of layout using new 
keywords (see Section 5.6). If you are still using old formats from the DOS version, they still 
work quite well so long as you are using Courier font (which is the default). 
 
A common requirement is to indent one or more fields when printing a record, e.g. 
 SINGER, Hans 
 A more human way forward 
 
This can be done by specifying the number of spaces to indent in brackets after the tag, e.g. 
 v10/v20(5) 
 
If the field is long, you may want to indent subsequent lines by the same amount, or by 
different amounts, e.g. 
 SINGER, Hans 
      The development between debt pressures, adjustment policies and  

deterioration of terms of trade for developing countries with special reference  
to Latin America 

 
You can specify two numbers in the brackets - one for the first line and one for all subsequent 
lines, e.g. 
 
 v10/v20(5,10) 
 
Indenting applies only if the field is the first item to be printed on that line. 
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To start a new line within a display format, use a slash. For example, v10/v20 will produce: 
 Singer, Hans 
 A more human way forward 
 
However, slashes will never produce a blank line, even if you use two or more. To produce a 
blank line (e.g. between records in a printout) you should use hash marks. One hash will go 
on to the next line, and two will produce one blank line. So the format v10##v20 will result 
in 
 Singer, Hans 
 
 A more human way forward 
 
 
5.4 LITERALS 
 
When you write v10 within a format, you do not want 'v10' to appear literally in the printout, 
but rather the contents of field 10, e.g. 'Singer, Hans'. However, you may want to specify 
some text or punctuation that you do want to appear literally, e.g. Author:  in front of the 
author's name. This text is known as a literal. 
 
Three types of literal can be used in CDS/ISIS: 
 
(i) Unconditional literals. These are specified by putting the text in single quote marks, e.g. 
 
 'Author: 'v10/'Title: 'v20 
 
This will produce the display: 
 
 Author: Singer, Hans 
 Title: A more human way forward 
 
Because this type of literal is unconditional it will appear even if there are no data in the 
field, e.g. no author's name in field 10: 
 
 Author: 
 Title: Oxford song book 
 
Note that literals can be used to supply spaces and punctuation. If we wanted a space, hyphen 
and space between author and title we could write v10 '  -  ' v20  
which would give 
 
 Singer, Hans - A more human way forward 
 
However, the space, hyphen and space will appear even if there is no author or title. 

Since you may be printing or displaying in a proportional-spaced font, a more precise definition of "space" is 
needed. In fact, each space is evaluated as 127 twips. A twip is a twentieth of a point and a point is 1/72 of an 
inch. So each "space" in an indent is 127/(20X72) = 0.088 inches. The size of the indent is thus independent of 
the font size. 



The CDS/ISIS for Windows Handbook 53

(ii) Conditional literals. These are displayed only if their associated field is actually present. 
They are written between double quote marks. Thus  "Author: "v10/"Title: " 
v20 will produce for the first example: 
 
 Author: Singer, Hans 
 Title: A more human way forward 
 
and for the second: 
 
 Title: Oxford song book 
 
You may need to use a comma to show whether a conditional literal is conditional on the 
field before it or the field after it. For example, in  
 
 v10 " - " v20  
 
is the punctuation conditional on field 10 or field 20 being present?  A comma will remove 
the ambiguity, e.g. v10 " - ",v20 shows that it is conditional on field 10. 
 
(iii) Repeatable literals. If you have a repeated field (e.g. several authors) you can choose 
whether the literal should appear with each of them, e.g. 
 
 Author: Singer, Hans 
 Author: Maxwell, Simon 
 Author: Joekes, Susan 
 
or just once, e.g. 
 
 Author: Singer, Hans 
          Maxwell, Simon 
         Joekes, Susan 
 
A repeatable literal is written between vertical bars. These may appear solid or broken on 
your computer: the key is in the bottom left-hand corner on an IBM keyboard. If you have 
trouble in finding the right character, make sure that {Num Lock} is on then hold down the 
{Alt} key and type 124 on the numeric keyboard. 
 
For example: 
 
 |Author: |v10 
 
A common requirement with repeating fields is to print some punctuation after each 
occurrence except the last one, e.g. 
 
 Singer, Hans; Maxwell, Simon; Joekes, Susan 
 
Here, a semicolon is printed after each name but not after the last name. This can be achieved 
using a plus sign, e.g. v10+|; | 
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5.5  REPEATABLE GROUPS 
 
Another common requirement with repeated fields is to display the repeats one on each line, 
e.g. 
 
 Singer, Hans 
 Maxwell, Simon 
 Joekes, Susan 
 
If you write the format as v10/, the three names will be run together and there will only be a 
new line at the end: 
 
 Singer, HansMaxwell, SimonJoekes, Susan 
 
The same problem occurs if you try to invert a repeated field, or to sort on a repeated field: 
only one index term or sort key is produced. It can be solved by using brackets to form a 
repeatable group, e.g. (v10/). v10 and the slash (new line) now form a group. Every 
time v10 repeats the new line repeats too. So the result will be: 
 
 Singer, Hans 
 Maxwell, Simon 
 Joekes, Susan 
 
5.6   WINDOWS FEATURES 
 
In CDS/ISIS for Windows, it is possible to control the appearance of the display or printout 
quite precisely using keywords not available in the DOS version. These are described in the 
CDS/ISIS for Windows: reference manual, chapter 7. The most important features are 
described in the sections below. Please note that they must be followed by a comma. 
 
5.6.1  FONTS TABLE 
 
At the beginning of your format, you can specify the fonts to be used. If you do not, the fonts 
available will be Courier New (font 0) and Arial (font 1). Fonts are specified by means of 
their family and name. The families are: 
 
 nil  Unknown or default fonts 
 roman  Roman, proportionally spaced serif fonts 
 swiss  Swiss, proportionally spaced sans serif fonts 
 modern Fixed-pitch serif and sans serif fonts: Courier, etc. 
 script  Script fonts: Cursive, etc. 
 decor  Decorative fonts: Old English, Zapf Chancery, etc. 
 tech  Technical, symbol and mathematical fonts 
 
If you want to use just Times New Roman, you could use the table 
 
 fonts((roman,Times New Roman)) 
 
or to use Goudy Old Style ATT and Arial: 
 
 fonts((roman,Goudy Old Style ATT),(swiss,Arial)) 
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If you do not know the right family, you can just specify nil, e.g. 
 
 fonts((nil,Garamond),(nil,Bookman),(nil,MS Serif)) 
 
The first font listed is referred to as font 0, the second as font 1, etc. Font 0 is used until you 
specify otherwise. To change to font 1, use f1, e.g. 
 
 v10/f1, v20 
 
This will display field 10 in the default font (font 0) and field 20 in font 1. 
 
Note that there must be two brackets after the word fonts and at the end of the fonts table. 
Also remember that there must be a comma after f1 etc. 
 
5.6.2  COLOURS TABLE 
 
The colours table is a bit more tricky to write than the fonts table, but you can use the default 
colours table: colour 0 = black (default), colour 1 = dark red,  colour 2 = green, colour 3 = 
olive green, colour 4 = blue, colour 5 = purple, colour 6 = cyan, colour 7 = grey, etc. You 
specify these using cl (letter C, letter L) and the number, e.g. 
 
 cl1, v10 
 
will display field 10 on the screen in red. 
 
5.6.3  FONT SIZE 
 
You can specify the font size to be used by means of fs followed by the size in half points, 
e.g. fs30 will change to 15-point size. The default when no size is specified is 12-point. So, 
 
 v10/fs30, v20/fs20,v30 
 
will display field 10 in 12-point, field 20 in 15-point, and field 30 in 10-point size. 
 
5.6.4 BOLD, ITALIC AND UNDERLINE 
 
You can make the display or printout easier to read by printing certain fields in bold, italic or 
underlined characters. This is done with the symbols b, i, and ul respectively. You can 
limit the extent of application of these features using braces (curly brackets), e.g. 
 
 {b,v10}/v20/{i,v30 " - ",v31} 
 
This signifies that field 10 is to be printed in bold, field 20 in normal type, and fields 30 and 
31 (and the dash) in italic type. 
 
5.6.5 PARAGRAPH FORMATTING 
 
(a) Indentation. m sets a margin (similar to the indent in Section 5.3), the measurement being 
in twips. The margin starts at the point where it is specified, so  
 
 v30/ m(144), v26 
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prints field 30 on one line, then a new line with field 26 indented by 144 twips. The indent 
will apply to the start of each subsequent line until it is set back to zero. 
 
As in Section 5.3, it is possible to specify different indents for the first line and subsequent 
lines of each paragraph, e.g. 
 
 v30/m(1000,500),v26,v70 
 
In this example, the first line of field 26 will be indented by 1500 twips (1000 plus 500) and 
subsequent lines of field 26 or field 70 will be indented by 1000 twips. The second number 
can be negative, so m(500,-500) will not indent the first line of each paragraph at all, but 
continuation lines will be indented by 500 twips. 
 
You can limit the effect of the m command by using curly brackets, e.g. 
 
 {m(500)v10/v20}/v30/v40 
  
(b) Tabulation. tab moves to a particular position in the line, the measurement again being 
in twips, e.g. 
 
 'Surname',tab(2000),'Forename'/(v100^a,tab(2000),v100^b/) 
 
Here the first line of output will contain the column headings ‘Surname’ and ‘Forename’ and 
subfields a and b will be arranged under the headings for each occurrence of field 100. 
 
(c) Centre. qc centres text between the left and right margins. It applies to the whole 
paragraph so each of these three examples has the same effect: 
 
 qc,v26,v30 
 v26,qc,v30 
 v26,v30,qc 
 
If desired, its effect can be limited with braces (curly brackets) e.g. 
 
 {qc,v70/v24} /v26 
 
(d) Justify. qj justifies text between the left and right margins. It works in the same way as 
qc. 
 
(e) Box. The command box draws a border round the paragraph using the current colour (see 
Section 5.6.2 above.)  The command box(2) draws a box round the paragraph and gives it a 
background of colour 2. In this case, the current colour should be different from 2 or you will 
be unable to read the text! 
 
(f) New page. The command np starts a new page during printing. It might be useful for 
printing order letters or recall notices where you want just one record on each page. 
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5.7  DISPLAYING PICTURES 
 
It is possible in the formatting language to display a picture as part of the format or as the 
background to the record display. The picture should be in the form of a .bmp or .jpg file and 
be stored in the folder specified for Patterns/Images (parameter 141 in syspar.par). 
 
To display a picture as part of the format, use the command pict, e.g.  
 
 v1/pict('library.jpg')/v2 
 
This will display field 1, then the picture in the file library.jpg starting on a new line,then 
field 2 starting on a new line. If you want a different picture to appear in each record, then 
you could store the file name in a field in the record, e.g. field 50: 
 v1/pict(v50)/v2 
 
You can make the display more interesting by using a background image with the command 
bpict followed by two values in brackets. The first (in its own brackets) is the file 
containing the image and the second is a number controlling the style. The value 2 scales the 
picture to fill the whole window. (In that case it needs to be a suitable shape to avoid 
distortion.)  For example: 
 
 bpict(('vicfalls.jpg'),2)/v1/v2 
 
The Reference manual explains the other options with bpict, including using an image as 
wallpaper in the display window. 
 
5.8  CONDITIONALS 
 
As mentioned in Section 5.4, it is usually fairly easy to make the printing of a literal 
conditional on the presence of its associated field. However, there can be more complicated 
conditions. 
 
For example, your database may contain different types of records, distinguished by a value 
given in one of the fields. Let us suppose that field 80 is used for 'item type'. Then you may 
want to say 'If field 80=BOOK then print these fields, but print those other fields in any case.'  
This kind of condition can be written into a format using FI to show where the 'if ... then' 
condition ends, e.g. 
 
 IF v80='BOOK' THEN v10/v20/v30 FI v60/v70 
 
Here, v10, v20 and v30 are conditional on the contents of field 80 being BOOK, whilst v60 
and v70 will be printed in any case. 
 
A more complicated example would be if there were two conditions: 
 
 IF v80='BOOK' THEN v10/v20/v30 ELSE IF v80='ARTICLE' THEN 
 v20/v30/v40 FI FI v60/v70 
 
It is possible for one format to be included in another, using an @ sign in front of the format 
name, so you if you have already written formats FMT1 and FMT2 you could specify a 
choice like this: 
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IF v80=’BOOK’ THEN @FMT1 ELSE @FMT2 FI 
 
The conditions IF V80='BOOK' and IF V80='article' will only work if the exact contents of field 80 
are BOOK or article respectively. If you want to allow for the contents being in upper or lower case, you could 
say IF V80 : 'BOOK'. The colon means 'contains' and case is ignored, but the condition IF V80 : 
'ARTICLE' would be satisfied if field 80 contained the word 'particle'. 
 
 
5.9  REF AND L 
 
It is possible to display, apparently as one record, information that has come from more than 
one record in the database. In the Windows version this has been extended to allow the 
combination of records in different databases. 
 
The REF function allows you to link one record to another by means of the MFN of the 
second record. For example, you could have one record for a journal article and another for 
the journal containing it. The first could refer to the second by quoting its MFN. 
 
Article record: 
 MFN 259 
 10 Walker, Gladys 
 20 The care of azaleas 
 30 6 
 
Journal record: 
 
 MFN 6  
 20 Houseplants Monthly 
 
Here field 10 is used for author, 20 for title (the article title in the first case and the journal 
title in the second) and 30 is used in the article record to contain the MFN of the relevant 
journal record. 
 
You can then display the combined information using the display format 
 
 v10/v20/'In: 'ref(val(v30),v20) 
 
The val function converts the contents of field 30 to a number. (Apart from the MFN, all 
fields in a CDS/ISIS record are held as strings of characters and cannot be used in 
calculations as they stand.)  The ref function then extracts field 20 from the record with that 
number as its MFN. The result will be: 
 
 Walker, Gladys 
 The care of azaleas 
 In: Houseplants Monthly 
 
There are two limitations to using the ref function like this. One is that when you enter the 
article record you need to know that "Houseplants Monthly" is record 6. The other is that the 
article and journal records need to be in the same database, whereas you might prefer to keep 
them separate. 
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The first limitation can be overcome by using the L or "look-up" function. (A capital L is 
used here just to make it easier to read but lower-case works just as well.)  This looks for a 
term in the inverted file in order to identify the related record. So, instead of using MFNs to 
make the link, you could use some sort of abbreviation, e.g. 
 
Article record 
 MFN 259 
 10 Walker, Gladys 
 20 The care of azaleas 
 30 HM 
 
Journal record 
 MFN 6 
 20 Houseplants Monthly 
 100 HM 
 
Now field 30 is used in the article record to contain an abbreviation of the journal title. Field 
100 in the journal record contains the abbreviation for that journal. "HM" should be easier to 
remember than "6". In the Field Selection Table, you then need an entry 
 
 Tag: 100 Technique: 0  Format: v100 
 
so that the abbreviation is entered on the inverted file. In fact, it is more reliable to use a 
prefix for this term (see Section 7.3) so that it cannot be confused with the same term from 
another source (e.g. HM from a title "A visit by HM the Queen" or field 30 from article 
records.)  In the Field Selection Table you could use 
 
 Tag: 100 Technique: 0  Format: "ABBREV="v100 
 
To display the combined information you can then use 
 
 v10/v20/'In: 'ref(L('ABBREV='v30),v20) 
 
Note that it is the abbreviation in field 30 of the article record that needs to be looked up to 
find the relevant journal record. 
 
The second limitation - the need to have both records in the same database - is removed in 
CDS/ISIS for Windows. Suppose that the journal records are in a separate database called 
JNL. You can then display the combined information using the display format 
 
 v10/v20/'In: ' ref->JNL(L->JNL('ABBREV='v30),v20) 
 
Here both the linking (with ref) and the look-up (with L) are done to the database JNL. 
 
Another use in a library context might be to run a circulation system. You could have a 
database of books (called BOOK) and a database of registered borrowers (called BORR). 
When a book is issued to a borrower, you could enter the borrower code in a field of the book 
record. When the book is returned you could delete the borrower code. The REF function 
allows you to produce a display or printout combining information from the two records. A 
simple example is shown below. 
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BORR database 
 
10 Christopher Sabanda 
20 17 Fourth Street 
30 Harare 
40 CS230 
 
BOOK database 
 
100 Francis Zikonda 
200 Introduction to patent law 
900 CS230 
 
In the BORR database, field 40 is used for the borrower code. Let us assume that it has been 
put onto the index file as BC=CS230. In the BOOK database, a borrower code is entered in 
field 900 when the book is borrowed. If you need to produce a recall notice, you could use a 
format like this to print from the book database: 
 

'Dear ',ref->BORR (L->BORR('BC='v900,v10)/'The following 
book is now overdue.'/'Kindly return it immediately.' 
/v100/v200 
 

 
5.10  HYPERTEXT 
 
In the Windows version of CDS/ISIS it is possible to display a record containing a hypertext 
link. The link command puts some text on the screen which is underlined and in green, 
unless you have changed the colours table. You can click on this text and an action will be 
performed, e.g. a picture is shown, a video is played, or a World Wide Web page is accessed. 
This kind of link will be familiar if you have used the Windows help system or a World Wide 
Web browser such as Netscape Navigator or Internet Explorer. 
 
The general format of the link command is 
 
 link((text),command) 
 
Both the text (that appears as the link on the screen) and the command (that is executed when 
the user clicks on the text) are written in CDS/ISIS formatting language. Some special 
CDS/ISIS commands are available as well as standard operating system commands. 
 
5.10.1 OPENFILE 
 
This command allows you to activate an image, a video or audio file or an HTML page 
relating to the record. Provided that you have Windows set up to associate a program for the 
relevant file extension, CDS/ISIS will start up that program and activate the file, e.g. 
 
 link(('Display full text'),'OPENFILE ',v50) 
 
Note that OPENFILE must be written in upper-case and must have a space between it and the 
single quote: this is because it is interpreted as OPENFILE-space-datafile name (from field 
50). 
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The display format will show on the screen (normally in green) 
 
 Display full text 
 
Let us suppose that field 50 contains the name of a Word document file, c:\docs\ft1.doc. 
When the user clicks on the words “Display full text”, the Microsoft Word program will be 
run and will open the file ft1.doc. After reading the file, the user can close Word and return 
to CDS/ISIS. Alternatively field 50 could contain the name of an Acrobat PDF file, and 
provided the user has Acrobat Reader installed that program will be opened and the PDF file 
displayed. 
 
Rather than displaying text, this feature could be used to display an image. If the image file 
name is held in field 100, you could include in the display format: 
 
 link(('Show a picture'),'OPENFILE ',v100) 
 
This will show on the screen 
 
 Show a picture 
 
If field 100 contains the name of an image file, e.g. f:\images\durham.jpg, then when the 
user clicks on the link the image durham.jpg will be displayed using whatever graphics 
program is associated with JPG files on his/her computer. 
 
Another use would be to open a browser and display a WWW page. The format could contain 
 
 link(('Go to the web site'),'OPENFILE ',v950) 
 
and field 950 is used to contain the relevant URL, e.g.  
 
 http://www.bireme.br 
 
The text displayed could also come from a field in the record, instead of being a literal, e.g. 
 
 link ((v104^a),'OPENFILE ',v104^b) 
 
This will display the contents of subfield a of field 104 on the screen. If you click on this text, 
the relevant program will be run, operating on the data in subfield b of field 104. If subfield a 
contains the data  Middlesex University homepage and subfield b contains 
http://www.mdx.ac.uk then the text Middlesex University homepage will appear on 
the screen. When you click on this text, the Web browser will be launched and the specified 
page World Wide Web page should be displayed. 
 
5.10.2  CMD 
 
You can start other programs (not associated with a file type) by using CMD followed by the 
program file name. Backslashes in the path need to be written as \\ and remember the space 
between the command and its arguments, e.g. 
 
link (('Display image with Paintbrush'), 'CMD pbrush ',v100) 

http://www.bireme.br/
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This will start the program pbrush.exe and open the bitmap format file whose name is given 
in field 100. (In field 100 the path can be written normally, e.g. c:\images\015.bmp) 
 
5.10.3  TEXTBOXES 
 
The Textbox feature allows you to display text or (despite the name) a picture in a new 
window. For example, 
 
 link (('Show abstract'),'TEXTBOX ',v600)  
 
Note that TEXTBOX must be in upper-case letters and have a space after it. This command 
will display Show abstract on the screen (normally in green). When you click on these words, 
a new window will open showing the contents of field 600.  The window can be closed by 
choosing its Close button or exiting from Winisis. 
 
The format displayed in the Textbox may not contain spacing commands nor the Windows 
features described in Section 5.6. There are ways round this, described in the CDS/ISIS for 
Windows: Reference manual. 
 
Pictures can be displayed using the command TEXTBOXIMG provided that they are in BMP, 
GIF or JPG formats. (Other formats can be displayed using OPENFILE as described above.)  
The image file is expected to be in the folder specified for images in the System Settings.  An 
example format would be: 
 
 link(('Show logo'),'TEXTBOXIMG ',v50) 
 
The name of the image file should be entered in field 50. When the user clicks on the text 
“Show logo”, the image file is opened in a new window. 
 
The image viewer allows you to enlarge or reduce the image by clicking the icons showing 
the magnifying glasses with + and – signs, or to zoom in on a part of the image by marking 
it out with the cursor. (Hold down the left button on the mouse and move the mouse.)  The 
right mouse button returns the image to normal. 
 
There are various possibilities for specifying how Textboxes can be closed, which you can 
find in the Reference manual. 
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6 DATA ENTRY 
 
When you have set up your database, or if you have been given a database, you will be eager 
to try it out by entering some records. Incidentally, it is best to put in say six records and 
check that they can be searched and displayed as you would like before starting on full scale 
data entry. First, you may like to practice editing the database supplied with the system, CDS. 
 
6.1  EDITING RECORDS 
 
6.1.1 OVERVIEW OF THE EDIT FUNCTION 
 
Choose Database ⇒ Open and select the database you wish to open by double-clicking on 
its name (e.g. CDS). The database will then open displaying the first record in the database. 
Then choose Edit ⇒ Data entry and the data entry window will appear as in Figure 6.1. The 
record displayed when the database is opened will be displayed in the data entry window. If 
the database had already been open and you were looking at a different record, that record 
would be displayed. 
 
The display is divided into parts. The MFN is displayed towards the top left of the screen. If 
you are in a database which already contains some records, point to the number with the 
mouse, click and edit the number and press {Enter}. The record with that number or the last 
record in the database if the number is greater, will be displayed. A data entry box is at the 
top in which is displayed the text of the first field. Below is a list of the fields which exist in 
the record. The first field will be highlighted. You may also see empty fields depending on 
the setting of Show empty fields in data entry option on the Configure ⇒ System Settings 
⇒ Display dialog box. If empty fields are not visible, you can click on the magnifying glass 
icon in the bottom right corner and those fields will be represented by empty boxes on the 
screen. If the first field displayed on the screen is empty, the data entry box will be empty. 
Any text typed into the box will be displayed against that field in the display below on 
pressing the {Enter} key.  The field below will then be highlighted and its data appear in 
the data entry box.  Alternatively you can click in a different field. The top box will display 
the highlighted field and the cursor will be placed at the start of that box waiting for a key to 
be pressed. 
 
If you are not displaying empty fields you may add a field by clicking on the combo box 
labelled Add field. Click on the field you wish to add to select it, or else start typing its name. 
 
Below the listed fields you will see a box which indicates the size of the field being edited 
(e.g. 25 bytes) and a box which contains the help message for the field that was supplied 
when the worksheet was created. 
 
6.1.2 USING THE KEYS 
 
You can use the {Delete} and {Insert} keys in the usual way. {Insert} will act as a 
toggle between insert and overtype. {Home} will take you the start of the field and {End} to 
the end of the field. 
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Figure 6.1 Data entry 
 
You may cut and paste data in the usual Windows way. You can highlight a section by 
dragging the mouse from the start to end of the section with the left mouse button pressed. 
{Ctrl x} will cut that section and copy it to the clipboard, {Ctrl c} will copy it to the 
clipboard. {Ctrl v} will insert the text at the point where the cursor is. 
 
Additionally CDS/ISIS for Windows uses the function key {F2}. This will delete the field 
you are editing and remove the field completely from the display, moving data entry to the 
next field. If you have entered a field and made so many mistakes you would like to start 
again, press {Esc}and the field will revert to how it was before you began to edit the record. 
 
6.1.3 ADDING FIELDS 
 
If you wish to add a new occurrence of a field which is already present in the record, you may 
do so if the field is repeatable, by clicking on the button to the left of the field name. A blank 
field will appear into which you may enter data as you wish. 
 
If you need to enter several values in the same field, use this repeatable field option. 
Alternatively, you can separate the repeats with % signs, as in CDS/ISIS for DOS. 
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Since the repeats can be printed with a line space (for example) between them, it is 
convenient to enter the lines of an address or the paragraphs of an abstract as repeats of the 
same field, e.g. 
 
 Address:  PO Box 123 
      Addis Ababa 
      Ethiopia 
 
Since the % sign is used to separate repeated values in a field, you cannot enter % as part of the field contents. If 
you wish to enter % in text, e.g. How to earn 15% interest, you must redefine the repeating field 
symbol. For example, if you wish to use @ instead of %, in the syspar.par file enter 8=@ and you will be able 
to enter % in text. 
 
 
If the field has not been defined as repeatable in the Field Definition Table, you cannot add 
multiple occurrences in data entry. You will need to go back and edit the FDT. Do not worry 
about words getting split at the ends of lines. Should your data will not fit on to one line, just 
keep typing: do not press {Enter} within a field or you will go on to the next one. When 
records are displayed or printed, CDS/ISIS makes sure that words are not split. 
 
If you click on the name of the data entry worksheet, you will see a list of other names. Click 
on one and a different set of fields may be displayed. Note that any field which contains data 
will be hidden if it is not present in the selected worksheet. Be aware that you may not see all 
the fields in a record when you are editing it with a particular worksheet. Click on the 
magnifying glass icon to see any empty fields which are specified in that worksheet. This 
icon acts as a toggle so clicking a second time will restore it to its original state, and no blank 
fields will show on the worksheet. 
 
6.1.4 DELETING A FIELD 
 
Click on the field and press {F2}. 
 
6.1.5 VALIDATION 
 
Note that CDS/ISIS for Windows has a number of different validation procedures. When a 
data base is created, each field is designated repeatable or non-repeatable. It is possible to 
create repeated fields only if that field is set up to be repeatable. 
 
When the database was created the designer could indicate that certain fields were mandatory 
(see Section 4.4). If these are not entered the record cannot be saved. You may not add a 
subfield if that subfield is not specified in the database (in the field definition table). If you 
try to add an invalid subfield you will get the message “Subfields not allowed in this field”. 
Take care to enter data in subfields with no spaces before or after the subfield markers, e.g. 
 
 ^aBombay^bOxford University Press^c1990 
 
If the designer specified that a field should be Alphabetic or Numeric in the Field Definition 
Table (Section 4.3), the data you enter will be checked against that specification and rejected 
if the type does not match. 
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6.1.6 MOVING TO ANOTHER FIELD OR RECORD 
 
When you have finished editing the field click on another field you wish to edit or save the 
record and move to another. 
 
When you have finished editing all the fields you wish, click on the icon of a floppy disk and 
the record will be saved. To move to another record, edit the number in the MFN window and 
press {Enter}. If you have not saved the previous record, you will get the message: Record  
was changed. Save? Click on the Yes button and the record will be saved. If you want to 
create a new record proceed as follows… 
 
6.2  TO CREATE A NEW RECORD 
 
To create a new record in the database, click on the blank page icon. Empty fields will appear 
on the screen and the MFN box will contain ???. Whatever you type goes into the top box 
and will be added to the contents of that field when you press {Enter} or finish by clicking 
on the text of another field. 
 
The rules for editing a record as described above apply equally to entering data in new 
records. 
 
When you have completed a record and saved it, it will be allocated the next available MFN. 
If you want to amend this record, edit it as described in Section 6.1. 
 
6.3  EDITING A RANGE OF RECORDS 
 
You can edit a record or a range of records whether you have found the record(s) by 
browsing a database or by doing a search. 
 
From the main menu bar, choose Edit ⇒ Data entry and the data entry window will appear 
with the record you have on your main database display screen. You can move onward in the 
database by clicking on the right-facing triangle or backward by clicking on the left-pointing 
triangle. 
 
If you have retrieved a set of records you will move forwards or backwards through the 
retrieved set. Otherwise you will move on one by one. 
 
If you want to edit records 15-20, with the database open but with Data Entry closed, type 
15 in the box marked MFN. Choose from the menu bar Edit ⇒ Data Entry and the record in 
the data entry window will be record number 15. Make changes to that record, then click on 
the floppy disk to save it. Then click on the right-pointing triangle to move to the next record 
(or on the left-pointing to move backwards). If you make changes and forget to save the 
record before moving on, you will get a message Record was changed. Save? Click Yes to 
save it and move on. 
 
If you want to make a change or check particular fields of all records with a particular 
attribute you can search for that attribute and view those records in data entry. For example, 
you might have entered 'Anon' in the author field and you might want to review each author 
field containing 'Anon'. 
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Choose Search ⇒ Guided search.  Select from the list of fields Author and enter Anon as 
a search element.  Click Execute. 
 
On the main menu bar, select Browse ⇒ Search results... and select the search you have just 
done. The first record of the set will appear in the data entry window. You can move through 
the retrieved set by clicking on the right-pointing triangle. 
 
If you wish to make the same change in many records, you may use the Global functions 
which are described in Section 10.6. 
 
 
6.4  DELETING RECORDS – LOGICALLY AND PHYSICALLY 
 
To delete a record from the database: retrieve the record as for editing. Then when you are 
sure that the correct record is in the data entry window, select Options ⇒ Delete record. 
It will then not appear during searching. However, the data remain in the record and you may 
later undelete the record. Select from the data entry window: Options ⇒ Undelete record 
 
If you want to get rid of the record altogether and 'close up' the gap in Master File Numbers, 
the only way is to Export the whole database (which will exclude deleted records) and then 
Import it again. Exporting and importing are dealt with in Chapter 9. Do not do this if you 
have made any use of the MFN. (Some libraries write the MFN inside each book as it is 
catalogued.) 
 
 
6.5  DEFAULT VALUES 
 
It may be that you need to create several records that have one or more fields in common, e.g. 
you are cataloguing several books in a series with the same series title and imprint. To save 
having to type these data in each time, it is possible to set some default values which will be 
filled in already in the data entry window. 
 
If you have a record which you would like to use as a model, select the record and display it 
in the data entry worksheet. Then select Options ⇒ Define Default values [Model] 
 
Modify the record and save it. That will now be the model. 
 
Any new record will be based on the model. When you no longer wish to use the model, 
select Options ⇒ Clear Default values [Model] 
 
 
6.6  BROWSING THE DATABASE 
 
After you have entered your first few records in the database, you will want to see what they 
look like in your display format, i.e. the output format rather than in the worksheet which is 
the input format. 
 
To do this, close Data entry. Click on the right hand triangle button and you will see the 
record you have entered last. The format in which the records are displayed will be the 
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display format written into the database definition. You may want to change the format when 
you see it in use. How to do this is explained in Section 10.5. 
 
Click on the Format drop-down menu and try each format. You will see the format *ALL*. 
Click on that and the display will list all the fields in the record as entered. Other formats will 
give different displays of the same record. 
 
 
6.7  UPDATING THE INVERTED FILE 
 
When you have created some records or made some changes to existing records, you will find 
if you go to the search screens that you cannot search on the new data. This is because 
records are not inverted straight away, i.e. search terms have not yet been added to the 
inverted file. 
 
To update the inverted file, choose Database ⇒ I/F Update. The Inverted file maintenance 
screen is displayed. Select OK. The MFN of each record is listed while it is being inverted. 
At the end, click on the Completed button. 
 
You can now test the inverted file: select Search ⇒ Expert search ⇒ Dictionary 
 
A dictionary window will open and you will see the terms which have been indexed in 
accordance with the instructions in the Field Selection Table which was created when the 
database was created and possibly edited since. 
 
If the terms are not as expected you must revise the FST. See Sections 4.6 and 10.4. 
 
If you attempt to leave a database after editing without updating the inverted file, it will be 
updated automatically unless parameter 130 of syspar.par is set to 1. This may be changed 
by choosing Configure ⇒ System Settings ⇒ Options and clicking on Automatic Inv. File 
Update. 
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7    SEARCHING 
 
7.1 THE TWO SEARCH FORMS 
 
The normal method of searching makes use of the inverted file. Before you search a database 
you should make sure that the inverted file is up-to-date (see Section 6.7). It will need 
updating if any records have been added or modified since the last update. 
 
To search the database, choose Search on the menu bar. You can then choose either Expert 
Search or Guided Search. Guided Search gives you a search form with separate text boxes 
in which you can enter search terms. Expert Search gives you a form with one large text area 
in which you enter your search expression. The same basic principles of searching apply in 
either case. 
 
7.1.1  GUIDED SEARCH 
 
The form for a Guided Search is shown in Figure 7.1 below. 
 

 
Figure 7.1  Guided search form 
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You can enter up to four search elements. For each one, you can specify whether to search in 
All Fields (i.e. all inverted fields, as specified in the Field Selection Table for the database)  
or you can select a particular field from a drop-down list box. Restricting searches to 
particular fields is considered in more detail in Section 7.9. 
 
You can also choose to combine a previous search (if you have done one) with your new 
search elements. Finally, if you enter more than one search element, you can choose the 
logical operator with which to combine the terms: AND, OR or NOT from a drop-down list 
box. When you open the form, the operators are set by default to AND. 
 
To search for a single term, e.g. PLANT PHYSIOLOGY, type it in one of the search 
elements boxes. You can enter your search in upper- or lower-case letters, or a mixture. Click 
the Execute button. The Search Number box will then show 1, the Number of Hits box will 
show the number of records containing that term, and the Search Expression box will show 
the term you entered. 
 
After doing a search you can display the record(s) you have found by clicking the Display 
button. For more information about displaying see Section 7.2. 
 
7.1.2  EXPERT SEARCH 
 
The form for an Expert Search is shown in Figure 7.2. 

 
Figure 7.2  Expert search form 



The CDS/ISIS for Windows Handbook 71

To search for a single term, e.g. PRIMARY EDUCATION, type it in the Search Expression 
box. You can enter your search in upper- or lower-case letters or a mixture. Then click the 
Execute button or press {Enter}. 
 
The Search History box will show a message like: 
 
 #4 (CDS) T=2: primary education 
 
This means that for search 4 on the database CDS, there were two records retrieved and the 
search was for PRIMARY EDUCATION. To display these records, click the Display button 
(if there is one) or double-click on the relevant line in the Search History box. The next 
section attempts to explain why the method of displaying the results is so confusing. 
 
If you check “Automatically display Search Results” in Configure⇒ Systems Settings ⇒ Options  (or set 
parameter 105 of syspar.par to 1) the results will be displayed automatically after using the Expert Search form. 
 
 
7.2  DISPLAYING SEARCH RESULTS 
 
What happens after you click on Display depends on the setting of Parameter 980 in the 
syspar.par file (see Section 3.2). If you have Winisis version 1.31 or later and have not  
changed Parameter 980 since CDS/ISIS was installed, it will be set to 1. This will give you 
the “Table” display described below. If you have an earlier version of Winisis it may not 
have Parameter 980: this is equivalent to having Parameter 980 set to 0 (zero). In that case 
you will get the “Default search display”. You can change Parameter 980 either by editing 
syspar.par in a text editor such as Notepad or by choosing Configure ⇒ System settings ⇒ 
Options. There are three radio buttons, allowing you to select one of the following three 
options. 
 
 
(a) Default Search Display 
 
With this setting, the Display button is not available in Expert Search and you need to 
double-click on the relevant entry in the Search History display. The method of display is 
then the same as for browsing the database (Section 6.6), but moving between records will 
show only the retrieved records, not all the records in the database. 
 
(b) Alternate Search Result Tool Bar 
 
This is similar to the Default Search Display, but at the top of each record a bar is displayed 
giving information on the search number, the hit being displayed and total number of hits, 
and the option to Stop. It is caused by parameter 135 in syspar.par  being set to 1 (and 980 to 
0).  
 
 (c) Display Search Results in a Table 
 
Clicking the Display button then shows for each hit its record number (MFN) and the first 
field (if present) defined for that database. The order is by decreasing MFN, so the most 
recently added  records appear at the top: you can reverse this by choosing the down-arrow 
button  ↓. You can also select a different field to display using the drop-down list against 
“Tag:”.  
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To see a fuller version of a record, click on it and it will be displayed in the right-hand 
window. The search term(s) will be highlighted where they occur in the records. You can also 
click on the [+] icon next to the MFN to mark selected records. 
 
To stop browsing records, either click the red STOP button or click the Options button and 
select Stop Browsing Results (or another function if you wish). 
 
7.2.1  BROWSE FUNCTION 
 
Another way of looking at the results of a search is to choose Browse from the menu bar  
and then Search Results. You will be presented with a list of the searches you have done 
(Search History) and you can select the one you want. 
 
 
7.2.2  HIGHLIGHTING OF RETRIEVED TERMS 
 
When you display the retrieved records, each term you have searched on is highlighted 
wherever it occurs in the record – even if you specified searching one field only.  The 
example in Figure 7.3 shows one record retrieved by searching for PLANT in the CDS 
database. 
 
 

 
Figure 7.3  Highlighting of retrieved terms 
 
 
You can chose the colours used in highlighting from Configure ⇒ System Settings 
⇒Options and changing the values for Foreground color and Background color. The 
numbers correspond to the values in the Colours table which can be displayed in the CDS  
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database using the format cdscol. You can also turn highlighting off or on using the 
checkbox. (The settings are stored in parameter 142 of syspar.par.) 
 
 
7.2.3  DISPLAY FORMAT 
 
The format in which the records are displayed will be the display format written into the 
database definition. The default format, which is used if you do not specify otherwise, is the 
one with the same name as the database. It is possible to have more than one format for a 
database, e.g. a complete one and a shortened one - see Section 10.5. In this case you can 
change to another format by choosing from the Format drop-down menu. 
 
You will see a special format listed, which is not part of the database definition, called 
*ALL*. This displays the records as they are stored on the system with each field preceded 
by its numeric tag. It is useful for checking records and investigating problems. An example 
of a record in the *ALL* format is shown in Figure 7.4. 

 
 
Figure 7.4  Record displayed in the ALL format  
 
 
7.2.4 MARKING RECORDS 
 
When you are looking through the results of a search, you may decide that some records are 
relevant to your need but others are not. You can mark the relevant ones by clicking the 
Mark check box: a V appears in the box. Then in the Browse menu you can choose Marked 
Record to browse through the marked records only and in the Print Setup dialog box you 
can click the Marked Records Only check box. 
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You can mark records only after you have done a search. 
 
 
7.3  DICTIONARY DISPLAY 
 
The method of searching described above works by the computer looking for the term in the 
inverted file of the database being searched. If it finds the term there, it gets the number of 
hits: if not, it reports zero hits. If you then ask to display the records containing the term, the 
computer can find the numbers of these records from the inverted file. 
 
The inverted file is thus the key to what can be searched in the database, and the key to how 
you should enter the search term. If the inverted file reads: 
 
 1 MEAD, J 
 2 MEADOWS, J 
 1 MEADOWS, P 
 3 MEARNS, R 
 1 MEEK, B 
 
then it is no use searching for MEADOWS, AJ or MEADOWS, J. or MEADOWS, JACK. 
Your search will only succeed if you enter the search term exactly the way it is in the inverted 
file. Similarly, if the title has been entered on the inverted file as separate words, it is no good 
searching for a whole title such as PRINCIPLES OF ORGANIC SYNTHESIS or a phrase 
such as ORGANIC CHEMISTRY. 
 
Because the inverted file is so crucial in searching, it is very useful to be able to inspect it. 
You can then find out how to enter a search term correctly -- especially if you have just 
attempted a search and found nothing. To see the inverted file, click the Dictionary button on 
the Expert Search form or one of the Book icons on the Guided Search form, or choose 
Browse ⇒ Open Dictionary from the menu bar. The display will start from the beginning of 
the file (in the order of figures 0 - 9 then letters A - Z). If you want to see further down the 
file, you can use the forward button |> or you can type into the second text box where in the 
alphabet you want to start. For example, you could enter M or MEA: there is no need to enter a 
whole term. You will then get a display of the form shown in Figure 7.5. 
 
This is called the 'dictionary' because it does not contain all the detail of the inverted file. It 
only shows the indexed terms and the numbers of postings (i.e. how many times they occur in 
the database) whereas the inverted file also contains details of which records and positions 
they occur in. 
 
The top text box in the Dictionary window indicates <All fields>. This means that all terms 
on the inverted file will be shown. You can change it so that the terms from a particular field 
are distinguished. For example, if you select Title from the drop-down menu, terms from the 
title will be shown with their number of postings, while terms from other fields will be shown  
with – as their number of postings. 
 
What happens when you select a field is controlled by parameter 104 in the syspar.par file: 
 
104=0 This is the default. The dictionary is displayed as described above. 
 
104=1     Only terms from the selected field will be displayed. 
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Figure 7.5  Dictionary display 
 
 
 
 
In the simplest case, the inverted file (or terms dictionary) contains all searchable terms arranged in alphabetical 
order. However, it is possible to have similar terms grouped together by means of a prefix. For example, all 
authors could be given the prefix 'AU=' and so grouped together in A, and publishers might be grouped together 
with a prefix 'PU='. An example is shown below: 
 
 AU=ADMIRAAL 
 AU=BEARD 
 AU=JAMIESON 
 AU=WEBER 
 ELEPHANTS 
 LIONS 
 PU=COLLINS 
 PU=MACMILLAN 
 PU=MCGRAW HILL 
 TIGERS 
 ZEBRAS 
 
The prefix is added during inversion of the records by including it as a literal in the Field Selection Table (FST). 
If the publisher is in field 260, the entry in the FST might read: 
 
 260   0   'PU=' V260 
 
The prefix would then, of course, need to be entered when searching the database for authors or publishers. 
Prefixes are particularly useful for numbers or codes which may mean different things in different fields. 
 
In Version 1.4 it is possible to hide such prefixes when the dictionary is displayed and a specific field is 
selected. Instead of the display for Publishers appearing as: 
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 6  PU=COLLINS 
 3  PU=MACMILLAN 
 4  PU=MCGRAW HILL 
 
it will appear as: 
 
 6  COLLINS 
 3  MACMILLAN 
 4  MCGRAW HILL 
 
This is done by creating an EXP file for the database, i.e. a file in the same folder as the database files and with 
the same name but the extension .exp. So for the database ZIM it would have the name zim.exp. It needs to 
contain one or more parameters 550 set to the value of the tag and followed by the prefix used for that tag, e.g. 
 
 550=100 AU= 
 550=260 PU= 
 
Only those fields which are inverted with a prefix should be listed. 
 
When search terms are selected from the Dictionary display by dragging or by double clicking, the correct 
prefix will be restored, so they are only searched in the desired field.  
 
If you now want to search for the records containing one or more of the terms displayed, you 
can drag that term from the dictionary to the search expression box. Select the term by 
clicking once on it. Hold down the left mouse button and move the mouse pointer across to 
anywhere in the search expression box. Then release the mouse button. 
 
On the Expert Search form, if you drag across a term when there are already terms in the 
Search Expression box, the new term will be combined with the + (OR) operator. On the 
Guided Search form, you need to drag each term to a separate box: the dragged term replaces 
any term already there.  The Searchable Field is not set automatically if you have selected a 
field in the dictionary display. 
 
7.4  TRUNCATION 
 
The truncation facility allows you to look for a number of words or terms starting with the 
same letters. For example, you might want to look for any item to do with agriculture: it 
would be useful to search the terms AGRICULTURAL, AGRICULTURE, 
AGRICULTURALIST, etc. This can be done using the truncation symbol which is a dollar 
sign in CDS/ISIS. You would therefore enter the search as 
 
 AGRICULTUR$ 
 
Another use of this facility is searching for authors when they have been inverted as phrases 
and you are not sure of the exact form. 
 
 WALTON$ 
 
will retrieve WALTON D; WALTON DAVID; WALTON DH; WALTON, D.; etc. - as well, 
of course, as WALTON C, WALTON HOSPITAL and other Waltons. 
 
It might also be useful for searching classification numbers. With the Universal Decimal 
Classification you could search 54$ to retrieve all chemistry or 547$ to retrieve all organic 
chemistry. 
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You can either type the $ yourself or, on the Expert Search form, click the [$] button. In the 
latter case, beware that a space will be added before the $, which you will usually need to 
remove yourself. 
 
7.5  LOGICAL OPERATORS 
 
It is frequently necessary to combine two or more terms in a search, for example to find items 
about ECONOMICS of TRANSPORT, or a book by GRAHAM on MATHEMATICS. This 
can be done by using logical operators, of which there are three. 
 
1  AND. This operator would be used in the examples just given. In the first case we want to 
find those items each of which has the index term ECONOMICS and TRANSPORT. On the 
Guided Search form you would enter ECONOMICS in the first Search box, leave the 
Operator next to it as AND and enter TRANSPORT in the second Search Elements box. This 
is shown in Figure 7.6. 

 
Figure 7.6 Guided search using the AND operator 
 
On the Expert Search form you would enter ECONOMICS, click the AND button, then enter 
TRANSPORT. This is shown in Figure 7.7. For simplicity, we will write the search in this 
section as: 
 
 ECONOMICS AND TRANSPORT 
 
You actually enter it in one of the two ways described. In the display of the Search 
Expression the AND operator will appear as an asterisk, *. 
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Figure 7.7  Expert search using the AND operator 
 
In the second example, the record should contain the author GRAHAM  and the subject term 
MATHEMATICS, so you should enter: 
 
 GRAHAM AND MATHEMATICS 
 
In general terms, we could say that the AND operator narrows the search. Looking for 
ECONOMICS AND TRANSPORT is more specific than looking just for ECONOMICS. 
 
2   OR. This operator is useful for linking together several synonyms or related terms each 
relevant to the concept you are looking for. If you were trying to find everything about 
education in your database you might enter the search as: 
 
 EDUCATION OR SCHOOLS OR UNIVERSITIES OR TEACHING 
 
This means that each item retrieved must contain the term EDUCATION or SCHOOLS or 
UNIVERSITIES or TEACHING. An item might happen to contain more than one of these 
terms, but you are not insisting on that. 
 
You could also use this with author names, e.g. to find any items by WATSON or by 
SAYERS or by MARTIN: 
 
 WATSON OR SAYERS OR MARTIN 
 
The effect of the OR operator is to broaden the search: you expect to find more items if you 
look for EDUCATION or SCHOOLS or UNIVERSITIES or TEACHING than if you look  
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just for EDUCATION. In fact, it is a common error in searching for subjects to forget about 
synonyms and related terms. 
In the display of the Search Expression the OR operator appears as a plus sign, +. 

Make sure you understand the difference between the logical operators AND and OR. 
Someone might ask you for 'books about schools and universities'. But do they want each 
book to cover schools and universities or would they be happy with some books about 
schools and some about universities, i.e. each book is about either schools or universities? 

3   NOT. Sometimes you might want to exclude records with a certain term from your search. 
For instance, you might want to find all items in your database about STRUCTURAL 
ADJUSTMENT but which do not come from your own institute. In this case you would use 
the NOT operator, e.g. 

STRUCTURAL ADJUSTMENT NOT INSTITUTE OF DEVELOPMENT 
STUDIES 

It should generally be avoided in subject searching. For example, if you are interested in the 
treatment of tonsillitis not using surgery you might think of entering: 
 
 TONSILLITIS NOT SURGERY 
 
However, the 'not' would also exclude an article which discussed treatments both by surgery 
and by drugs. 
 
In the display of the Search Expression, the NOT operator appears as a circumflex, ^. 
 
It is possible to use these operators to refer back to previous searches. For example, your 
search 3 was for TRANSPORT and you now want to search for TRANSPORT AND 
ECONOMICS. In Guided Search, you can see the previous searches you have done by 
opening the drop-down menu below "Previous Search". Each set of records retrieved is 
identified in CDS/ISIS by a number preceded by a hash mark, e.g. 
 
 #3 (BOOKS)  T=25 : transport 
 
Select the search you want to combine and close the drop-down menu. Select the correct 
operator and then type in the search element to combine with it: ECONOMICS. Then click 
Execute. 
 
In Expert Search, the previous searches are displayed in the Search History box. You can 
drag the contents of previous searches into the Search Expression box using the mouse (and 
the search terms can then be edited). Alternatively if you click on a search in the Search 
History that was done in this database, its identifier (e.g. #3) is copied there. (If it was done in 
another database the contents of the search are copied.)  The previous searches are combined 
with any existing terms with the OR operator, but you can change that.  
 
 
7.6 ANY FILES 
 
You may find that there is a group of search terms which you often use together linked by 
OR. For example, if your information centre is responsible for East Africa, you might often 
need to search for 
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SOMALIA OR ETHIOPIA OR KENYA OR UGANDA OR TANZANIA 

To save having to spell out the countries each time, you could set up an ANY file. Then in 
Expert Search you would only need to click the ANY button and select ANY EAST 
AFRICA from the list, or in Guided Search you would just type ANY EAST AFRICA. 
 
The ANY file has to be created outside CDS/ISIS using a text editor or word processor (see 
Section 2.9.8). It needs to be held in the same folder as the database to which it refers, and to 
have the name of the database with the extension .any. For example, if you have a database 
called MINES, the corresponding ANY file should be named mines.any and this file should 
be in the same folder as mines.mst. 
 
The format of the ANY file is as shown below: 
 
 ANY EAST AFRICA               SOMALIA 
 ANY EAST AFRICA               ETHIOPIA 
 ANY EAST AFRICA               KENYA 
 ANY EAST AFRICA               UGANDA 
 ANY EAST AFRICA               TANZANIA 
 
The individual terms (SOMALIA, ETHIOPIA, etc.) must be one on each line, and they must 
start at position 31 on that line. There could be other ANY terms in the same file, e.g. 
 
 ANY WEST AFRICA               SENEGAL 
 ANY WEST AFRICA               GAMBIA 
 
but all the entries for a given ANY term must be grouped together. 
 
If you set up an ANY file and it doesn't work, the most likely reason is that you have miscounted the start 
position of the terms. 
 
 
7.7  PROXIMITY OPERATORS 
 
Suppose that you have inverted the title field with indexing technique 4, i.e. as keywords. If 
you then want to search for titles containing 'New York', you might search for: 
 
 NEW AND YORK 
 
This would find titles containing both the word NEW and YORK, but the words might not be 
adjacent. For example, there might be a title 'New buildings in York'. In fact the words might 
not even have come from the same field: there might be an author 'New' and a place of 
publication 'York'. 
 
You can make the search more specific in various ways. You could specify that the words 
came from the same field (or the same occurrence of the field if it is a repeatable field) by 
using the operator (F) instead of AND, e.g. 
 
 NEW (F) YORK 
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Even more specifically, you could specify that the words must occur next to each other in the 
field by using the adjacency operator, which is a full stop: 
 NEW . YORK 
 
There are other proximity operators available in CDS/ISIS and described in the Reference 
manual, but these are likely to be the most useful ones. 
 
7.8  BRACKETS 
 
The logic in search statements can sometimes get confused. You might want to look for any 
items about 'lions or tigers in Kenya or Uganda'. It would be tempting to enter the search as 
 
 LIONS OR TIGERS AND KENYA OR UGANDA 
 
You may know perfectly well what you mean, but unfortunately the computer doesn't. What 
it would do here is first combine TIGERS AND KENYA, so you retrieve items about tigers in 
Kenya, but then add all items about lions and all items about Uganda. This is because the 
AND operator is processed before the OR operator. (You can remember this as alphabetical 
order of operators.) 
 
The best way to avoid this kind of confusion is probably to do the search in small stages: 
 
 1. LIONS OR TIGERS 
 2. KENYA OR UGANDA 
 3. #1 AND #2 
 
However, if you think it's clever to do it all in one go, you can use brackets to show what is to 
be combined first: 
 
 (LIONS OR TIGERS) AND (KENYA OR UGANDA) 
 
What tends to happen is that you enter a search without brackets, get an impossible result, 
and then, hopefully, realise your mistake. 
 
 
7.9 FIELD IDENTIFIER 
 
If you wish, you can specify that a search term should only be retrieved if it occurs in a 
particular field. 
 
On the Guided Search form, you can specify one of the Searchable Fields for each Search 
Element by clicking on the arrow to the left of the Element box. ("Searchable fields" are 
those included in the Field Selection Table.)  This opens a drop-down list of searchable fields 
and you can select the one you want. Figure 7.8 shows a search for NEW as an author. 
 
 
Note that if you drag a term from the Dictionary, the field that the term occurs in is not 
automatically entered in the Searchable Fields box. 
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On the Expert Search form, you can specify the field using a slash and brackets. For example, 
if the author field is 100: 
 
 NEW/(100) 

 
Figure 7.8   Choosing the field in Guided Search 
 
If you drag a term from the Dictionary after selecting a searchable field, it is automatically 
copied with its field identifier. 
 
You can also specify more than one field, e.g. 
 
 YEMEN/(245,650) 
 
Strictly speaking, what you specify is not the field tag but the ID attached to that kind of term in the Field 
Selection Table (FST). However, to save having to remember two sets of numbers, it is usually best to use the 
tag number as the ID when you are writing a FST. 
 
 
7.10 FREE-TEXT SEARCHING 
 
This is available in Expert Search only. 
 
As explained in Section 7.1, the normal way in which CDS/ISIS does a search is to try and 
match any term(s) you type in against the inverted file. We will refer to this method now as 
direct searching. It is very quick, but it is limited by the decisions you made in writing the 
Field Selection Table when you defined the database. For instance, if field 260 is used for the 
publisher and you did not have an entry for field 260 in the Field Selection Table, you will 
not be able to search publishers directly. 
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However, there is another method of searching which does not depend on the inverted file. 
Rather, it depends on scanning through the records in the whole database (or a subset of the 
database) one-by-one looking for a word or term that you specify. This is a much slower 
process, somewhat like looking for a particular name in a book by scanning page-by-page  
instead of going to the index. The advantage, though, is that you can look for any term 
anywhere in the record, whether the field is indexed or not and whether the word is a 
stopword or not. 
 
This kind of searching is often known as serial searching, because the records are searched 
serially. CDS/ISIS calls it free-text searching. It is specified by using a question mark at the 
beginning of the search and using the same formatting language as described in Chapter 5. 
The colon (:) is used to mean 'contains'. Thus we could enter: 
 
 ? v260 : 'longman' 
 
This would look for those records where field 260 contains the word (or literal)  'Longman'. 
As with direct searching, upper- and lower-case are not distinguished. To search the whole 
text of the record, use v0, e.g. 
 
 ? v0 : 'yemen' 
 
You could look for more than one word, e.g. 
 
 ? v260 : 'cambridge university press' 
 
or part of a word (a string): 
 
 ? v245 : 'ase' 
 
The second example would find any record where field 245 contained the string of letters 
ase, for example oxidase, asexual, or case. 
 
A word of caution. Free-text searching searches the records as held in the database. This may not always 
correspond to the form displayed on the screen, which is determined by the display format used. Thus if you 
search for the publisher Macmillan in New York by searching for New York: Macmillan you may find 
nothing because in the record it may be entered as ^aNew York^bMacmillan. It is best to keep free-text search 
terms as short as possible for that reason. 
 
After you enter a free-text search, you will see a display of the kind shown in Figure 7.9. You 
will see the MFN advancing as the search proceeds through the database and if any records 

Figure 7.9 Free-text searching – progress message 
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match your search statement they will be added to the figure for 'Hits'. The '%' number shows  
what percentage of the records scanned so far match your search statement. When the search 
is complete, you can click the Completed button and display the records found just as with 
direct searching. 
 
If you have a very large database, a serial search on the whole database might take some 
time. You may be able to select a few records first by a direct search and then just search this 
subset by serial searching. For example, to find what chemistry books are published by 
Cambridge University Press you might first be able to search for 'chemistry': 
 
 Search expression 
 
 [  CHEMISTRY   ] 
  
 #5 (LIBC) T=18 :  chemistry 
  
Then only these 18 records from search 5 need to be scanned for the publisher: 
 
 Search expression 
 
 [  ?  #5 v260 : 'CAMBRIDGE UNIVERSITY PRESS'  ] 
 
There are other operators you can use apart from : (contains). If you were trying to find the 
journal called Weather, you could do a direct search: 
 
 Search expression 
 
 [  WEATHER  ] 
 
 #7 (LIBC) T = 55:   WEATHER 
 
If the title is indexed with indexing technique 4 (i.e. by keyword) then this search will 
retrieve all the titles which contain the word weather. To make the search more precise, you 
could next use a serial search: 
 
 Search expression 
 
 [  ? #7 v245 = 'WEATHER'  ] 
 
This means that the title must equal Weather, i.e. must contain that word alone, and so should 
find just the title you are looking for. 
 
It is also possible to use the operators > (greater than) and < (less than). If you include an entry date for each 
record in the form year-month-day, e.g. 1994-03-17, in field 10 and you want to find which records have been 
added since 1st February 1994, you could search: 
 
[ ? v10 > '1994-02-01' ] 
 
 
In this example, we are comparing strings of identical length. What if you have a date subfield (say v260^c) 
containing data like Mar. 1992, 1994 (copyright), [1972]? It is possible to do a search on a field containing data 
in these different formats using the function val. This function converts text into a numeric form. Any  
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comparisons of strings are made on the basis of their value. If we want to find anything published in 1990, we 
can enter 
Search expression 
  
[ ? #7 val(v260^c)=1990  ] 
 
This will look at each subfield 260^c, find the first string consisting of numbers (and ended by a non-numeric 
character) and convert it to a number for computation. It must therefore be compared with a number, 1990, not a 
literal, '1990'. 
 
 In a similar way, you could do a search for documents with more than say 24 pages. If you had a field v30 
containing pagination and height with the following format: 126p; 25 cm, val(v30) would take only the first 
number it found, in this case 126. Subsequent numbers are ignored. If you had a field containing cxv p, 18 cm 
(the number of pages being expressed in Roman numerals), CDS/ISIS would take 18 as the value of this field. 
 
Another type of search that is sometimes useful is to look for those records in which a 
particular field is present or absent. This is done using the functions p or a respectively. 
(These have already been used in the examples of Data Entry validation rules in Section 4.4.)  
You might have a membership database in which field 99 records the date when the member 
paid his or her subscription for 1999. When you want to send out reminders to people who 
have not yet paid for 1999, you could use the free-text search: 
 
 ? a(v99) 
 
This would find the records with no entry in field 99. If you wanted to know how many 
members had paid for 1999, you could search 
 
 ? p(v99) 
 
These expressions can be combined like other search terms, so the search 
 
 ? p(v98) AND a(v99) 
 
will find those records where field 98 is present but field 99 is absent. Note that you must 
type the words AND, OR and NOT: you may not use *, + and ^ here. 
 
You may search through all fields at once by using the field number zero, though it may take 
some time on a large database. For example,  
 
 ? v0 : 'the' 
 
will retrieve every record containing the string the in any field, which could be in the words 
then, mother, or thermometer. 
 
 
From version 1.4, you can do a free-text search on a section of the database specified by a 
range of MFNs, e.g. 
 
 ? *500,1000 v70 : 'harare' 
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7.11 SAVING SEARCHES 
 
If you have a search that you may need to repeat in the future, e.g. a profile of a user’s 
interest that you are going to run regularly against additions to your database, you can use the 
Save search facility. Carry out the search using the Guided or Expert Search form. If you 
used Guided Search, close the search form. Then choose Search ⇒ Save Search. The search 
history is displayed: click on the search you want to save. Then choose a folder and filename 
for the saved search. 
 
To rerun the saved search in the future, choose Search ⇒ Recall Saved Search. Select the 
filename and click OK. The search will run and the results will be displayed. The search will 
appear in Search History and can be combined with other terms if required. 
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8    SORTING AND PRINTING 
 
8.1  INTRODUCTION 
 
There are two main ways in which you can print records from a CDS/ISIS database. One is to 
display a record on the screen and copy it onto the Clipboard. You can copy several records, 
one at a time. Then you can "paste" from the clipboard into an application that allows 
printing, e.g. Word for Windows. This is explained further in Section 8.2 below. 
 
If you have more than a few records to print, or you do not want to bother with another 
application, you can make use of the sophisticated printing and sorting facilities of CDS/ISIS 
for Windows. To do this, choose Database ⇒ Print, or click on the Printer icon on the 
toolbar. The Print Setup Window is shown in Figure 8.1. There are five dialog boxes 
provided for specifying your printing requirements:  the second to fifth boxes (Presentation, 
Margins, Layout and Sorting) are accessed by clicking on their tabs. These dialog boxes are 
described in Sections 8.4 to 8.8. It is possible to send the output either to your default printer 
or to a file in Postscript format for printing on an appropriate printer. 
 

 
Figure 8.1  Print Setup Window 
 
 
8.2  PRINTING USING THE CLIPBOARD 
 
The Clipboard provides temporary storage for data you want to transfer. You can cut or copy 
data from a record displayed on the screen onto the Clipboard and then transfer those data  
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into another application. Data put onto the Clipboard remain there until you clear the 
Clipboard or quit Windows. 
 
The Clipboard in CDS/ISIS operates in two modes. You can switch the Clipboard mode by 
clicking on one of the two buttons [TXT] and [RTF] on the Toolbar. One button will appear 
to be "pressed in" to indicate which mode is in use. 
 
The default mode, which is set until you change it, is Text Mode. This means that when you 
paste data to the Clipboard, only the characters are stored - not any details about font sizes, 
colours, use of bold or italics, etc. Such data should be suitable for use in almost any 
application - a word processor, electronic mail, re-inputting to a CDS/ISIS data entry form, 
etc. 
 
The second mode is Rich Text Format (RTF) mode. When text is stored this way, codes are 
also stored which hold information about the font sizes, colours, use of bold and italics, etc. 
(These codes are similar to the “Windows features” of the CDS/ISIS formatting language 
described in Section 5.6.)   If you paste from the Clipboard in RTF mode into a text editor 
such as Notepad or Wordpad, you will see something like this: 
 

{\rtf1\ansi{\fonttbl \f0\fnil Courier New; \f1\fswiss Arial; }{\colortbl 
\red0\green0\blue0;;;}\cf0 \f0\fs24 0001 - Techniques for the measurement of 
transpiration of individual plants. Magalhaes, A.C.; Franco, C.M. Paris, Unesco, -
1965. p. 211-224, illus. (Methodology of plant eco-physiology: proceedings of the 
Montpellier Symposium) Incl. bibl.  
\fi-1270\li1270 KEYWORDS: Paper on: plant physiology; plant transpiration; 
measurement and instruments. \fi0\li0  

 
Save this file as text with the extension .rtf, e.g. myfile.rtf. Then you can open it in 
Microsoft Word, which recognizes Rich Text Format and will display a fair representation 
(but probably not an exact copy) of the original display in CDS/ISIS. To paste CDS/ISIS 
records into an existing Word document, first save the document in Rich Text Format, open it 
in a text editor and paste in from the Clipboard, then save it and reopen it in Word. 
 
The fifth button on the Toolbar (showing a blue document, a red arrow and a clipboard) 
copies the record currently displayed on the screen onto the Clipboard. Alternatively you can 
choose Edit ⇒ Copy to Clipboard. If there are data already on the Clipboard, the new data 
are added at the end. The fourth button on the Toolbar clears the Clipboard: you can also 
choose Edit ⇒ Clear Clipboard. 
 
The way of "pasting in" text from the Clipboard depends on the application you are using, but 
it can often be done by choosing Edit ⇒ Paste, or by typing {Ctrl v}. The latter method 
can be used in CDS/ISIS Data Entry. 
 
 
8.3  PRINTING AND SORTING FACILITIES - PRELIMINARIES 
 
If you wish to use the printing and sorting facilities, there are a couple of things worth 
thinking about before opening the Print Setup dialog. 
 
1  Although you can write or edit a print format in the General dialog box, it is a lot easier to 
get your format right while you are browsing the records. This could be the display format  
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that you set up in the database definition (Section 4.5), which will have the same name as the 
database. Alternatively, you may want to use a different format in the printout. Adding new 
print formats is covered in Section 10.5. It is a good idea to try out the format by browsing 
some records in this format. You can change the format much more easily at this stage than 
after you have produced reams of printout. 
 
One thing to watch is that you will probably want one or more blank lines after each record in 
the printout in order to distinguish the records. This need will probably not be obvious when 
you display the records on the screen. You can achieve the desired effect by putting two or 
more hash signs at the end of your format (see Section 5.3). You need one more hash sign 
than the number of blank lines to be produced. Note that slashes cannot be used to do this as 
they never produce a blank line. An example is shown in Figure 8.2. 
 
________________________________________________________________________
 Record format 
 
  Field 10 :  author 
  Field 20 :  title 
 
 
 (a) Display format  v10/v20 
 
  Chaucer, G. 
  Canterbury tales 
  Churchill, W. 
  A history of the English speaking peoples 
  Clarendon, Earl of 
  History of the rebellion 
 
 (b) Display format v10/v20### 
 
  Chaucer, G. 
  Canterbury tales 
 
 
  Churchill, W. 
  A history of the English speaking peoples 
 
 
  Clarendon, Earl of 
  History of the rebellion 
 
Figure 8.2  Formatting for line spaces between records 
 
 
 
2  You need to have decided which records from the database you want to print. If you want 
to print the whole database there is no problem. If you want to print records between certain 
Master File Numbers, e.g. 25-60, you need to have checked what these numbers are. If you 
want to print records selected by some search criterion, e.g. with accession dates beginning  
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9709 (for September 1997), or with the descriptor FOOD TECHNOLOGY, you will need to 
do a search first before going to Print Setup. 
 
You can open the Print Setup window by clicking the Printer button on the toolbar or by 
choosing Database ⇒ Print. There are then dialog boxes which can be opened by means 
of their tabs. 
 
 
8.4 GENERAL 
 
The first dialog box to complete is called "General". This allows you to say what and where 
to print and to define the print format. It is shown in Figure 8.1. 
 
You need to select the records to print either as the results of a search or by Master File 
Numbers (MFNs). This is done by clicking on one of the option buttons Current Browse 
Set or MFN Range. Current Browse Set means the set of records retrieved in your last 
search. In this case, you can also click on the check box Marked records only if you have 
marked some records (see Section 7.2.4). If you choose MFN Range, you should enter your 
selection of MFNs in the text box. Some possible formats for this are: 
 
 17   Print record number 17 
 -5   Print records up to number 5 
 60-   Print from record 60 onwards 
 19-30  Print records 19-30 
 -5,17,19-30,60-Print this combination of ranges 
You could print the whole database by choosing an appropriate range of MFNs. 
 
Next you can specify where the output from the printing should go by means of the Output 
to combo box. It should be showing the printer configured as your default printer. The button 
with the Printer icon next to this combo box allows you to change your printer settings if 
necessary.  Alternatively you can send the results to a file in Windows-ASCII, DOS-ASCII or 
Postscript format. This has the advantage that you can check the output file on the screen 
before committing it to paper. You could then use a word processor to paginate the text and 
do other editing if necessary. The two versions of ASCII differ in the way that special 
characters are coded, though of course much of the formatting detail will be lost. When you 
have created a file in Postscript format, you can copy it to a Postscript printer for printing. 
 
The print format can either be one which you have defined and named already, or one which 
you now write in the large text area. The latter alternative is not recommended, but it might 
be useful for making a minor change to your predefined format by editing it in the text area. 
For example, you may want to add some hashes at the end (see Section 8.3). When you are 
using a predefined format, the Predefined Format checkbox is crossed: when you edit it the 
cross disappears. A predefined format for that database can be selected by means of the 
combo box.  
 
If you do write your own format or edit an existing one, you can save the format by clicking 
the button showing a floppy disk. This works like saving any other file in Windows. 
 
There are also some command buttons down the right-hand side of the dialog box. Recall 
allows you to call up a previously saved print worksheet. Save allows you to save your  
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worksheet so that you can produce similar prints in the future without having to repeat all 
your work. Preview lets you see what the first page will look like before printing. (The 
buttons on the Preview screen apart from Close do not work at present.)  Print starts the 
printing process, but don't be too hasty - there are four more pages!  Close (indicated by an 
exclamation mark in a red triangle – the message was missing in the initial release of Version 
1.4) allows you to change your mind and do something else. Help should be self-explanatory. 
 
 
8.5  PRESENTATION 
 
This dialog box allows you to add titles, headers and footers to your print. It is illustrated in 
Figure 8.3. 
 
At the top of the dialog box there is a combo box allowing you to edit these objects: 
 
 First title 
 Second title 
 Third title 
 Header 
 Footer 
 

 
 
Figure 8.3  Presentation dialog box 
 
 
"First", "second" and "third titles" are three pieces of text which you can have printed on your 
printout. Each one can come on a separate page at the beginning (as a "cover"), at the top of  
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the first page of records, or at the top of every page of records. The header comes at the top 
of every page and the footer comes at the bottom of every page. 
 
For each "title" you would like on your printout, you select it from the first box, then click the 
boxes for "Use as a cover" and "Keep title on all pages" if you wish. The remaining boxes 
apply also to headers and footers. The text for the object you type into the large area. You can 
pick alignment of the text to the left, to the right, or have it centred by clicking on the 
appropriate button. You can choose to have the text in italic, bold, underlined or 
combinations of these (but you cannot vary them within the text). The font and font size can 
be selected from the two boxes on the right. (Again they cannot vary within the text.)  The 
facility to have a frame round the text is not working yet. 
 
As an example, the following three titles might be set up: 
 
 
________________________________________________________________ 
 
First title:   INSTITUTE OF DEVELOPMENT STUDIES 
 
 [ ]   Use as a cover                         [X] Keep title on all pages 
 
Second title:   Accessions list 
 
 [X]  Use as a cover                          [ ] Keep title on all pages 
 
 
Third title:   July 2001 
 
 [ ] Use as a cover   [ ] Keep title on all pages 
 
 
 
The first page of the printout (the cover) will be printed only as: 
 

Accessions list 
 

The second page will have the heading: 
 

INSTITUTE OF DEVELOPMENT STUDIES 
 

July 2001 
 

followed by the records being printed, and the third page will have the heading: 
 
 INSTITUTE OF DEVELOPMENT STUDIES 
 

There is a bug in the function which outputs to a Postscript file. When you print the file, the first page 
prints as a mirror-image of what it should be. To get round this, include a “dummy” cover page which 
you can discard after printing. 
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8.6  MARGINS 
 
Here you define what area of the page you want to print on (or more precisely, the areas you 
do not want to print on!)  The dialog box is illustrated in Figure 8.4. 

 
 
Figure 8.4  Margins dialog box 
 
 
You can define the size of the margin at the top of the page, the bottom of the page, the left 
hand side (Inside) and the right hand side (Outside). If you are intending to bind your 
printout down the left hand side, you can specify extra space to be added to the inside margin 
(Gutter). 
 
When you first go to this dialog box, the values are set to 10 mm for Top, Bottom and 
Outside margins, 15 mm for Inside margin, and 0 mm for Gutter margin. You can increase 
each value by clicking the upward-pointing arrow next to it, or decrease it by clicking the 
downward-pointing arrow. The Measurement Unit can be selected from a combo box as 
Millimetres, Centimetres, Inches or Twips (see Section 5.6.5 for what a "twip" is.)  The Paper 
Size can be set to A4, Letter (8.5 by 11 inches), Legal (8.5 by 14 inches) or User Defined. In 
the last case you then set the height and width of the paper in the boxes next to the diagram. 
 
There are three further boxes in the "Special" frame. Data Indention (i.e. Indentation - there 
was not room for the full word on the DOS version worksheet!) is most useful for indenting 
records with respect to headings when you are producing sorted listings - see Section 8.8. 
 
EOC (i.e. End Of Column) tolerance. If a record will not fit the space available at the 
bottom of a page, CDS/ISIS will print part of it on that page and the rest of the record on the  
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next page (or column). You might not like this to happen, especially if only one line is 
printed at the bottom of the first page. The End of Column Tolerance means how many lines 
space must be left at the bottom of the page for CDS/ISIS to start printing a record. If you set 
it to 3, a record might be split as shown below. 
______________________________________________________________________ 
 
 World Conservation Strategy. International Union 
 for the Conservation of Nature and Natural Resources, 
 in co-operation with the United Nations Environment 
 
                              5 
 --------------------------------------------------------- 
 
 Programme and the World Wildlife Fund. IUCN: Gland, 
 Switzerland, 1980. 
 
________________________________________________________________________ 
Figure 8.5  A record split between pages 
 
 
The greater you make this number the less likelihood of records being split, but if you set it at 
10, say, there could be nine blank lines at the bottom of a page. You need to consider how big 
the records are and how concerned you are about their being split. 
 
Finally in Version 1.4 you can set Record height is fixed and the measurement. This makes 
it possible to specify the height of the record when printed. If the text does not fill it some 
blank space will be added: if the record is too long it will be truncated. This is to allow the 
printing of labels – see Section 8.11. The Changes and News for Version 1.4 Build 19 warn 
that “the current implementation doesn’t apply exact measurement”, but at least “all records 
will have the same height”. 
 
 
8.7  LAYOUT 
 
In this dialog box you can specify more about the page layout and the number of columns. It 
is illustrated in Figure 8.6. 
 
Firstly there is a frame to do with columns. There is a spin box for the number of columns 
across the printed page (set by default to one) and one for the space between the columns, 
using the current unit of measurement (set by default to10). Then there are three radio buttons 
for choosing no decoration, a line between the columns, or a border round each column, 
respectively. Next you can choose whether there should be a maximum number of records 
per page or column and if so what that number should be. This could be useful in printing 
labels or cards – see Sections 8.10 and 8.11. 
 
Below that, the frame allows you to ask for page numbers and say where they should appear. 
There is a check box to request that page numbers are printed and a separate one for a page 
number on the first page of printout. Then you can choose from a combo box whether the 
number comes at the top or bottom of the page, and from the next box whether the number 
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Figure 8.6  Print setup – Layout dialog box 
 
appears on the left, centre or right of each page. Alternatively, you can ask for the numbers to 
be placed on the inside or outside of each pair of pages. You can pick the first page number to 
be used by means of a spin box, e.g. if there was a 10 page introduction to your listing you 
could start it at page 11. 
 
At the top right of the page, there is a spin box for applying a "zoom" factor. By default it is 
set to 100% but you can vary it between 50 and 120%. It allows you to fit more or fewer 
records on a page by varying the font size, but with no changes to your print format. Then 
there is a group of three check boxes. The first two are for Don't use titles and Don't use 
sorting. If you are using a format which you have set up and saved on a previous occasion, 
but on this occasion you don't want to include the titles or you don't want to have the records 
sorted, you can "turn off" these features by means of the check boxes. (If you do not use 
sorting, the records will be printed in order of ascending MFN, i.e. the order that they are on 
the database.)  The third one Just make HIT file provides a way of sorting the database into 
a different order: this is described in Section 9.6.  
 
There are also command buttons on this page to Preview the printout, start Printing, Cancel, 
or ask for Help. If you have never tried printing from Winisis before, it would be a good idea 
to print some records now. Otherwise, if you want to specify sorting instructions, click the tab 
for Sorting. 
 
8.8   SORTING 
 
To understand the controls in this dialog box, we need to think first about what sorted output 
looks like, say in a printed library catalogue. 
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A catalogue entry consists traditionally of two parts: a heading (usually the author) which is 
used to put the entry in place alphabetically, and a description which describes a book or 
document. This is illustrated in figure 8.7. 
__________________________________________________________ 
 
KNOWLES, Leonard                                <-  Heading 
 Court of drama / Leonard Knowles. - 
 London: John Long, 1966. 176pp.       <-  Description 
 
____________________________________________________________ 
 
Figure 8.7  The parts of a catalogue entry 
 
Here the author forms the sort key used to sort the entries in order. For a prolific author, there 
may be subheadings under the author heading. These subheadings form a second sort key, 
e.g. 
 
SHAKESPEARE, William 
  Plays 
 All's well that ends well ... 
 
 As you like it ... 
 
 
  Poems 
 The phoenix and the turtle ... 
 
Below the subheadings, the entries will probably be sorted by some other element, e.g. the 
title. However, this additional sort key may not actually be used as a heading. 
 
We are now ready to consider the questions in the Sorting dialog box, illustrated in Figure 
8.8.  
 
a. N[umber] of headings. This actually means the number of levels of heading to be used. In 
the above example it is two: author and type of literature. The maximum is four, though the 
number will usually be one less than the number of sort keys. In the example, the title forms 
the third sort key and it forms the beginning of the description. If the first field in the 
description is the one you are sorting on, you will want no headings at all. 
 
b. Stopword file. If sort keys are generated from a field using indexing technique 4 
(individual keywords) a stopword list can be used to avoid words like "THE" or "AND" 
being used. The name of the stopword file should be entered here. How to construct a 
stopword file is explained in Section 4.7. 
 
c. Heading format. You can provide your own format for printing the headings, using the 
formatting language explained in Chapter 5. However, at least to begin with, you can leave 
this blank and let CDS/ISIS construct the heading format itself. 
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Figure 8.8  Print setup – Sorting dialog box 
 
 
 
d. Sort key parameters. Up to four sort keys may be specified. If two records have the same 
primary sort key (e.g. author) they will then be sorted by secondary sort key (e.g. literary 
form). If this is the same they will be sorted by the tertiary key (e.g. title) and so on. 
 
If a record does not contain the primary key (e.g. no author) it will not appear in the sorted 
listing. If you do want it to appear, you must cater for this specially using the formatting 
language. 
 
For each sort key, you must give three pieces of information: 
 
i. Key length. This defines how many characters are taken from the specified field(s) to 

form the sort key. The longer you make the sort key the more computer memory will 
be needed and the longer the sort will take. If you make the length 200 characters, you 
will cater for very long terms but sorting will be very slow. If on the other hand, you 
make the length 15 characters, sorting will be much quicker but names with the same 
initial 15 characters (e.g. UNIVERSITY OF NEW MEXICO and UNIVERSITY OF 
NEWCASTLE) will not always appear in the correct order. There is no 'right answer' 
to this question but you might try 30 or 40 at first. If you have a powerful computer 
you may well find that sorting is still fast with a length of 200!  

 
ii.  Heading processing indicator. Again this is probably understood most easily by 

figure 8.9. 



The CDS/ISIS for Windows Handbook 98

 
 
______________________________________________________________________ 
RECORD 1 
 
Author:   Lipton, Michael 
Title:     The role of the World Bank in agricultural development in the 
           1990s 
 
RECORD 2 
 
Author:    Lipton, Michael 
           Toye, John 
Title:     Does aid work in India? 
 
_____________________________________________________________________ 
Figure 8.9  Repeated and non-repeated headings 
 
If we produce a listing using author names as headings, there are two choices to be made. 
Firstly, do we want 'Does aid work in India' to appear twice: once under Lipton and once 
under Toye?  Secondly, when the two works appear under Lipton, do we want the heading 
'Lipton, Michael' to be repeated as: 
 
 Lipton, Michael 
  Does aid work in India? 
 
 Lipton, Michael 
  The role of the World Bank in agricultural development in 
  the 1990s 
 
or do we want the heading to appear once only? 
 
These two choices give us four combinations, numbered (in true programmer's style!) 0 to 3: 
 
0. Headings don't repeat. Records don't repeat. 
 
1. Headings don't repeat. Records repeat. 
 
2. Headings repeat. Records don't repeat. 
 
3. Headings repeat. Records repeat. 
 
You give your answer to both choices together by means of the Heading Processing 
Indicator. Probably the most common form for a library catalogue would be Indicator 1: 
records are repeated under each heading for joint authors, etc., but the heading is not repeated 
if there are several records under it. However, if you are printing an accessions list you 
probably will not want the same book to appear several times and you might choose Indicator 
0. 
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iii.  A Field Selection Table. This is written in the same way as the Field Selection Table 
for inversion (Section 4.6). There data were selected from the record to be entered on the  
inverted file: here data are selected to act as sort keys (and the corresponding headings if 
applicable). As in inversion, the sort key is always converted to upper case. 
 
Note that for the Field Selection Table to be operative (i.e. for sorting to take place) the box 
next to “FST” must be checked. The check box provides a temporary way of “turning off” 
one or more FSTs. 
 
The elements of the Field Selection Table are as described in Section 4.6, e.g. 
 1 0 v100 
 
This selects sort key 1, using the whole field (Indexing Technique 1) from field 10. Note that 
the tag, Indexing Technique and format are separated by spaces. 
 
If you want to select sort keys from more than one field (e.g. main author and added author), 
you can use a plus sign, e.g. 
 
 1 0 v100 + 1 0 v700 
 
The sort keys from field 100 and from field 700 will be sorted into a single sequence. 
 
Instead of writing out the FST, you may use an FST which you have already prepared in 
Database Definition Services. This is particularly useful if you have complicated sorting 
requirements. You enter here its name preceded by an at sign, e.g. @SORT. An example of 
this is shown in Figure 8.14. 
 
An example of a completed sorting dialog box is shown in Figure 8.10. 
 
You can now click the Print button to put your specification to the test. You may find that 
the field(s) you are now using as headings were also included in the main part of the entry. In 
that case you may want to edit the print format or create a special one to be used in this 
listing. 
 
8.9  SAVING YOUR PRINT SPECIFICATION 
 
You may want to produce similar printouts at regular intervals, e.g. a printed catalogue every 
quarter, or a list of new accessions every month. It is very tedious and error-prone to have to 
enter essentially the same data on the dialog boxes each time. The title, print format, line 
width, sort keys, etc. will probably stay the same each time and you may therefore find it 
useful to enter the values once, test them, and then save your specification. To save a 
specification after entering it, click the Save button on the General page. You are asked to 
give it a file name and choose a folder: the name is given an extension .wpr. 
 
Next time you want to print with this specification (perhaps with slight modifications) go into 
Print Setup, click Recall and select the .wpr file. You can make modifications on each of the 
five pages if you wish and on the Layout page you can click Don’t use titles or Don’t use 
sorting without having to delete these parts of the specification. You can also turn off one or 
more FSTs on the Sorting page. If you are printing a selection from  the database (e.g. records  
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added in the last month) you will need to do a search each time and then print Current 
browse set. 
 
 

 
 
Figure 8.10  Completed sorting dialog box  
 
At the time of writing, there is a bug in the program which means that when a print 
specification is recalled, the default print format (with the same name as the database) 
appears as the print format name, whatever format was saved. The format specification is, 
however, correct.  
 
 
 
8.10  PRINTING CATALOGUE CARDS 
 
Although computers have become commonplace in libraries throughout the world, there are 
still libraries that have a need for printing cards – sometimes in order to integrate new entries 
produced in CDS/ISIS with a pre-existing card catalogue. In that case, you will need to write 
a print format to make the cards look as near as possible to the format already used.  
 
You will presumably either be using a dot-matrix printer with continuous feed (i.e. the cards 
have perforated margins containing sprocket holes) or you will use a laser or inkjet printer, 
print on to A4 sheets of card, and then cut them into individual cards. The latter method is 
more tricky to set up as you have to take more care to get the spacing right. The simpler way 
is to use the dot-matrix printer.  
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You need some way of setting the printer page length to the length of the catalogue card 
(usually 3 inches). You will have to determine this from the manual, the manufacturer or the 
supplier of your printer. You may well find that choosing from the Task Bar Start Settings 

 Printer, clicking on the icon representing your printer and then choosing Printer  
Properties will allow you to set the dimensions of your page. 
 
You need to decide on a format for the catalogue cards and the kinds of added entry you wish 
to be printed. You may wish to print tracings at the foot of each card since if you withdraw a 
card or wish to change it, you need to know which other cards refer to the same book (or 
other library item). As regards added entries, it is no trouble for the computer to make as 
many added entries as there are in the catalogue record: the problem is that someone has to 
file them! Many manual card reproduction systems, such as those using stencils, work on the 
unit entry principle where a main entry card is made and reproduced with the added entries 
typed at the top of the additional cards. This can be reproduced in CDS/ISIS. Alternatively if 
you produce a format which has at the top of each record the title, you can generate all the 
index entries above that. We will demonstrate this method.  
 
Make a note of the fields for which you wish to make added entries and create a Field 
Selection Table containing them. Edit  Field SelectionTable  New. Call it cards and 
create the table by selecting the fields for which you wish to produce cards. In CDS/ISIS for 
Windows it is difficult to produce a FST where the tag is different from the one in the format. 
It may be best to produce one in the usual way. Then change the file later in an editor, since it 
is best to number the ‘fields’ produced in sorting consecutively from 1 onwards rather than 
with the original tags.  
 
Create the print format: you may already have one that you wish to use, but it is a good idea 
to create a new one based on it and call this CARDS in case you wish to change the format 
specifically for printing cards. 
 
The following example uses AACR and is based on the UNIMARC exchange format. 
Because of the way CDS/ISIS works, a heading has to be generated for each card as the cards 
are printed in alphabetical order of the heading. This is convenient for the person who has to 
file the cards as the cards will already be sorted into alphabetical order, though the cards may 
well not all be filed into the same catalogue if there are separate author and title catalogues. 
We do not include subject headings in this example but you could add the fields for subject 
headings: they would usually go in a separate subject catalogue. 
 
Note that in the example below we output the file direct to the printer. If you want the rich 
selection of typefaces and styles that you can get on the screen you must output direct to the 
printer. If you send to a file, this can only be added later in a word processor. 
 
The values are complex and must be entered correctly, Thus you must save the Print setup to 
avoid having to enter them again. When you have filled them in you can click on the Save 
button and give it a file name which should have a wpr extension. 
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Figure 8.11 Print setup for cards 
 
You do not need to amend the Presentation dialog box: the values may be retained as they 
are. The Margins dialog box is difficult. Ensure all the margins and gutter are set to zero 
since there is no room on a catalogue card for a margin. Make sure the measurement unit is 
NOT millimetres. If you leave it at that you may find the printer prints blank pages and will 
not stop until you abort the program and turn off the printer. The paper size must be user 
defined since the settings for catalogue cards are not in the list. The dimensions can be set at 
12 cm across and 6 cm down (not quite 5 inches by 3 inches but you need to avoid the bottom 
of the card which cannot easily be read in the card drawer). EOC tolerance should be set at 16 
lines. All these values are reproduced in Figure 8.12. The only change on the Layout dialog 
box is to tick Max records per page/column and ensure it is set at 1. This will ensure that 
each card comes on a new ‘page’ as the printer will be set to with a page length of the size of 
a card. Finally the Sorting worksheet should be set up as displayed in Figure 8.13. This relies 
on the Field Selection Table cards.fst which is reproduced in Figure 8.14 below. 
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Figure 8.12 Margins settings for printing cards 

 
Figure 8.13 Settings for creating the entries 
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1 0 MHL,(V700^a,| |V700^b,| |V700^c,| |V700^f/) 
2 0 MHL,(V701^a,|, |V701^b,| |V701^c,| |V701^f/) 
3 0 MHL,(V702^a,|, |V702^b,| |V702^c,| |V702^f/) 
4 0 MPL(ref->unif(l->unif(v700^3),|v200^a,|, |v200^b,| |V200^c,| |V200^f)/) 
5 0 MPL(ref->unif(l->unif(v701^3),|v200^a,|, |v200^b,| |V200^c,| |V200^f)/) 
6 0 MPL(ref->unif(l->unif(v702^3),|v200^a,|, |v200^b,| |V200^c,| |V200^f)/) 
7 0 MHL,(|V710^a,| |V710^b,| |V710^c,| |V710^d,| |V710^e,| |V710^f/) 
8 0 MHL,(|V711^a,| |V711^b,| |V711^c,| |V711^d,| |V711^e,| |V711^f/) 
9 0 MHL,(|V712^a,| |V712^b,| |V712^c,| |V712^d,| |V712^e,| |V712^f/) 
10 0 MHL,(ref->unif(l->unif (v710^3),|V210^a,| |V210^b,| |V210^c,| |V210^d,| 

|V210^e,| |V210^f)/) 
11 0 MHL,(ref->unif(l->unif (v711^3),|V210^a,| |V210^b,| |V210^c,| |V210^d,| 

|V210^e,| |V210^f)/) 
12 0 MHL,(ref->unif(l->unif (v712^3),|V210^a,| |V210^b,| |V210^c,| |V210^d,| 

|V210^e,| |V210^f)/) 

 
Figure 8.14 Field Selection Table cards.fst 
 
Note that those lines which contain the ref function pointing to the UNIF authority database 
may be omitted if you are not using an authority file. 
 
When all the changes have been made save the worksheet as a wpr file 
Database Print  Save 
 
Please note that next time you run the program, you will choose Database Print  Save 
and select the name of the wpr file. You will find that the print format will be as it was saved 
before even though the default format is named. There is a bug in the program and the only 
change you made in the Layout dialog box, to tick Max records per page/column and 
ensure it is set at 1, may need to be reactivated. Otherwise you can repeat the procedures to 
print cards as often as you wish. You will note that in the example we gave MFN range the 
value of 1/1. This is to prevent the whole database being printed out in error. In practice you 
may wish to select records by searching, say, for all those produced after a particular date but 
normally if you produce the cards regularly to add recent additions to a catalogue, you will be 
able to print out from a range of MFNs. 
 
More information on implementing UNIMARC is found in Section 13.3. 
 
 
8.11  PRINTING LABELS 
 
If you have a database of names and addresses, such as a list of members, vendors or 
exchange partners, you may want to print a set of labels to do a mailing. 
 
When the database is set up, you should define a separate field or subfield for each line of the 
address, or else use repeats of a field for each line (or use a combination). For example, 
UNESCO’s database of CDS/ISIS licence holders uses the following fields: 
 1 Name 
  ^a  Surname 
  ^b  Forenames 
  ^c  Title 
 10 Position 
 2 Organization 
 3 Address 
 4 City 



The CDS/ISIS for Windows Handbook 105

If any of the elements consists of more than one line, repeats are used, e.g. 
 
 1 ^aMartin^bGillian^cMrs 
 10 Lecturer in Information Science 
2 School of Library Archive and Information Studies%University College London 
3 Gower Street 
4 LONDON  WC1E 6BT 
 
A format for printing out from this database could be: 
 
 fs20, mhl,m(-500,500) (v1^c| |,v1^b| |,mhu,v1^a+|; |, 
 mhl)/v10/(v2/)/(v3/)/mhu(v4/) 
 
This format allows for any field except ‘position’ to be repeated. The margin command is 
explained below. The person’s surname and the city are printed in upper-case letters. The 
format is called USELB. 
 
Printing labels is basically a matter of using the various print parameters to make the records 
fit the labels. It is easy to waste many sheets of labels in trying to get this right (the authors 
write from long experience) so a few tips may be helpful. 
 
1. Try out your print specification on plain paper first to avoid wasting labels. If you are not 
sure which way up the labels need to be inserted into the printer, write TOP in pencil on the 
paper before printing.  
 
2. In the General dialog box, set the range of record numbers you need. (Try a few records 
first.) 
 
3. Note the margin command m(-500,500) above which can be used to indent 
continuation lines for clarity. The margin is set to 500 twips, but this is reduced to 0 in the 
first line of each ‘paragraph’. 
 
4. You will probably need quite a small point size to fit a long address onto a label: fs20 
will produce 10-point type. 
 
5. In the Presentation dialog box, specify no titles, headers, footers, etc. 
 
6. In the Margins dialog box you need to choose values for the margins that suit the sheet of 
labels that you are using. Remember that these mean the margins measured from the edges of 
the complete sheet – not each label. Similarly the paper size means the size of the complete 
sheet. 
 
7. Set the EOC tolerance to the number of lines that fit on one label. It is very important that 
a new record is not started at the bottom of one column and continued at the top of the next, 
or all subsequent records will be printed across the label divide. 
 
8. Check the box for Record height is fixed and set this to the distance from the top of one 
label to the top of the next. (This will be slightly greater than the height of the label because 
of the gap between labels.)  This record height may not be an exact number of printed lines, 
so it may not be used exactly, but you should be able to get close enough. 
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9. Next, in the Columns window, set the number of labels across the page and a suitable 
space between the columns (probably fairly small). Select No decorations. 
 
10. Set the Max records per page/column to the number of records down the sheet. This is a 
further precaution against parts of records spilling over into the next column. 
 
You can now try printing a page of records onto paper (e.g. MFN range 1/16) and 
comparing it with your sheet of labels. Good luck! 
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9   EXPORTING, IMPORTING AND BACKING UP DATABASES 
 
9.1  ISO 2709 STRUCTURE 
 
The export function of CDS/ISIS allows you to copy some or all of the records in a database 
on to a floppy disk or to a file that can be attached to an email message so that you can pass 
them to another user. The import facility allows you to bring data from elsewhere into your 
own database. 
 
During exporting or importing you can use a Field Selection Table (a) to limit the parts of the 
record you allow to be transferred or (b) to move data from one field to another on transfer. 
So another use of these functions is to reformat the database by exporting and then re-
importing the same records. 
 
The record structure which is used for exporting and importing is known as ISO 2709 
because it follows the International Organization for Standardization's standard 2709. This is 
used by some other bibliographic software, such as ISIS, MINISIS, and any software that 
allows the import or export of MARC records. Unfortunately, it is not used by all 
bibliographic software.  
 
In the DOS version and early Windows versions, CDS/ISIS produced a record which deviated slightly from the 
standard: after each 80 characters, and at the end of each record, the program inserted a carriage return. 
However, in Version 1.4 you can alter the line length and if you set it to 0 no carriage return will be inserted 
within or between records. If you are sending a file by email, you should use the default 80. 
  
The ISO 2709 standard also prescribes certain characters to be used for the end-of-record marker and the end-of-
field marker. These characters are called control characters because they are intended to control printed output 
rather than be printed out in the same way as other characters like 5 or K. The Windows version of CDS/ISIS 
uses the standard control characters by default, whereas the DOS version did not (see Section 9.2 below). 
 
The default for the first character of the subfield identifier is ^, whereas in the ISO standard the ASCII character 
with the value 31 is used. You can set it to this value by entering \031 in the Export form. 
 
If you try to import an ISO file and it does not work properly, it may be because of  slight differences in the 
characters used for these purposes. Have a look at the file in a text editor (or a hex editor to examine control 
characters) and you should be able to see what format and codes have been used. 
 
A program called Fangorn is available which can convert data from many online databases 
and other sources into ISO 2709 format, so that they can be imported into CDS/ISIS. This is 
described in Section 9.4. There are also programs available for conversion from comma 
delimited files and dBase files: your distributor should be able to give you details. 
 
If you wish to export to other systems which cannot accept ISO 2709 format, find out what 
their preferred batch entry format looks like. Provided that it is an ASCII file (i.e. uses the 
ASCII codes to represent the characters in the data and not some coding of its own) you 
should be able to write a print format that produces the required format. You can then use 
Sorting and Printing Services to output the file. 
 
A file of two records in ISO 2709 format is shown in Figure 9.1. 
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00433000000000121000450004400780000005000120007806900790009002400690016902600230023
8030002100261070001600282070001300298~Methodology of plant eco-physiology: 
proceedings of the Montpellier Symposium~Incl. bibl.~Paper on: <plant 
physiology><plant transpiration><measurement and instruments>~Techniques for the 
measurement of transpiration of individual plants~^aParis^bUnesco^c~1965~^ap. 211-
224^billus.~Magalhaes, A.C.~Franco, 
C.M.~#00376000000000109000450004400780000005000120007806900370009002401000012702600
0700227030002100234070001100255~Methodology of plant eco-physiology: proceedings of 
the Montpellier Symposium~Incl. bibl.~Paper on: <plant evapotranspiration>~<The> 
Controlled climate in the plant chamber and its influence upon assimilation and 
transpiration~^c1965~^ap. 225-232^billus.~Bosian, G.~# 

 
Figure 9.1  A file in ISO 2709 format 
[Here ~ has been used as field separator and # as record separator.] 
 
 
9.2  EXPORTING IN ISO 2709 FORMAT 
 
It is possible to export records on to a hard disk, a floppy disk or via a network. You may 
pass data to another organization using a floppy disk or by attaching the file to an e-mail 
message. If you want the file on a floppy disk, it may be easier to export to the hard disk and 
then copy the file using My Computer or Windows Explorer (see Section 2.9.4). 
 
Open the database from which you are going to export. (Use the Open  File icon, or choose 
Database ⇒ Open, then the database you want to use.)  To export only part of the database, 
first ensure that you know the range of Master File Numbers (MFNs) or else carry out a 
search for the required records. 
 
The exporting function is reached by choosing Database ⇒ Export. A dialog box will open 
asking you for the name to be given to the ISO file. You can choose whether it should go on 
to the hard disk, a floppy disk (which must be in the disk drive), or a network drive. It is 
customary to give the ISO file a name with the extension .iso, e.g. mar01.iso. If you are 
exporting similar data regularly, it is a good idea to identify the file like this. Then click the 
OK button. 
 
A dialog box will appear as in Figure 9.2. It  may look somewhat daunting but in fact you can 
accept most (if not all) of the default values offered. The meaning of the various choices is 
explained below. 
 
1  Name of output ISO file. This will be the filename you have just chosen, but you can alter it 
here. 
 
2  Field separator. If this is left blank, the program will use the ISO 2709 standard field 
separator, which is the ASCII character 30. In DOS applications this appears on the screen as 
Δ, but in Windows it may appear as a hyphen or not at all. In the DOS version of CDS/ISIS, 
the default field separator was the hash sign, #, and most users left it as this. So, if your 
export file is going to a user of DOS CDS/ISIS you had better warn him or her, or else 
change the separator to #. 
 
3  Record separator. If this is left blank, the program will use the ISO 2709 standard field 
separator, which is the ASCII character 29. In DOS applications this appears on the screen as 
⇔, but in Windows it may appear as a square or not at all. In the DOS version of CDS/ISIS, 
the default record separator was the same as the default field separator, i.e. the hash sign, and  
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most users left it as this. This could lead to the import program looping if there were errors in 
the data and it is better to use different symbols. Inform a user of CDS/ISIS for DOS who is 
going to import your records what you have used. 
 
 

 
 
Figure 9.2  Export dialog box 
 
4  Export Range of MFNs / Search results/From sorted HIT file. You can limit the records 
exported either by giving a range of MFN numbers or by means of a previous search. You 
cannot limit by both (as you could in the DOS version) but you can limit to marked records 
only. Exporting from a sorted hit file is used to sort the records in a database into a new order 
and is discussed in Section 9.6. 
 
Click the option you want. If you choose Search results, only the records retrieved in the last 
search you did will be exported. 
 
5  Range: from MFN ... to MFN ... If you want to limit by MFN, specify the limits here, e.g. 
 
 From MFN   1  to MFN    50 
 
6  Reformatting FST. If you do not want to reformat the records for exporting, leave this 
blank. If you do want to reformat the records, please refer to Section 10.7. 
 
7  Renumber records from MFN. You can make the MFNs of the exported records start from 
a different value from what they start from in your database. It will only apply if you are 
actually exporting the MFNs as described in the next option. You can generally leave this 
blank. 
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8  Output Tag containing MFN. The number of the record in your database, i.e. the Master 
File Number (MFN), is not held in one of the tagged fields and so is not normally included in 
the ISO 2709 record. If you want to include it (e.g. because the recipient is maintaining a 
database in step with yours) you will need to transfer the MFN into one of the tagged fields. 
You can choose any field number which is not already in use, e.g. 99, and the program will 
copy the MFNs into that field in the exported records.  
 
9  Gizmo conversion file. This has to do with the different ways that micro CDS/ISIS and 
mainframe CDS/ISIS handle diacritical marks and is outside the scope of this book. Leave it 
blank. 
 
When you have completed the dialog box, click the OK button. The computer should then 
start to export records. If you are exporting to a floppy disk, make sure there is still space 
after exporting. Unlike in the DOS version, if there is not enough space the export appears to 
work but there will be data missing. You are not prompted to insert another disk. 
 
 
9.3  IMPORTING AN ISO 2709 FILE 
 
This section covers transferring records from a file in ISO 2709 format into a CDS/ISIS 
database. The records may be on a floppy disk or a network drive, or in a file received by e-
mail. If there is more than one floppy disk, the records from each disk must be imported as a 
separate job: you are not prompted to insert another disk as in the DOS version of CDS/ISIS. 
 
The database definition must have been set up before importing records, though the database 
can either be empty or already have records in it. 
 
The database receiving the data does not need to include all the fields that are present in the ISO 2709 records. 
The fields will be imported even if they are not in the database definition. 
 
The Windows version of CDS/ISIS can accept hash marks, #, or ASCII characters 30 and 29 respectively or 
other characters as field separators and record separators. If you want to check what has been used in the ISO 
2709 file, display it in a text editor (or hex editor to examine control codes). 
 
First open the database into which you want to import. Then choose Database ⇒ Import. 
You are asked for the name of the ISO file to import from - choose the correct disk, folder 
and filename. Note that only filenames with the extension .iso are displayed unless you 
change List files of type... to *.*. Click the OK button. 
 
A dialog box will appear as in Figure 9.3.  Most of the choices are similar to those in the 
export dialog box. 
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Figure 9.3  Import dialog box 
 
 
1  Name of input ISO file. This will be the name of the file you wish to import. 
 
2  First MFN to be assigned. You can normally leave this as the default value, 1. If you make 
it greater than the number of records already in your database, the incoming records will be 
given MFNs starting from the value specified. 
 
3  Tag containing MFN. You can take the MFN from a numeric field present in the ISO 2709 
record being imported (see Section 10.7). This will override anything you have answered at 
choice 2. The MFN will be removed from the field specified when the record has been 
imported. 
 
4  Reformatting FST. If you do not want to reformat the records during importing, leave this 
blank. 
 
You can use a Field Selection Table during importing to reformat the records, e.g. to select 
only certain fields or subfields, or to change some of the field tags. You should enter the 
name of the FST here and set up the FST from Edit ⇒ Field Selection Tables. The form of 
the FST entries is: 
 
 100  0  (v1/) 
 
This means that field 1 in the incoming records will be converted to field 100 in the database. 
(v1/) is a repeatable group (see Section 5.5) consisting of an occurrence of field 1 and a 
new line. It makes sure that each occurrence of field 1 will go into a separate occurrence of 
field 100; otherwise all the occurrences of field 1 would get run together. 
 
If a database field is not included in the FST it will not be imported. If no FST is named, all 
fields will be imported whether or not they are in the FDT of the receiving database. 
 
5  Gizmo conversion file. As in exporting, this has to do with the different ways that micro 
CDS/ISIS and mainframe CDS/ISIS handle diacritical marks and is outside the scope of this 
book. Leave it blank. 
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6  Input line length. This is the number of characters per line in the ISO file. It needs to be set 
correctly or the Import program can get into a loop and eventually crash CDS/ISIS. The DOS 
version of CDS/ISIS always used 80-character lines and 80 is the default in the Windows 
version. However, if you are importing from another package which adheres more strictly to 
ISO2709, there may not be any line breaks and you should set this value to 0. 
 
If you are not sure what value to use, examine the ISO file in a text editor and check the line 
length. 
 
7  Subfield separator. Normally this is the circumflex ^ in CDS/ISIS, but if you are importing 
data from another package it may be ASCII character 31 or another value. Again you could 
check in an editor. 
 
8  Options: Load/Merge/Update. Be careful what you choose here as you could lose an 
existing database!  The choices are: 
 

Merge. This means that the imported records will be added to any existing ones. If the 
imported records have MFNs and these clash with existing MFNs they will not be 
imported. 

 
Load. This means that any existing records are lost and you end up with only the 
imported records. Fortunately you are asked to confirm this drastic action: 
 Database will be overwritten!   OK  /  Cancel 
 
Update. This works like Merge, except that if an incoming record has the same MFN 
as an existing one it will overwrite the existing record, i.e. update it. 

 
When you have completed the dialog box, click the OK button. The record(s) should then be 
imported: the program displays the MFNs as it runs. 
 
 

9.4  IMPORTING FROM OTHER SOURCES 
 
There are only two methods of adding records to a CDS/ISIS database: the usual method is to 
enter data at the keyboard; the second is by importing a file formatted according to ISO 2709 
as described in the section above. If you want to import any other kind of file you will have to 
convert it to this format. 
A package has been contributed by Hugo Besemer (of PUDOC-DLO, Wageningen) and Paul 
Nieuwenhuysen (of the Free University of Brussels) called Fangorn which is very useful for 
this purpose. It comes with a file named english.doc containing a document : 
 
How to use Fangorn - a microcomputer program for the conversion of databases to ISO-
2709 format. 
 
To view or print this document, you may use the Write program and open the file 
english.man. Write will convert the format from text to Write format for you. 
 
Fangorn was written primarily to convert data downloaded from online information systems 
such as Dialog or BLAISE so they can be added into a CDS/ISIS database. The program is 
circulated by UNESCO to distributors, who often include it on a disk with other conversion 
programs.  
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It is necessary for the data to be in the form of an ASCII file, with each field clearly labelled 
and the data starting in the same column, e.g. 
 
001  0853658994# 
100  Gredley^hEllen# 
245  ^aExchanging bibliographic data# 
260  ^aLondon^cLAPL^d1990# 
 
A table is then set up to specify how fields in the ASCII file should be converted to fields in 
the ISO 2709 file. You can use a text editor to fill in the table, or a word processor provided 
you save the completed file as an ASCII file or DOS text (see Section 2.9.8). Part of a 
sample table for converting a MARC record laid out as above for entry into a CDS/ISIS 
database, retaining the same tags, is shown in Figure 9.4 below. 
 
The example is limited for reasons of space to four fields. There are in fact a lot more in the 
UK MARC format. The tags are to be the same in ISO file as in the incoming file.  
 
To use Fangorn for a new conversion you need to run it once to create the blank form. Exit 
from Fangorn and fill in the form using a text editor. Save it, then run Fangorn again with this 
specification file to generate the ISO file. 
 
A Windows-based program, IsisAscii, is under development at the time of writing. It is based 
on ISIS_DLL and is documented in IsisAscii Version 0.9 (Paris: UNESCO, July 2001).  
Unlike Fangorn, it writes directly into a CDS/ISIS database – either appending to an existing 
one or creating a new one. 
______________________________________________________________________ 
                        SPECIFICATION FILE 
 
Which conversion is specified :UK MARC to CDS/ISIS 
Number of fields   :4 
Text indicating start/end of record : 
Tag indicating start/end of record :001  
Line indicating start/end of record : 
Two texts indicating start/end of rec. : 
 
Tag in incoming file   :001 
Tag in ISO-2709 file   :001 
(The following is not mandatory) 
Spaces in continuation lines  : 
Subfield delimiter in incoming file : 
Subfield delimiter ISO-2709 file : 
Delimiter occurrences incoming file : 
Texts to replace   : 
 
Tag in incoming file   :100 
Tag in ISO-2709 file   :100 
(The following is not mandatory) 
Spaces in continuation lines  : 
Subfield delimiter in incoming file : 
Subfield delimiter ISO-2709 file : 
Delimiter occurrences incoming file : 
Texts to replace   : 
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Tag in incoming file   :245 
Tag in ISO-2709 file   :245 
(The following is not mandatory) 
Spaces in continuation lines  : 
Subfield delimiter in incoming file : 
Subfield delimiter ISO-2709 file : 
Delimiter occurrences incoming file : 
Texts to replace   : 
 
Tag in incoming file   :260  
Tag in ISO-2709 file   :260 
(The following is not mandatory) 
Spaces in continuation lines  : 
Subfield delimiter in incoming file    : 
Subfield delimiter ISO-2709 file       : 
Delimiter occurrences incoming file : 
Texts to replace   : 
 
Figure 9.4  Fangorn Specification file 
 
 
9.5   EXPORTING TO OTHER DATABASE PACKAGES 
 
The only format used by the  CDS/ISIS export function is ISO 2709. Whilst this is 
recognized by all good library packages it is not recognized by most microcomputer database 
packages. To produce other output formats from CDS/ISIS you need to use the Print function 
and print to a file or else use a utility program. This section offers some guidance on writing 
the necessary print formats. 
 
Many database programs can read a comma-delimited variables (or CSV) file. There is a 
utility program dlmexp.pcd which exports to this format. The distributor may have included 
it with the DOS version of CDS/ISIS and it can only be used with that version. First you need 
to write a Field Selection Table which selects the data to be exported, e.g. 
 

1   0 v1 
10  0 v10 
20  0 v20 
 

This will export fields 1, 10 and 20 with any repeated occurrences run together. Then you 
need to go into Advanced Programming Services and run the program dlmexp. You are 
prompted: 
 
 Export FST name? 
 Output file name? 
 Export last search results (Y/N)? 
 MFN limits? 
 
The Export FST name is the one you wrote above. (You cannot leave this answer blank.)  
The other questions should be fairly clear. The reords are then exported to the output file you 
specified. You leave the program by pressing Enter. 
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If you do not have the DOS version and the program dlmexp.pcd don’t worry. It is quite easy 
to write a format to produce a CSV file. If the fields in yout database are 10, 20 and 30 and 
they do not have repeats, you can use the following format: 
 
 '"',v10,'","',v20,'","',v30,'"'  
 
The literals are written in single quotes to make sure that they are always printed out, even if 
the field is absent. Otherwise data would end up in the wrong fields. After writing this 
format, testing it on the screen, and saving it you can use Database ⇒  Print, select Output 
to ASCII file (Windows-ANSI) and the format you have written. You should then be able to 
print some or all of the records in the database to an ASCII file in CSV format. 
 
To print to the format used by DB/Textworks (formerly Inmagic) you can use a similar 
format: 
 
 "AU ",v10/"TI ",v20/"PU ",v30/'$'/ 
 
Because the fields all have their own labels in DB/Textworks, you can use conditional literals 
(in double quotes) so that the label is printed only if that field occurs in the record. 
 
One of the most common problems faced when converting data from CDS/ISIS to another 
package is how to handle repeating fields. We will use the following as an example: 
 

Tag Data 
 
100  Ferguson, Peter 
100 Zussman, Tracy 
100  Doe, Janet 
 

Probably the only common package with repeating fields is DB/Textworks   This reads a 
format with each occurrence on a separate line, a label in front of the first occurrence and a 
semicolon in front of other occurrences, e.g. 
 

AU Ferguson, Peter 
; Zussman, Tracy 
; Doe, Janet 

 
This can be produced by the format  
 
"AU " (|; |+v100/) 
 
 Otherwise you have three possible choices: 
 
(a) Convert the repeats to a single field 
You could put all the occurrences in a single field with some sort of punctuation to separate 
them, e.g. 
 Author: Ferguson, Peter; Zussman, Tracy; Doe, Janet 
 
This could be produced by the format 
 
V100 +|; | 
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However, this may cause problems with searching and sorting, since the discrete terms are 
now merged into one. 
 
(b) Convert the repeats into different fields 
You could have several fields in the new database corresponding to the one CDS/ISIS 
repeating field, e.g. 
 Author1: Ferguson, Peter 
 Author2: Zussman, Tracy 
 Author3: Doe, Janet 
 
The first problem here is to know how many fields to provide, since there could be any 
number of fields in CDS/ISIS. This causes difficulties in writing the CDS/ISIS output format: 
if you are using a comma-delimited variable format you need to have the same number of 
fields in every record whether empty or filled. Then there may be problems in searching in 
the new database since you will not know which field to search for a particular name (e.g. 
Doe, Janet). 
 
(c) Set up two tables with a relationship 
This is the real answer to handling fields with several values in a relational database 
management system (DBMS). You need one table with the bibliographical data and another 
one with author names. These are in a many-to-many relationship (one book may have 
several authors and one author may have written several books) so you need a link table too: 
 
Books      Link table Authors 
 
Number: 125    125  9  Number: 9 
Title:  The World Wide Web  125 17  Name: Ferguson, Peter 

and Libraries   125  56  
        Number: 17 

Name:  Zussman, Tracy 
 
Number:  56 
Name: Doe, Janet 

 
Creating this kind of structure from a CDS/ISIS database is not very easy and depends on a 
good degree of skill in using the package you are migrating to (which you may not have if 
you are just starting to use it!)  One approach is to start by exporting to a “flat file” with 
separate fields as above. 

 
 
9.6  SORTING A DATABASE 
 
The order of records in a database is normally the order in which they were entered or 
imported. When you are inputting records in Data Entry, you have no control over the MFNs 
assigned by the system. 
 
However, there may be occasions when you want the records in the database to be sorted into 
a particular order. (This should not be confused with producing a printout or print file in a 
particular order, which is dealt with in Section 8.8.)  A common case is when you want to 
print a listing in a sorted order with each record having a running number and then to produce 
an index to this listing. An example is shown in figure 9.5. 
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DIRECTORY OF CONSULTANTS 
 
 1. 
 AARONOVITCH, Samuel 
 Queen Mary College, University of London 
 Subjects:  economics, commerce 
 
 2. 
 AHMED, Sharif Uddin 
 Coopers and Lybrand, London 
 Subjects:  accountancy, commerce 
 
 3. 
 ALLEN, Christopher 
 United Hospitals, Bath 
 Subjects:  surgery, physiology 
 
 4. 
 AMOS, Donald Bruce 
 Ministry of Indian and Northern Affairs, Ottawa 
 Subjects: politics, race relations 
 
  
 [etc.] 
 
 
 SUBJECT INDEX 
 
 accountancy  2 
 commerce  1,2 
 economics  1 
 physiology  3 
 politics  4 
 race relations  4 
 surgery  3 
 
 
Figure 9.5 Sample listing of directory and index 
 
If the original database was in alphabetical order of surname, it would be quite easy to 
produce these listings and the MFN could be used as the reference number. However, if the 
database was produced by adding names as information was received, its order may not be 
alphabetical and the MFNs would not correspond to the numbers wanted for the sorted 
listing. 
 
We can achieve this by proceeding as follows: 
 
1. Go into Print Setup and open the Sorting page. If the name is stored in field 10, the 
required Field Selection Table for sorting will be something like: 
 
 1 0 v10 
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On the Layout page, check the box for Just make HIT file. On the General page there is no 
need to touch the Print Format or Output To, but make sure that the radio button for MFN 
range is selected and a range specified which is big enough to include the whole database, 
e.g. 1/99999. Now click Print. The HIT file produced has the same name as the database 
with the extension .hit. Close Print Setup. 
 
2. Choose Database ⇒ Export and enter a name for the export file (e.g. sorted.iso). Select 
the radio button From sorted HIT file. Click OK. The records will then be exported in the 
sorted order. 
 
3. Either define a new database with the same fields as the original database or make a back-
up copy. 
 
4. Import the exported records into this new database (or the existing one using Load which 
deletes all existing records). The Master File Numbers in this new database will be the 
reference numbers you want for the sorted listing. 
 
5. You can now use Print Setup to produce the two printouts required: the first will require 
no further sorting and the second will be sorted on 'subject'. 
 
An example is shown in the Reference manual for the DOS version in the section on 'Sample 
print runs' in 'Sorting and Printing Services'. 
 
 
9.7  BACKING UP AND RESTORING A DATABASE 
 
In case of accidents, either your own or the computer's, you should take regular backups of 
your database(s). How often you need to do this depends on the rate at which you are making 
additions or alterations to the database: remember that you could lose all your work since the 
last backup. 
 
Before you make a backup, make sure that the inverted file is in step with the data: choose 
Database ⇒ I/F Update if necessary. 
 
While the database is small enough to fit on to one floppy disk, the simplest way to back it up 
is to copy all the database files using My Computer or Windows Explorer. This is covered in 
Section 2.9.4. The worksheet and print format files will only need to be copied once - 
provided you keep the disk safely!  Subsequently you can just copy files with the name book 
(or whatever your database is called). Note that is not sufficient just to copy book.mst. The 
database cannot easily be reconstructed from the MST file without the XRF file. You would 
only need to copy the worksheets and print formats if you have created any new ones or 
altered existing ones. 
 
When the database gets too big to go on to one floppy disk, you will have to use the Windows 
Backup facility or a file compression program. PKZIP (for DOS) and Winzip (for Windows) 
can split a file over multiple floppy disks. 
 
When disaster strikes, you will need to restore your data from the most recent backup. You 
can use My Computer or Windows Explorer. If only the inverted file has been damaged (i.e. 
the records appear correct when you browse them but there are errors in the Dictionary 
Display or searching) you do not need to restore the index files: just run a full inverted file 
generation from Database on the main menu (Section 1.4) 
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10 MODIFYING A DATABASE 
 
10.1  INTRODUCTION 
 
After you have been using your database for some time, you will probably wish to make 
some modifications to the original definition. For example, there may be fields in the 
definition that you have never used, or you might realize that you missed out some data 
elements. You might want to be able to search on elements which have not been indexed or 
you might find that elements are not being indexed in the way you had intended. You may 
want an additional worksheet for a particular task. You might want to alter the print format, 
or you might want several print formats for different purposes. 
 
Alternatively, you might want to alter the data in existing records. Perhaps you decide that 
'added entry' authors should go into the same field as 'main entry' authors, or you want to 
change all occurrences of 'Leningrad' to 'St Petersburg'. 
 
Most of these modifications can be made quite easily, but there may be implications which 
are not immediately obvious. This chapter explains how to make such changes and what else 
you need to consider. 
 
 
10.2  MODIFYING THE FIELD DEFINITION TABLE 
 
The most common type of modification is to add extra fields to the database. This entails 
adding to the Field Definition Table (FDT). To do this choose Edit ⇒ Field Definition 
Table from the main menu bar. This opens up the Data Base Definition - Field Table 
window. The cursor is in the Tag box. To add a field, type in the number. Press {Tab} to 
move to the Name and type in the name of the field. It is best to leave fields as 
Alphanumeric.. Click on the check box if the field is to be repeatable. Enter the subfield 
identifiers of any subfields you have decided to use. Then press {Enter} or click on Add. 
Click on OK when you have finished. 
 
In CDS/ISIS for DOS, it does not matter if the repeatability or subfields are not correctly 
entered. CDS/ISIS for Windows validates subfields and will not allow a non-repeating 
subfield to be entered more than once. So you must ensure that the table is correct. If a 
database was set up under the DOS version, more often than not you will need to change a 
field that is already present. 
 
Click on the line of the table to edit and it will fill the boxes at the top of the dialog box. 
Make any changes. Do not forget to press {Enter} or choose the Add button or the changes 
will not be made. Do not press OK until you have chosen Add or the changes will not take 
effect. 
 
If you add a new field, you will also need to add it to a worksheet, a print format, and 
possibly to the Field Select Table. If you delete a field from the FDT, the field will not 
disappear in existing records but you will not be able to enter any more data into this field. 
You may therefore want to remove it from the worksheet(s). If you have already entered data 
in this field in existing records, you can change the print format(s) to stop them displaying. 
For a quick way to delete the data, please see Section 10.6.2. 
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10.3  MODIFYING THE WORKSHEET OR CREATING A NEW ONE 
 
If you have added a field in the Field Definition Table, you must add it to a worksheet. Select 
Edit ⇒ Data entry Worksheets and the default worksheet will be displayed. You should see 
any extra field you have added displayed in the Fields window. Double Click on the new 
field and that field will be added to the data entry fields box and hence to the worksheet. The 
field will be highlighted: if you want to add a Default value, Help message, Validation or 
Pick-list definition, double click on the field under the Data Entry Fields heading. A 
worksheet will open enabling you to fill in this information. You can even change the name 
of the field as displayed in this worksheet. This could be useful in a multi-lingual 
environment. 
 
It may be useful to have more than one worksheet for a database. For example, you might 
want one for books, one for serials and one for conference proceedings in a bibliographical 
database. Or you may want an identical worksheet in a multilingual environment so that each 
cataloguer can have the choice of his or her own language. To create a new worksheet select 
Edit ⇒ Data entry Worksheets and the default worksheet will be displayed. Select New and 
enter the name of the new worksheet. Double click on the fields you wish to be entered in the 
worksheet. See Section 4.4 to remind yourself about how to create a data entry worksheet. 
 
10.4  MODIFYING THE FIELD SELECTION TABLE 
 
As computers get faster and are fitted with larger hard disks, it may be advantageous to 
include more fields because increasing the size of the index will no longer lead to a space 
problem. Again, you may wish to add a title index indexing the first 30 characters of the title 
rather than relying only on title words. 
 
Select Edit ⇒ Field Selection Tables and the table will be displayed. To add a title index to 
the database CDS, select New, select 74 Added title, leave the indexing technique as 0, and 
make the format v24. Click Add. Click OK to save it.  

What users often fail to realize is that changing the FST changes the rules for the indexing (or 
inversion) of records subsequently added to the database, but it does not alter the entries for 
records which have been inverted already. When you say YES to Update inverted file?, 
CDS/ISIS only considers records which have been added or modified since the last update: it 
does not consider updates needed for old records. Therefore, for the new FST to take effect 
on existing records, you will have to choose from the main menu bar Database ⇒ I/F 
Update and click the Full Inverted File Generation radio button and OK. If the database is 
large, this will take some time. You will see that the complete titles up to the first 30 
characters (normal maximum length of an index term in CDS/ISIS) have been indexed. 
 
 
10.5  MODIFYING OR ADDING PRINT FORMATS 
 
This is one of the most common modifications required. Usually you will start off with a 
default print format produced by the print wizard and then modify it to take out any fields not 
for public view. Or you may produce another one for public view. In any case, it is likely that 
you will want different print formats for different purposes. 
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To set up a new print format, chose from the main menu Edit ⇒ Print Formats. Select New. 
If you are modifying the current format then click on the check box Don't clear current 
format and the current format. Give the format a new PFT name and click OK. You will 
then be able to amend the format and produce a variation on the earlier one. If you want to 
make a completely new format, you must not tick Don't clear current format and the 
message appears Do you want Winisis to launch the Print Format Assistant? If you say 
Yes to this, a window headed Database Definition - PFT Wizard appears with five choices 
of format. This gives you a chance to have different displays. If you want to produce a 
bibliography to mount on the web, you should choose one of the two HTML formats, Normal 
and Table with Headers. Neither of these looks good on the screen, but are intended to 
produce a file which can be viewed in a browser. See how to publish your data on the web in 
Section 13.6.  
 
Whichever print format you have produced you may want to edit it. You may wish to create 
one from start and wish to change it later. There are two ways in which you can modify a 
print format. Either you can click on Edit ⇒ Print formats or you can edit it while browsing 
or searching a database. The latter is usually preferable for two reasons: (a) because you are 
likely to have spotted the need for a modification while browsing or searching, and (b) 
because it allows you to make a temporary change, try it out immediately, and save it when 
you are happy with the result. 
 
If you want to change the print format while browsing, click on the icon depicting a pencil on 
paper. (For reasons of security, this is only available if editing is available, not in the short 
menus.) This icon is third from the right. A window containing the format language will 
appear. You can extend the size of this by placing the cursor over the line below the window 
and dragging the bottom of the window down by holding down the left mouse button. You 
can edit the format. If you click on the yellow lightning symbol, any changes you make are 
implemented, but not yet saved for good. If there are any errors as a result of changes you 
have made, you will see in the middle of the record display window an error message such as: 

 ***** Format syntax error 99 near:  
If you wish to return to the format as it was before you began to make any changes, click on 
the Format window, choose *ALL*, click again on Format, choose the name of the format 
you were changing. You can start the editing procedure again. 
 
When you are happy with the new format, click on the floppy disc icon to save it. Don't do 
this if you are getting any error messages. A Save file window will appear and you should 
ensure that you save the format file in the same folder as the one you edited is stored. You 
will see the name of the format come up as a file in the scroll box below the File Name. Then 
you may save it. If you do not save it in the correct folder, you may not see again the changes 
you thought you had made! Make sure you save it in the folder where you can see the file 
name.  
 
If you alter a print format from the Edit menu, note that the changes will not take effect 
immediately: you need to reselect the format when in browse or search mode. The easiest 
way to do this is to click on the list of formats in the Format box, select *ALL*, click on the 
list again and select again the format you have changed. 
 
 
10.6  MODIFYING THE DATA 
 
We dealt with modifying data in the normal way in data entry in Section 6.1. 
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CDS/ISIS for Windows has three very powerful utilities for making global changes to the 
database. That means making the same change across sets of records. 
 
There are three separate functions: Global add, Global delete and Global replace. 
 
Be very careful when using these functions. YOU SHOULD BACK UP THE DATABASE 
FIRST IN CASE YOU DAMAGE IT. If you make any mistakes when you do a global edit 
you will almost certainly not be able to get back to the database as it was before, unless you 
have backed it up and can restore the database from the back-up files. 
 
Each function can operate on a set of records within a range (e.g. 300-350) or on a set 
selected by a search. 
 
Global add adds a field to every record selected. . 
 
Global delete removes a complete field from every record 
 
Global replace replaces selected text in a field with text required. 
 
Note that these functions cannot be opened while the Data Entry Worksheet is open. You will 
find that they do not open but no error message is displayed. 
 
10.6.1 GLOBAL ADD (RANGE)  
 
With the database open, select Utils ⇒ Global Add (Range). 
 
Enter the range of MFNs, e.g. 1/50. If you enter nothing it will add the field to every record. 
 
Select the field tag using the spin box. 
 
Add the text to be entered in this field. 
 
Note that a new field will be created, for each field added. This will be created even if the 
field is already present and the field is not repeatable. The field will be created even if it is 
not in the FDT. 
 
You may want the field to be created only if it is not already present. Click on Add if not 
present. 
 
How could you use this? You could add in an author field the text 'Anon.' to every record 
which does not have an author field. Let's do it in the first 50 records only. 
 
Here (Figure 10.1) is the screen displayed ready to run. 
 
When you click on OK, a Progress window comes up, very useful in a very large database, 
and you will see on the window the MFN of the record being processed. 
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Figure 10.1 Global Add (Range) window 
 
 
Click on the completed button when it appears and then check some records to ensure it has 
worked correctly. You could try Global delete (Search) (see 10.6.5) to remove the authors 
containing 'Anon.'! 
 
10.6.2 GLOBAL DELETE (RANGE) 
 
With the database open, select Utils ⇒ Global Delete (Range). 
 
Enter the range of MFNs, e.g. 350/355 
 
CAUTION!! If you enter nothing in range, Global Edit will remove all instances through the 
entire database of the field you select in the next step. 
 
Select the field tag using the spin box. 
 
Press OK. 
 
The field will be deleted from every record selected. Note that if you wish to delete only 
certain words in a field, use Global replace (below). 
 
10.6.3 GLOBAL REPLACE 
 
Global replace allows you to search for a particular string of characters and replace them by 
another string. You can limit this to particular fields, subfields or occurrences of a field. You 
can get it to select text for change taking into account case or ignoring it. You can tell it to 
select whole words only. You can get it to prompt you before it makes any particular 
replacement. This is a highly sophisticated program, but beware, it could damage your 
database if you make any errors. You may click on the Cancel button if you have made a  
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mistake, but you will not have prevented any changes earlier in the set of records you have 
specified for the replacements to be made. 
 
You may enter the range of records on which you wish to make the global edit. Click on the 
button and enter the range as e.g. 55/90. If you leave the MFN limits button set and do not 
enter a range the global edit will not be performed; it will go through all the stages but 
nothing will be changed and no error message will appear. 
 
If you have not made any searches in that database since opening it, Search set and Marked 
Records will be greyed out. Otherwise you can select a search set for the global edit to be 
done on instead of using a range. 
 
The Marked records selection which can be used if you have just separately marked records 
in the last search you made is not reliable. 
 
You must enter the text you wish to replace in the Text to find box. If you enter nothing you 
will get a message 'No text to search for'. Enter the text you wish to replace it with in the next 
box. If you enter nothing there, you will get the message 
 

You are DELETING some text! 
NO NEW TEXT HAS BEEN SPECIFIED! Are you sure? 

 
If you click on the Yes button, the text will be deleted and replaced by nothing. If you click 
No the Replace Text Window will appear again with all values empty so you have to start 
again. If you click on Cancel, the Global Replace utility closes. 
 
If you click the case sensitive button the replacement will check the case of the original and if 
different from that entered in Text to find it will not change it. If you click on Whole words 
only it will select character strings only found between two spaces or the beginning or end of 
the field. It does not change anything immediately preceded by a subfield identifier. Thus, 
the will be changed if it is a complete word but not if it is another word like 'there'. 
Warning!!! It will not change if it is at the start of a subfield. 
 
Prompt on replace does not work in Windows 3.11 in version 1.4 build 19. 
 
In the Tags box you can specify replacement in one or more fields. Enter each field separated 
by commas. If you want it to replace the text only in certain subfields, you can specify as 
many subfields as you like: e.g. afgh but it will change the text in any of the subfields 
specified in any of the fields selected. You cannot specify to make a change in subfield a of 
field 26 and subfield b in field 30. To do this you should run Global Replace separately for 
each. 
 
You can convert punctuation to a subfield identifier. Here is an example. You may have an 
author in field 70 and you may wish to replace comma space by ^b in the first 100 records in 
your database. Let's do it only in second occurrences of the field. See Figure 10.2 for the 
settings. 
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Figure 10.2 Global replace 
 
10.6.4 GLOBAL ADD (SEARCH) 
 
To add a field to every record you have just retrieved with a particular search, with the 
database open, select Utils ⇒ Global Add (Search). 
 
Click on search set and select a search you have just made by clicking on the button at the 
right of the combo box and clicking on the search 
 
Select the field tag using the spin box. 
 
Add the text to be entered in this field. 
 
Note that a new field will be created, for each field added. This will be created even if the 
field is already present and the field is not repeatable. The field will be created even if it is 
not in the FDT. Ensure you enter the correct field number as there is no validation! 
 
You may want the field to be created only if it is not already present. Click on Add if not 
present. 
 
When might you use this? Let's assume that every bibliographic record in a database includes 
a language code in field 41. Let's say we would like to add a note 'Foreign Language 
Material' in field 500 to those records describing non-English-language material. Select those 
records with language code not ENG: 
 

? v41 <> 'ENG' 
 
Select the search set in the global edit window. Select field tag 500 and enter in the text box  
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'Foreign Language material' 
 
and the text will be added in field 500. If field 500 is not repeatable and the field already 
exists, it will still add the field, unless you click the check box Add if not present. 
 
10.6.5 GLOBAL DELETE (SEARCH) 
 
With the database open, select Utils ⇒ Global Delete (Search). 
 
Click on Search set and select a search. If you do not select a search you will delete the field 
you select in every record. 
 
Select the field tag you wish to delete using the spin box. 
 
Choose OK. 
 
The field will be deleted from every record selected. Note that if you wish to delete only 
certain words in a field, use Global replace (10.6.3). 
 
 
10.7  MODIFICATION BY EXPORTING AND IMPORTING 
 
Another way to make changes to all the records in a database is through the export and 
import functions on the Database menu. In either process you can use a field select table 
(FST), which allows you to make changes to the data. In particular, if you want to move data 
automatically from one field to another this can only be done through exporting and 
importing. 
 
FSTs can be created from the Data Base Definition Services menu by choosing Edit ⇒ Field 
Selection Tables. Select New. Enter a name, e.g. CONV. You can use the Wizard to select 
the fields in the database you wish to export. Let us suppose you wanted to export from the 
CDS database fields 24,25,26,70,71 and 72: you select those boxes. The format which results 
should without any editing produce the desired FST, so press OK and YES. This might look 
like the table below. 

 
====================================== 
 ID     IT  Data extraction format 
====================================== 

  24   0  mhl,v24 
  25   0  mhl,v25 
  26   0  mhl,v26 
  70   0  mhl,(v70/) 
  71   0  mhl,(v71/) 
  72   0  mhl,(v72/) 

 
The wizard makes provision for repeatable fields by using groups like (v70/) - otherwise the 
repeats will get run together. 
 
Fields you wanted to eliminate, you have left out of the FST. If on the other hand you wanted 
to move data from field 24 to field 200, you could have an entry like 
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 200         0       v24 
 
or, if field 24 is repeatable: 
 

 200         0       (v24/) 
 
As the first line of the FST you can add 1 0 mfn: this transfers the MFN of the record into 
field 1. This can be used to retain the old record number in the new database (see Prompt 3 in 
Section 9.3). 
 
To put the same text into all the records exported, you could use a literal in the FST, e.g. 
 

990          0       'Copyright IDS' 
 
Other kinds of modification are possible if you have a good understanding of the formatting 
language (see the Reference Manual). You can even import two databases into one using the 
REF(L) function. 

 
If you make changes during exporting you will usually not need to use an FST when you 
import again. You will need to import into a new database definition or re-initialize the old 
database before importing again. (Be sure you have a backup in case anything goes wrong, so 
you can start again.) 
 
Another example of a FST for reformatting a database is found in Section 13.3. 
 
 
10.8  COMPACTING THE DATABASE 
 
When records are edited and then written back to the master file (.mst), the new version does 
not actually overwrite the old version. (If it were larger it would not fit anyway.) Instead, it is 
written at the end of the master file and the cross-reference file (.xrf) points to the new 
version instead of the old one. So if you have a database in which a lot of editing is done (e.g. 
a book file in which you insert borrower codes and then delete them when the book is 
returned, or a file on which you have done a global edit) a lot of space will be wasted.  
Another waste of space may be records that have been marked as deleted. (These are 
logically deleted but they are still recoverable.) 
 
Users familiar with the DOS version of the software will know that this space can be 
recovered by compacting and will wonder how to do this in CDS/ISIS for Windows as there 
is no equivalent function. If you export a file and import the file that is subsequently created 
you will find that the new MST file has fewer bytes. Before you export and import, BE 
SURE THAT YOU HAVE A BACK-UP COPY.  
 
Select Database ⇒ Export, enter a file name, say data.iso (it is best to give it an .iso 
extension) and a worksheet headed Export in ISO-2709 format will appear. If your database 
has fewer than 10 million records you need only enter Output Tag containing MFN. This 
will add to each exported record the record number and you need to use this only if you want 
to retain the MFNs in the compacted database. If you have not used field 1 in your database, 
enter 1 there, otherwise 99, or 999 are good numbers to use for field tags. 
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Click on OK and a Progress box will let you know how far you have got and eventually a 
Completed button will appear. Check that the number of records exported is the same as the 
number of records in the database seen at the bottom right of the database window (e.g. 
MAX: 12345). It will be the same if you have used Output tag containing MFN. Click on 
the button and you have finished. 
 
If you are reasonably certain that the correct number of records is exported, choose from the 
main menu Database ⇒ Import. The Name of input ISO file box will appear and hopefully 
you will see the file you have just created with an extension .iso. Double click on the file 
name, and a box headed Import from ISO-2709 file will appear. Ensure you click on the 
radio button Load (otherwise you will append the file to itself rather than overwriting the old 
database). You must also enter 1 (or the field you chose for the MFN) in the box Tag 
containing MFN. Click on OK and click OK to Data Base will be overwritten! You should 
find your database has been compacted! A database of 99 records which had been edited was 
reduced from 169,742 bytes to 37,376 bytes by this method!  
 
Users of CDS/ISIS for DOS will be aware that importing and exporting does not compact the database. In 
CDS/ISIS for Windows, on importing a database through the Load option, you will find that the database is 
compacted. 
 
You can also compact the inverted file. Select Database ⇒ I/F update and click on Full 
inverted file generation. Again you will see that the files associated with the inverted file are 
reduced in size. 
 
 
10.9  RECOVERING A CORRUPTED DATABASE 
 
You might discover when compacting a database that it has become corrupted and that some 
records cannot be found. The Master File Numbers sometimes reach impossible values, far 
above the number of records in your database. Sometimes when browsing you may appear to 
have reached the end of the database though you know there are records beyond there. The 
likely cause is that the Cross Reference File (extension .xrf) has got out of step with the 
Master File (extension .mst). 
 
Before dealing with a corrupt database, it would be a good idea to make a copy of the mst 
file. 
 
10.9.1 THE PROGRAM MSTRCV1 
 
UNESCO has circulated a program mstrcv1.exe which is a Master File Recovery Utility. It 
attempts to recover the master file records without using the XRF file. It is documented in a 
file called mstrcv1.doc. The program is run from the operating system prompt from the 
folder where it is located by typing its name, e.g. 
 
 C:\ISIS>mstrcv1 
 
You are asked for the name of the mst file, the name of the xrf file, and the maximum Master 
File Number. (You can err on the generous side.) The program then reads the master file and 
reports on what it finds. When the whole file has been examined it asks you for permission to 
rewrite the xrf file. If you reply Y the xrf file will be recreated on the basis of the 
examination of the mst file. This should make as many records as possible usable. 
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10.9.2 OTHER METHODS 
 
If you do not have the program mstrcv1, or it does not correct your problem, there are two 
other methods you can try. 
 
One is to go to your previous backup and restore it on to another computer or, if you are 
brave, into a different folder on the same computer. If the last record when restored is the 
same as the last record when the database was backed up, the problem of data corruption has 
been removed. However, any records added since that backup will not be there and any 
amendments made to other records will have been lost. You can add the records after the end 
of the restored database by exporting from the original database by choosing Database ⇒ 
Export from the main menu and then importing to the restored database. However, you 
cannot get the amendments back this way. 
 
The second method is to find the record where the problem is. It will usually be the record 
after the last one successfully exported when the database was backed up using Export. Try 
and delete this record in Data Entry. If the record refuses to be deleted (because Data Entry 
may not be able to access this corrupt record) then export all records up to the new end into a 
file called a.iso. Next try to export from one, two, three or four (etc.) records after the corrupt 
record into another file named b.iso. Now set up a new database on another computer or 
folder, import the file a.iso, then import b.iso using the Update option. 
 
When you have got back as much of the database as possible, if it is on a different computer 
or in a different folder you may copy the new one to the old. 
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11 PROGRAMMING WITH CDS/ISIS 
 
11.1  INTRODUCTION 
 
Have you ever wanted to explore the depths of CDS/ISIS to do something difficult such as a 
mathematical calculation or putting today’s date into a field? Well, CDS/ISIS for Windows 
provides at least three ways of doing this. 
• Using ISIS_DLL to program in Visual Basic 
• Using the Pascal programming facility 
• Using the extended formatting language. 
We are going to ignore ISIS_DLL in this book as it requires high level programming skills. 
We will give you here some examples of Pascal programming and of using the extended 
formatting language. 
 
 
11.2 ISIS PASCAL 
 
CDS/ISIS includes a Pascal compiler and facilities to write a program and interface it to a 
print format. Your only (!) problem is writing a program or finding someone who can do this 
for you. 
 
If you have had anything to do with the DOS version you may be aware that there were three 
types of Pascal program. CDS/ISIS for Windows allows only one, the print format exit. Other 
functions are replaced by ISIS_DLL. Menu exits are to some degree replaced by the 
flexibility of the Menu database which is discussed in Chapter 12. Pascal Menu exits and 
run-time programs written for CDS/ISIS cannot be used in CDS/ISIS for Windows.  
 
In Pascal it is possible to write a library of routines (called procedures and functions) which 
can be called on by further Pascal programs. UNESCO has made routines from this library 
available for anyone to use in programs that can be written to interface with the print 
formatting language. CDS/ISIS includes its own compiler to avoid the problem of finding a 
supplier of a commercial compiler who would allow it to be offered free of charge. Chapter 8 
of the Reference Manual1 (winisis.doc) describes CDS/ISIS Pascal but the manual written for 
using Pascal in CDS/ISIS for DOS2 which is available from distributors is essential if you 
want to write programs. It assumes a certain elementary understanding of Pascal but for those 
with knowledge of computer languages this can be deduced from the sample programs which 
are available. 
 
11.2.1 COMPILING AND RUNNING PROGRAMS 
 
Programs in high level computer languages are not usually run in the form in which they are 
written. They have to be interpreted or compiled first, that is converted into a "language" that 
can be "read" by the computer. 
 
CDS/ISIS Pascal is no exception. A program has first to be written in Pascal and the program 
file or source code file saved in the prog folder. Its name should have the extension pas. It 
may then be compiled by choosing Utils=>Compile ISIS/Pascal Programs. Select the 
source code file and double click on it. You will see a message ‘Compilation of myfile.pas  



The CDS/ISIS for Windows Handbook 131

ended. Press any key to continue’. You can then include this file in a print format as 
&myfile('') 
 
When the program is complied without errors, it generates a file with the extension .pcd 
(Pascal Compiled). In the meantime, a .pcd file may have been generated but if you try and 
use it in a print format, you will get an error box. A file will be produced with the same name 
as the .pas file and extension .lst listing the compilation errors. 
 
However, beware that even though the program may have been compiled without any 
compilation errors, it may not do what you expect. It may contain logical errors and it may 
even damage the data, for example if you are using it as part of a reformatting FST. 
 
11.2.2 SAMPLE PROGRAMS 
 
These short sample programs are provided in order to demonstrate how to write, compile and 
run programs. 
 
a) TODAY.PAS 
 
It is useful to include the date on a record display, if for example it is intended for users to 
print out records. This date is taken from the computer's system date. 
________________________________________________________________________ 
Program TODAY(s1: string; lw,occ:real; s2: string) [FORMAT]; 
{ Prints today's date} 
var dy,mo,yr,x: real; 
    dat,out,mon,new: string; 
Begin 
  dat:=datestamp; 
  mon:=substr(dat,1,2); 
  x:=val(mon); 
  case x of 

0: mon:=''; 
1: mon:='Jan'; 
2: mon:='Feb'; 
3: mon:='Mar'; 
4: mon:='Apr'; 
5: mon:='May'; 
6: mon:='Jun'; 
7: mon:='Jul'; 
8: mon:='Aug'; 
9: mon:='Sep'; 
10: mon:='Oct'; 
11: mon:='Nov'; 
12: mon:='Dec'; 

   end; 
  out:=substr(dat,4,2)|' '|mon|' 20'|substr(dat,7,2); 
  s2:=out; 
end. 
 
 
Figure 11.1 Pascal program to place the date in a print format 
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To avoid confusion, the name of the program should be the same as the file name without the 
extension. In fact, CDS/ISIS uses the file name rather than the name in the "Program" 
statement to call the program. 
 
In Pascal, any text in {...} is a comment and does not affect the operation of the program. 
 
The program calls a CDS/ISIS Pascal routine 'datestamp', which takes the system date and 
puts it in a variable, in this case 'dat'. 
 
The system date is reorganized by the program into the date in the form day, month as 3-letter 
abbreviation and final two digits of year, e.g. 31 Jan 02 for 31 January 2002.  
 
To print out the date, add to your print format &today(''). A print routine must have a 
parameter, hence the dummy parameter(''). 
 
b) FIRST.PAS 
 
The formatting language in CDS/ISIS for DOS was less sophisticated than that in CDS/ISIS 
for Windows. Here is a program written for CDS/ISIS for DOS which could now be replaced 
by the command v1[1]. If you want to use a program which has been compiled for use with 
CDS/ISIS for DOS you must recompile it in CDS/ISIS for Windows. 
 
This program prints only the first occurrence of a field. Used in a reformatting FST it will 
export only the first occurrence of a field. 
_______________________________________________________________________ 
 
program first (s1: string; lw,occ: real; s2: string)[FORMAT]; 
begin 
  if nocc(300)=1 then 
    s2:=s1 else 
  if occ=1 then s2:=s1 
    else s2:=''; 
end. 
 
Figure 11.2 Pascal program to print out only the first occurrence of a field 
________________________________________________________________________ 
 
This print exit works for field 300, to ensure that it is printed out (or selected in an FST) only 
once even if it is a repeatable field. 
 
It is called in the print format as follows for a subfielded field: 
 
MHU,(&first(v300^a))(&first(", "v300^b))(&first(" ("v300^c") 
")) 
 
If the field were not subfielded or the subfields required no special manipulating, it would be 
called as follows: 
 
 MHU,(&first(v300)) 
 
This particular program must be called from a repeatable group: the initial opening and final 
closing parentheses indicate this. 
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Although a format exit may compile successfully, it may not have the desired effect. 
Furthermore, format exits and the associated syntax are not validated by CDS/ISIS. It is 
desirable when testing a format exit to set up a special format containing only the call to the 
format exit. Format exits can easily cause a loop which causes the screen to go blank. They 
may do this if they are badly written or if they are not called correctly in the print format. If it 
does not work correctly it may lock up your computer and you may have to reboot it or if 
using Windows NT you may have to End Process with the Windows Task Manager. Your 
Network manager will show you how to use this. In any case you may lose any work you 
have done on the print format but you should not lose the Pascal program files. Print format 
exits should be used with great caution, if at all, by the inexperienced! 
 
 
11.3  EXTENDED FORMATTING LANGAUGE 
 
The formatting language itself is very powerful, particularly with its conditionals 
(if...then...else...fi) but conditionals do not suffice for every situation. 
 
In the latest version of CDS/ISIS for Windows, format variables bring the formatting 
language closer to the power of a programming language. You will often be able to use this 
instead of writing a Pascal format exit. 
 
e0 ... e9 are reserved as string variables and s0 ... s9 as string variables. Alongside 
these there are certain functions: 
 
size(format) returns the number of characters in the output string produced by a format 
expression: note that it would differ depending on the mode. 
 
If field 200 contains ^aJohnson^bSally 
mpl^aJohnson^bSally   yields 16 (^aJohnson^bSally) 
mhl^aJohnson^bSally   yields 14 (Johnson, Sally) 
mdl^aJohnson^bSally   yields 16 (Johnson, Sally. ) 
 
You can see the length by including;  
e0:size(v200),f(e0,0,0) 
or 
f(size(v200),0,0) 
 
 
 
db returns the name of the current database 
 
 
 
nocc(vn) returns the number of occurrences of a specified field, where n is the tag of that 
field. 
 
 
OCC returns the number of the current occurrence of a repeatable group 
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Suppose that field 700 has 3 repeats:   Daniel, Mark 
      Colledge, Marion 
      Fraser, Jonathan 
 
The result of the following is incorrect: 
 
(f(occ,0,0)|. |v700) 
 
1. Daniel, Mark 
2. Colledge, Marion 
3. Fraser, Jonathan 
4 
 
The last 4 appears because the program does not know until it reaches the field data that there 
is not another repeat. By then it has already printed the repeat number. How can this be 
prevented? 
(if occ <= nocc(v70) then f(occ,0,0),fi,|. |v70) 
 
This checks that the number about to be displayed is less than or equal to the number of 
occurrences of that field in the record. If the number about to be printed is greater than the 
number of repeats it will not print the occurrence number. 
 
The f function converts a number into a string so that it can be displayed. 
 
 
tag used in repeatable groups returns the tag of the fields in the record. 
 
The *ALL* print format can be reproduced by: 
 
(if(p(v0) then f(tag,0,0),' ',v0/ fi)/ 
 
To produce this display for just one field:: 
 
(if(p(v200) then f(tag,0,0),' ',v0/ fi)  
 
will produce the value of field 200.  You could do this for all fields you wished to be 
displayed, but of course it is equal in its output to |200 |v200/ 
 
 
date(type)would produce on 8th December 2002: 
 
date(1) 12-08-2002  15:38:20 
date(2) 12-08-2002 
date(3) 15:38:20 
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In CDS/ISIS for DOS, it was possible to program a function key to hold today’s date. In 
CDS/ISIS for Windows you can do it with the extended formatting language. Choose from 
the main menu bar Edit ⇒ Data entry worksheet. In this example, the field where you 
would like the date to be entered automatically is ‘60 Date Record Created (DD-MM-
YYYY)’. In Record validation in the End code text box enter 
 
      if mfn=0 then 'a60#',date(2),'#',fi 
 
Click on OK. This statement checks to see if it is a new record (mfn = 0) and if so adds field 
60 in the date(2) format. 
 
ss has three parameters:  for position, length and format and returns the substring of the 
format starting from the stated position for the stated length. 
 

ss(4,2,date(1))'/' 
ss(1,2,date(1))'/' 
ss(7,2,date(1)) 

 
The above would on 8th December 2001 produce 08/12/2001 
 
 
11.4  SOURCES OF PROGRAMS  
 
Users of CDS/ISIS all over the world are writing Pascal programs and using complex print 
formats. Some are writing them for a specific purpose which might not be relevant to anyone 
else. Others are writing programs that would be useful to others. Some, particularly UN 
agencies are making them freely available to others (and, in the case of Pascal programs, are 
circulating the source code). Others are offering programs for a fee. Some have published 
lists of programs. Many users have called for a catalogue of these programs to be made 
available, but the task would be very difficult and UNESCO have stated that they do not have 
the resources to do this. The CDS/ISIS Mailing List is a useful forum for seeking information 
(see Section 1.7). 
 
However, as already stressed, be very careful whenever installing and using Pascal programs. 
It is unlikely that they will have been tested to the same extent as CDS/ISIS for Windows. 
Those from reputable sources will no doubt have functioned correctly at the original 
installation, but even these may not work correctly under other conditions. 
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12  CUSTOMIZING THE PACKAGE 
 
12.1  INTRODUCTION 
 
When you have set up your system and have been running it for a while, you will want to 
tailor it to your requirements. For example, you may want to put the name of the database on 
the database window bar. It is possible to write special programs in Visual Basic to change 
the screen displays using ISIS_DLL. We are not going to include that in this manual as it 
requires specialist programming knowledge. Or you may want to add or change CDS/ISIS 
Help. You may not like the terminology used by the system or you may want to add screens 
in languages other than the basic English, French and Spanish provided at installation.  
 
Your distributor may have already done some of the above before you receive the package, in 
which case your menus may not correspond exactly with those in the manuals you have 
received with the package or those depicted in this Handbook. 
 
 
12.2  CUSTOMIZING THE MENUS 
 
The text on the screens is generally customizable. Those familiar with CDS/ISIS for DOS 
will be aware that there were message files held in a database and menu files held as 
worksheets. In CDS/ISIS for Windows, menus as well as messages are held as databases. 
 
Before making any changes you should copy the database files mn* (MNENDF is the 
English default menu database) and ms* (MSEN is the English message database) to another 
folder or a floppy disk in case you need to get them back You should also copy the 
syspar.par file to another file, say syspar.old. If you have any problems starting CDS/ISIS, 
copy syspar.old to syspar.par.  
 
To change the heading  
 

CDS/ISIS for Windows [Full Version : EN] 
 
open the database MNENDF and edit field 1 of record 1. For example, replace 'Full Version' 
by 'Middlesex University'. The database MNENDF includes the messages that relate to the 
Full Version of CDS/ISIS for Windows – see Section 3.4.2. 
 
The database MNENSH lists the texts in the menus that relate to the search only version. If 
you do not make a change to this database, the read-only version will still show the default 
message  
 

CDS/ISIS for Windows [Search only version: EN] 
 
When you open a menu database, you will see that many of the entries contain an ampersand, 
&. This precedes the character which in conjunction with the {Alt} key will activate that 
item on the menu. Any item without an ampersand can be accessed only from the mouse or 
by using the arrow keys. 
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12.3  CUSTOMIZING THE MESSAGES 
 
If you do not like any of the messages in any of the languages, you may change them, but 
make sure that the new message is of approximately the same length as the old, or you may 
find yourself with some strange-looking screens.  
 
The messages are stored in a database for each language. 
 
If you wish to change the message file you have to access it as a database in Data Entry with 
its name, e.g. MSEN (English), MSFR (French) or MSIT (Italian). In CDS/ISIS for DOS, you 
cannot change the message file if you are already using it in your CDS/ISIS session, so you 
have to change the language you are using by going to another language. In CDS/ISIS for 
Windows you do not need to worry. Nevertheless, it is probably better to practice on another 
file. If you do not have another language message file, you will have to create one (see 
Section 12.4)! This cannot be done in CDS/ISIS but has to be done in DOS or Windows 
Explorer. Remember to ensure that messages edited remain similar in length; in some cases a 
message of a different size will cause no problems but you will have to experiment to find out 
what the end result looks like. 
 
Each message in CDS/ISIS has a number by which it is known to the system. Before making 
any changes to the message file, you should print out the messages. You can do this by 
entering the database and printing it in the usual way (see chapter 8). If the software has been 
set up using the usual defaults it will be sent to the printer; otherwise you can create an ASCII 
file of messages relating to the language you have opened. When you are asked for a 
filename, call the file msen.lst (for an English language message file) or msfr.lst (for French) 
etc.  This file may then be printed out. 
 
When you have printed out the messages, you will see that they are grouped into records each 
containing 10 fields. Message 5 is field 5 in record number 1 and message 38 is field 8 in 
record 4.  
 
If a message is missing, when you see a screen which should display that message, you will 
see the text Mess[244] or some such in its place. You then have to edit the database to put in 
say record 25 a value for a message in field 4. 
 
Note that some messages with the same text are repeated in the database. If you change 'Help' 
in message 4 (of record 1), it will only change the word ‘help’ in the print worksheets. 
 
 
12.4  ADDING A LANGUAGE 
 
To add a language, go to the DOS prompt (or use Windows Explorer to complete the 
following instructions). This assumes you wish to copy the English to the French messages 
which you would normally do only if there were no French messages present. 
 
 cd\winisis 
 cd msg 
 copy msen.* msfr.* 
 copy amsen.fmt amsfr.fmt 
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 cd\winisis\menu 
 copy mnendf.* mnfrdf.* 
 copy amnend.fmt amnfrd.fmt 
 copy mnensh.* mnfrsh.* 
 copy amnens.fmt amnfrs.fmt 
 
You will have copied the English message to the French message files and the English menus 
to the French menus. You can then change to 'French' (i.e. the copy) which will actually now 
display English language messages and menus since you have copied the English menus to it.  
 
As far as adding a new language is concerned you might have received the necessary files for 
an extra language or you might have to create them yourself, or you might have received 
some files but not all for an additional language. 
 
There are three sets of files which make up the screens and messages needed for each 
language and each of these types of file contains somewhere within the filename the language 
code. Each language is known to the system by a two-letter code. It is a good idea to use 
where possible the ISO language code for this: thus English is EN, French is FR and Spanish 
is ES. 
 
To return to the three kinds of files, the first type is the default menu files, and these files 
have names beginning with mn. They are followed by a language code (two letters) and then 
df to indicate the default menus. The short version of the menus consists of files beginning 
with mn, followed by the language code, e.g. en, followed by sh for the short worksheet. 
These worksheets are stored in the form of a CDS/ISIS database and have associated 
worksheets, amnens, for data editing. Message files, the third set of files, are stored similarly, 
as databases beginning ms, followed by the language code. They too have associated 
worksheet files. Thus msit is the main Italian menu database and amsit.fmt is the default 
data entry worksheet for the message files database. 
 
If you are given a set of files for a new language, add them according to the instructions with 
the diskette. If there are no instructions, you need to add the message files to the subdirectory 
\winisis\msg and the menu files to the subfolder \winisis\menu. 
 
Let us suppose in this example that you are adding German and the language code is DE 
(Deutsch). The diskette should contain the following files: 
 
           
 msde.cnt msde.fdt msde.fst msde.ifp msde.l01 
 msde.l02 msde.mst msde.n01 msde.n02 msde.pft 
 msde.xrf amsde.fmt mndedf.cnt mndedf.fdt mndedf.fst
 mndedf.ifp mndedf.l01 mndedf.l02 mndedf.mst mndedf.n01
 mndedf.n02 mndedf.pft mndedf.xrf amnded.fmt bmnded.fmt
 mndesh.cnt mndesh.fdt mndesh.fst mndesh.ifp mndesh.l01
 mndesh.l02 mndesh.mst mndesh.n01 mndesh.n02 mndesh.pft
 mndesh.xrf amndes.fmt bmndes.fmt 
 
With the diskette in drive A, go to the C: prompt and type the following: 
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 copy a:mn*.fmt c:\winisis\menu\ 
 copy a:amn*.fmt c:\winisis\menu\ 
 copy a:ms*.* c:\winisis\msg\ 
 copy a:ams*.fmt c:\winisis\msg\ 
 
You have now transferred the files from the floppy disk to the computer hard disk. 
 
If you yourself wish to create a new language you must do the following to create the new 
files. Copying them from the English language version, you will be able to edit each entry in 
the menu and message databases, replacing the English texts with texts in your chosen 
language. Changing the text of menus and messages is described above in Sections 12.2 and 
12.3. We will use German for the example below which shows you how to create the new 
files ready to be translated. 
 
Go to the C prompt. 
 
 cd\winisis\msg 
 copy msen*.* msde.* 
 copy amsen*.fmt amsde.fmt 
 cd\winisis\menu 
 copy mnen*.* msde*.fmt  
 copy amnen*.* amnde*.*  
 
In both cases, you will have to change the menu database to add on the new language. Field 1 
of record 1 must contain the name of the language. 
 
 
12.5  CHANGING THE LOOK OF THE SCREENS 
 
In CDS/ISIS for DOS you could change the colours of CDS/ISIS displays from the utilities 
menu. There is no direct equivalent in CDS/ISIS for Windows, so here we show you ways of 
doing similar. Firstly, you can change the colours of your screens in Windows. Click on the 
Start button ⇒ Control panel ⇒ Display ⇒ Appearance ⇒ Scheme. From the drop down 
menu try other colour schemes. But be aware that any changes here will be permanent and 
will affect the colour scheme in all programs you run on the computer. If other people use 
your computer you may not wish to do this. 
 
Some of the illustrations in this Handbook use the standard Windows colours and some use a 
rose-coloured display scheme. 
 
12.5.1 CHANGING RECORD DISPLAYS 
 
Without changing the colour scheme for your computer, there is still a great deal of scope to 
change the colours of the record displays. You can set the colour in the display format by the 
command cl followed immediately by a number. cl1 will make the text red. cl5 will 
make the text purple. box will place the text in the next paragraph (until the next / or #) in a 
box with the same colour as the text. box(5) will place the text in a box filled in with 
purple. make sure the colour of the text set by cl is not the same as the colour of the box. 
You can see the colour of the backgrounds by setting up a print format containing only a 
simple program. 
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while e0 <= 22 (box(e0),f(e0,0,0)/e0:=e0+1) 
 

This will display the number of the current line in the default system colour on a coloured 
background the colour represented by the number displayed. 
 
You could make the fonts bigger by prefixing the line above with fs50. Try fs1000, and 
you will see huge numbers displayed. Try fs10 and you will get 5 point text. fs means 
font size and CDS/ISIS measures font size in half points. 
 
These features are available in the extensions to the print formatting language which were not 
available in the DOS version and are covered in Section 5.6 of this Handbook. 
 
12.5.2 CHANGING PRINT FORMAT DISPLAY 
 
While you are changing the print format in the main data base window, you may like to try 
changing the font in which the print format is displayed when you edit it. This does not have 
any effect on the ordinary user of the database who is restricted from changing print formats 
and it does not make any difference to the fonts in which records are displayed. Click on the 
A icon at the bottom right of the database window and you will be able to change the font. To 
avoid problems of not being able to find the default settings again, before making these 
changes, copy syspar.par to a diskette. If you wish to restore the original settings, copy 
syspar.par from the diskette over the existing file which will normally be in the c:\winisis 
folder. 
 
12.5.3 CHANGING DATA ENTRY SCREENS 
 
It is easy to change the fonts on the data entry screens as well. Choose Edit ⇒ Data entry. 
Choose the Options button and select the Font by name, or change its size. Make the changes 
you wish. These will remain until you change them again. You may need to change the font if 
you wish to use diacritical characters and they are not displaying correctly in the font 
currently selected. 
 
12.5.4 CHANGING OTHER SCREENS 
 
Print format displays and data entry screens can be changed also through Configure => 
System Settings => Display as can the fonts used in the dictionary, and the Dialog font. You 
may need to experiment with changing the fonts if you wish to use a different script or even if 
you need diacritical characters and they are not displaying correctly in the font currently 
selected. You may also wish to alter the size of the fonts, particularly for users who are 
partially-sighted. 
 
 
12.6  TAILORING WORKSHEETS 
 
Unfortunately, it is not possible as it was in CDS/ISIS for DOS to provide users with default 
worksheets, with values which appear as soon as the worksheet is accessed. This is 
particularly useful in sorting and printing since the values which have to be entered are quite 
complex and it is not very comfortable to have to enter them again if a small mistake is made 
and you have to set up the worksheet again. The print worksheet has a special facility for 
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saving the values in it. You may save the values entered in all the dialog boxes of the 
worksheet and recall them. The file is saved with the extension .wpr. You may copy this to 
any other computer and it should work correctly if it is used in an identical database. It is  
particularly useful to be able to load the values to be entered in the sorting dialog box of the 
print worksheet as they will usually be complicated to set up. When once you have perfected 
the process it is likely that this will be repeated many times over and it is a good idea to save 
the parameters to avoid the necessity to re-enter them each time. However, all values will be 
saved except for the pre-defined print format which must be entered each time the values are 
reloaded.  
 
Let us suppose you regularly print cards and you want to save a sorting and printing 
worksheet for printing cards from a database which uses the UNIMARC format. 
 
Set up the worksheet as in Section 8.10. Choose Save in the General dialog box and at the 
cursor overwrite .wpr with a filename of your own choosing, with the wpr extension, say 
cards.wpr. To reuse this, load it by selecting the Recall button. 
 
 
12.7  CHANGING THE SYSTEM PARAMETERS 
 
12.7.1 SYSTEM LANGUAGE 
 
To make the system start up in French (when the language code is FR) add to syspar.par: 
 

101=FR 
 
It is possible to include non-Roman character sets in CDS/ISIS, but that is outside the scope 
of this book. Also, further alterations may have to take place for certain languages. Turkish 
for example has additional letters, G hacek and Turkish I which cause problems if you have a 
Turkish keyboard. Turkish I particularly causes a problem because upper case Turkish I is 
equivalent to Roman capital I and lower case Turkish i is a separate letter [turkish-i]. Turkish 
normal i has no dot and Turkish upper case I has a dot above it. It is necessary in Turkish to 
change the tables isisuc.tab and isisac.tab to take this into account so that each character 
will convert into its appropriate upper case character when preparing any index, whether a 
printed index or the inverted file. Also a Turkish font has to be procured, though that will not 
be a problem in a Turkish environment. 
 
Other languages can cause different problems. The circumflex sign is replaced by a letter of 
the alphabet in some eastern European character sets. It is however impossible to use that 
character in text since it is a reserved character for the initial character of the subfield 
identifier and for the Boolean NOT operator. When CDS/ISIS finds it in text it will treat it 
along with the following character as a subfield identifier. 
 
It is not possible to describe here the changes necessary to take different language versions 
into account and the best way to look for solutions to any problems that arise is to approach 
users who are using these languages to see what advice they can offer from their experience. 
 
12.7.2 STARTING UP IN A DATABASE 
 
You may wish users to open a specified database when loading the program. 
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From the menu bar, choose Configure ⇒ System settings. Enter the name of the database in 
Default database. Users will then enter this database on running the program.  
 
12.7.3 LIMITING ACCESS TO DATABASES 
 
You may have a number of databases on your computer or network which are, let’s say, for 
development work and which you do not want your end users to see. You can restrict users to 
a list of databases that you enter in syspar.par in parameters 1001 to 1005. Parameter 125 
must be 1 (125=1). It is possible to hide the name of the database and provide a description as 
below. To allow access only to the CDS database, you could enter in syspar.par: 
 

1001=CDS***UNESCO Sample Database  
 
If you click on Open ⇒ Database, a listbox will appear with the names and descriptions of 
the databases as in Figure 12.1. 

 
 
12.8  CONTROLLING ACCESS TO EDITING 
 
To remove edit access, choose Configure ⇒ Change profile and select Search Only 
Version from the Option window. You will see that the Edit and Utils options disappear 
from the main menu bar. This ‘read only’ mode will remain until you leave CDS/ISIS for 
Windows. To make this a permanent feature, edit syspar.par parameter 102 to read 
102=SH. SH means the short menu, i.e. without edit. If the value is 102=DF, you should see 
the full editing menu. 
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This is covered in Section 3.4.2 . 
 
It is possible to provide alternative menus in the same system by using passwords. 
 
Create a file staff.par with one line:  

102=DF 
 
Create a file reader.par with one line  

102=SH 
 
Add a line to the end of the syspar.par file 

0=!Please enter your password 
 
The result is that next time you run CDS/ISIS you must enter a password, in this case either 
staff or reader. This will take from the password files the value of parameter 102 as 
found there.  
 
You can also use the password to give different users different features. You can, for 
example, give one password to the geography department so that CDS/ISIS opens up for 
them in the GEOG database and one to the history department so that they open up with the 
HIST database. 
 
The history.par file will include: 

102=SH 
6=HIST 

while the geog.par file will include: 
 102=SH 
 6=GEOG 



The CDS/ISIS for Windows Handbook 145

13 APPLICATIONS 
 
CDS/ISIS is designed for information retrieval of textual data. It can be used for library 
catalogue databases, databases of other kinds of bibliographic references or for any kind of 
reference database such as directories. Another application is mailing lists. Since it has very 
good printing capabilities, it can be used for maintaining data and printing them out in 
different formats. The formats may be directories for publication or labels for postage. It can 
even produce standard letters from a mailing list database. 
 
If you want to use it for an integrated library automation system, you will have to acquire a 
suite of programs most probably written in Visual Basic using ISIS_DLL to use in 
conjunction with the basic package. Further information on this kind of application is given 
in Section 13.5. A large number of such applications were developed for CDS/ISIS for DOS. 
These may still be used running under CDS/ISIS for DOS, but at the same time you may also 
use CDS/ISIS for Windows to access these databases for functions which work better under 
Windows than under DOS. 
 
 
13.1 NUMERICAL APPLICATIONS 
 
CDS/ISIS is weak on numeric applications. However, UNESCO has developed a package 
called WinIDAMS (Internationally Developed Data Analysis and Management Software 
Package)1 and an interface which can import and export data from CDS/ISIS called IDIS. 
This package requires expert statistical knowledge. Information on WinIDAMS is available 
from UNESCO/CI (see address in Section 14.4). 
 
 
13.2 STANDARD FORMATS 
 
As mentioned in Section 1.8, CDS/ISIS supports standard formats. A number of applications 
implementing standard formats have been developed. Some of these have been based on the 
UNESCO Common Communication Format.2,3

. Although a database and manual have been 
widely circulated on diskette, they have not been formally distributed. 
 
A self-contained demonstration database (including a reduced version of the CDS/ISIS 
software) has been developed at the National Library in Portugal. Its main function is to 
illustrate retrieval on a UNIMARC4 database. It includes a number of print formats which 
offer different kinds of display including ISBD and AACR as well as a display with 
UNIMARC tags, indicators and subfield identifiers.5 It is available from the IFLA UBCIM 
Programme at Deutsche Bibliothek, Frankfurt, Germany (see Section 14.4). Although this is a 
program using CDS/ISIS for DOS, the database FDT can be used as it is though you will 
need to add the subfields to the FDT if you want to enter data. The print formats also need a 
little editing to remove Pascal format exits for the print formats which are not available in 
source code so cannot be re-compiled for CDS/ISIS for Windows. 
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13.3 SAMPLE UNIMARC DATABASE 
 
The Field Definition Table in Figure 13.1 is compatible with UNIMARC which is an 
international exchange format developed by the International Federation of Library 
Associations and Institutions for the exchange of bibliographic data between national 
libraries.4  
 
Tag   Name                          Subfields           
1     ISN       
10    ISBN                          abdz                 
11    ISSN                          abdz                 
20    NATIONAL BIBLIOGRAPHY NO.     a            
21    LEGAL DEPOSIT NO.             a                    
22    GOVT. PUBLICATIONS NO.        abz                  
100   GENERAL PROCESSING DATA       a                    
101   LANGUAGE OF ITEM              acd                  
102   COUNTRY OF PUB'N              a                    
200   TITLE                         acdefghi             
205   EDITION                       adfg                 
206   MATHEMATICAL DATA             a                    
207   SERIAL NUMBERING              a                    
210   IMPRINT                       acd 
215   PHYSICAL DESC.                ae  
225   SERIES STATEMENT              adefivx1 
300   GENERAL NOTE                  a 
320   BIBLIOGRAPHY NOTE             a 
330   SUMMARIES OR ABSTRACTS NOTE   a 
324   FACSIMILE NOTE                a   
326   FREQUENCY NOTE                a   
327   CONTENTS NOTE                 a   
328   THESIS NOTE                   a   
330   SUMMARY OR ABSTRACT           a   
454   TRANSLATION OF                a   
461   HOST SERIAL                   avp 
488   RELATED TITLE                 a   
500   UNIFORM TITLE                 aln 
501   COLLECTIVE UNIFORM TITLE      a   
512   COVER TITLE                   a   
517   VARIANT TITLE                 a   
600   PERSON RESPONSIBLE (MAIN)     abcdefghijklmnopxyz1234 
606   SUBJECT DESCRIPTORS           abcxyz 
675   UDC                           avz 
700   PERSON RESPONSIBLE (MAIN)     abcdefghijklmnop1234  
701   PERSON RESPONSIBLE (ALTERN)   abcdefghijklmnop1234  
702   PERSON RESPONSIBLE (SECONDARY)abcdefghijklmnop1234 
710   CORPORATE RESP'LE  (MAIN)     abcdefghijklmnop1234 
711   CORPORATE RESP'LE  (ALT)      abcdefghijklmnop1234 
712   CORPORATE RESP'LE  (SECONDARY)abcdefghijklmnop1234 
801   SOURCE                        abcd 
966   SHELFMARK                     a 
 
Figure 13.1 Sample Field Definition Table for UNIMARC 
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Subfield identifiers must be entered in the Field Definition Table in order for all aspects of 
the database to work and to ensure that it conforms to the UNIMARC format. The subfields 
need to be entered into the text by the cataloguers as required. 
 
The format is UNIMARC with a few variations. Field 966 is a private field for Shelfmark. 
 
A worksheet should be set up to enable these fields to be entered. Help messages should be 
added to the worksheets.  Some examples are given in figure 13.2. 
 
 
Field 200 
^aTitle proper ^bTtitle proper, other author^dParallel title^fStatement of 
resp.^gSubsequent statements 
 
Field 300 
^a Note 

 
Figure 13.2 Help messages for UNIMARC database 
 
 
Validation may also be added. According to the UNIMARC manual, field 200 should be 
present. Record validation should include in the Format text box: 

 
 
if a(v200) then 'Field 200 must be present' fi 

 
 
Since field 200, subfield a must also be present, the following can be entered as the validation 
for field 200. Double click on 200 under Data entry fields and enter in Validation / Format  
 
if a(v200^a) then 'Field 200 subfield a must be present',fi 
 
It is assumed that UNIMARC indicators would not be entered in fields where they always 
have the value of two spaces. Otherwise the cataloguers should enter the indicators at the start 
of each field exactly as required by the format as specified in the manual. The FST in Figure 
13.4 will add the spaces automatically if data are exported to another UNIMARC user who 
may not be a CDS/ISIS user. 
 
The print format in Figure 13.3 can be used to produce either catalogue cards or a display on 
the screen. 
 
In order to export records in UNIMARC format, the Reformatting FST unimarc.fst shown in 
Figure 13.4 can be used to add the indicators. The settings on the export worksheet should be 
as follows: Subfield separator \031. Output line length 0 
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mpl(mpu,v700^a||,mpl|, |v700^b) 
mdl,(mhu,v710^a||,mhl,|. |v710^b||,| (|v710^c|) 
 |,|, |v710^d||,|, |v710^e||,|, |v710^f||/)/, 
c4,(| ; |+v200^a,|. |v200^c,| : |v200^e,|   |v200^d,| / |v200^f,| ; 
|v200^g),,mdl,". -- "v210^a""," : "v210^c"",",  
"v210^d"",,mpl,ref (l(v461),mhl |. In: |v200^a,|(|v102|)|) 
mhl,if p(v461) then" "v207          ,   else "  . -- "v207"  ",,fi,if 
p(v215^a) then ". - "v215^a"" else " pp."v215 ,fi 
(mhl," ("v225^a," / "v225^f,"; "v225^v,")"d225")"), 
mhl,". -- ISBN "v010,". -- ISSN "v011, 
(|. -- |v300*2),(|. -- |v301*2),(|. -- |v302*2),(|. -- |v303*2),(|. -- 
|v304*2),(|. -- |v305*2), 
(|. -- |v306*2),(|. -- |v307*2),(|. -- |v308*2),(|. -- |v310*2),(|. -- 
|v311*2),(|. -- |v312*2), 
(|. -- |v313*2),(|. -- |v314*2),(|. -- |v315*2),(|. -- |v316*2),(|. -- 
|v317*2),(|. -- |v318*2), 
(|. -- |v320*2),(|. -- |v321*2),(|. -- |v322*2),(|. -- |v323*2),(|. -- 
|v324*2),(|. -- |v325*2), 
(|. -- |v326*2),(|. -- |v327*2),(|. -- |v328*2),(|. -- |v330*2),/,# 
'Tracings: '/ 
(mpu,v701^a||,mpl|, |v701^b/)/ 
(mhu,v711^a||,mhl,|. |v711^b||,| (|v711^c|) |,|, |v711^d||,|, |v711^e||,|, 
|v711^f||/) 
(mpu,v702^a||,mpl|, |v702^b/)/ 
mdl,(mhu,v712^a||,mhl,|. |v712^b||,| (|v712^c|) |,|, |v712^d||,|, 
|v712^e||,|, |v712^f||/) 
mdl,v500*2%v501*2%v502*2%v503*2%v504*2%v505*2% 
v506*2%v507*2%v508*2%v511*2%v518*2%%v510*2%v512*2% 
v513*2%v514*2%v515*2%v516*2%v517*2%%v520*2%v521*2% 
v522*2%v523*2%v524*2%v525*2%v526*2%%v527*2%v528*2% 
v529*2%v530*2%v531*2%v532*2%v533*2%# 
'Subject data:'/"UDC "v675^a+|; |,(v606*2(6,6)/)(v600*2(6,6)/)/# 
"Catalogue record no. "v001## 
 

 
Figure 13.3 UNIMAR print format 
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  1 0 mhl,v1 
 10 0 mhl,(|  |v10/) 
 11 0 mhl,(|  |v11/) 
 20 0 mhl,(|  |v20/) 
 21 0 mhl,(|  |v21/) 
 22 0 mhl,(|  |v22/) 
100 0 mhl,|  |v100 
101 0 mhl,v101 
102 0 mhl,|  |v102 
200 0 mhl,v200 
205 0 mhl,|  |v205 
206 0 mhl,|  |v206 
207 0 mhl,v207 
210 0 mhl,|  |v210 
215 0 mhl,|  |v215 
225 0 mhl,(v225/) 
300 0 mhl,(|  |v300/) 
320 0 mhl,(|  |v320/) 
321 0 mhl,(v321/) 
324 0 mhl,|  |v324 
326 0 mhl,(|  |v326/) 
327 0 mhl,v327 
328 0 mhl,(|  |v328/) 
330 0 mhl,(|  |v330/) 
454 0 mhl,(v454/) 
461 0 mhl,(v461/) 
488 0 mhl,(v488/) 
500 0 mhl,(v500/) 
501 0 mhl,(v501/) 
512 0 mhl,(v512/) 
517 0 mhl,(v517/) 
600 0 mhl,(v600/) 
606 0 mhl,(v606/) 
700 0 mhl,(v700/) 
701 0 mhl,(v701/) 
702 0 mhl,(v702/) 
710 0 mhl,(v710/) 
711 0 mhl,(v711/) 
712 0 mhl,(v712/) 
801 0 mhl,(v801/) 
966 0 mhl,(v966/) 
 
Figure 13.4 Reformatting Field Select Table unimarc.fst 
 
UNIMARC has a format for authorities. In this implementation we use the ref(L) format 
to link a bibliographic record to an authority record via authority ID.  
 
Figure 13.5 shows a selection of fields from the authority file database. 
 
 
Each record is given a record identifier (ID) in field 001. This ID is used to identify the 
record in the bibliographic record. Using your authority file database, you can build a record 
which contains data in the record itself or in the case of authority data you may make a link to 
the authority format. UNIMARC fields for authors include a subfield ^3 for link. 
 
Field 700 linking to authority record AUTH12345 will be as follows 
 

700  _1^3AUTH12345 
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Tag Field                       Subfields      Repeatability     
 
1   Record identifier                                 N 
100 General processing data       a                   N 
150 Coded data field for names    a                   N 
152 Rules                         ab                  N 
200 Heading - personal name       abcdfgxyz012345678  N 
210 Heading - corporate body name abcdefghxyz02345678 N 
300 Information note              a67                 R 
305 Textual See also Ref note     ab67                R 
310 Textual See Ref note          ab67                R 
320 General Explanatory Ref note  a67                 R 
330 General Scope Note            a67                 R 
400 See Ref Tr - Personal name    abcdfgxyz012345678  N 
410 See Ref Tr - Corp body name   abcdfghxyz012345678 N 
500 See Also Tr - Personal name   abcdfgxyz012345678  R 
510 S A Ref Tr - Corp body name   abcdfghxyz012345678 R 
801 Originating source            abc                 N 
 
Figure 13.5  FDT of UNIF: UNIMARC Authority File 
 
In record with ID (field 001) AUTH12345 in database UNIF, is a field 200 containing the 
actual name in the form required for the catalogue heading. The id field (001) has to be 
indexed to provide the link with ref(L) in the print format in the UNIB database: 
 

ref->unif(l->unif(mpl,v700^3),mhu,v200^a,|, |v200^b) 
 
Thus, subfields 200^a, 200^b will be printed out. 
 
Field 700 could alternatively have held _1^aShakespeare^bWilliam 
 
The index to the UNIB database also needs to include data from the UNIF database. 
 
This can be done with the following entry in the field select table in the database UNIB: 
 
700 0 mpl(ref->unif(l->unif(v700^3),|AU |v200^a,|, |v200^b)/) 
 
This needs to be done for each authority field: persons and corporate bodies. 
 
To sum up there are three elements required for authority file linking implementation, 
remembering that the authority file should be a database in its own right. 
 
a) A subfield in the bibliographic database to hold the ID of the authority file record. 
 
b) A print format (using ref(L) to display the data from the authority record in place of the 
authority ID 
 
c) An entry in the FST to add to the inverted file the data from the authority file. 
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13.4 DIRECTORY DATABASE 
 
CDS/ISIS is just as useful for producing directories as it is for producing library catalogues or 
bibliographies. 
 
Figure 13.6 illustrates a Field Definition Table based on the UNESCO Common 

Communication Format for Factual Information (CCF/F).3  It is part of a database which was 
originally designed to integrate records relating to persons, research projects and institutions 
as well as bibliographic records connected with these such as reports from research projects, 
articles produced by a person or books produced by or about an institution.  The fields 
necessary for bibliographic description are not included in this example.  The full database, 
known as the CCF Integrated Database, is available from UNESCO. 
 
Tag Name                           |   Type   | Rep| 
 22 Date record entered             Alphanumer  - 
 31 Language of record              Alphanumer  - 
 62 Type of factual information     Alphanumer  - 
 64 Type of institution             Alphanumer  - 
125 Project number                  Alphanumer  R 
130 Contract number                 Alphanumer  R 
200 Title                           Alphanumer  - 
300 Name of person                  Alphanumer  R 
301 Sex                             Alphabetic  - 
310 Name of Corporate Body          Alphanumer  R 
320 Name of Meeting                 Alphanumer  R 
391 Director                        Alphanumer  R 
392 Contact person                  Alphanumer  R 
430 Address, phone, etc             Alphanumer  - 
448 Start and end dates             Alphanumer  R 
500 Note                            Alphanumer  R 
610 Classification scheme notation  Alphanumer  R 
620 Descriptor                      Alphanumer  R 
700 Human resources                 Alphanumer  - 
705 Equipment and other resources   Alphanumer  - 
706 Information resources           Alphanumer  - 
710 Financial resources             Alphanumer  - 
715 Income components               Alphanumer  - 
716 Expenditure components          Alphanumer  - 
800 Nationality                     Alphanumer  - 
810 Educational qualifications      Alphanumer  - 
820 Experience of person            Alphanumer  - 
850 Duration of project             Alphanumer  - 
856 Link to external resource       Alphanumer  R 
860 Project status                  Alphanumer  - 
903 Regular publications            Alphanumer  R 
 
Figure 13.6 Field Definition Table for CCF factual database 
 
Print formats may be devised for each type of material.  These print formats depend on codes 
for the type of record having been entered in field 062: PER for person, PRO for project and 
INS for institution. The format in Figure 13.7 is a combined format for persons, institutions  
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and projects. Another format would be required for bibliographic records (let’s call it 
CCFBIB). Alternatively each type of material could have its own format (let’s call them 
CCFPER, CCFINS, CCFPRO). Then the default format will consist of the file displayed in 
Figure 13.8. Here the format references other formats. 
 
 
if v62 :  'PER' then  'PERSON'/'======'mdl,/"NAME OF PERSON: ",d300,""v300^c""," 
 "v300^b""," "v300^a/("Institutional affiliations: "v330(28,28)+|; |/)/mhl,"Addr 
ess: "d430,v430^a(9,9)/v430^b(9,9)/v430^c(9,9)/v430^d(9,9)/v430^e(9,9)/v430^f(9, 
9)/v430^g(9,9)//"Phone: "v430^h(9,9)/"Telegraphic address: "v430^i/"Telex: "v430 
^j/"FAX: "v430^k%##"Date of birth: "v300^d.4,"-"v300^d*4.2,"-"v300^d*6.2%#"Worki 
ng languages: "mdu,v40^a+|, |/mdl,mdl,"Nationality: "v800^a/"Sex: "v301/mdl,"Edu 
cational qualifications: "v810/("Experience: "v820/)/("Descriptors: "v620^a+|, | 
)%###"Notes: "v500^a%"Abstract: "v600(4,0)%"Subject area classification no(s).:  
"v610+|; |%mdl,fi,if v62 : 'INS' then 'INSTITUTION'/'==========='/mhu,V310^a||,| 
. |v310^b,| (|v310^c|) |,|, |v310^d,| - |v310^e/mdl,"   Type: "v64/mdl,"Address: 
 "d430,v430^a(9,9)/v430^b(9,9)/v430^c(9,9)/v430^d(9,9)/v430^e(9,9)/v430^f(9,9)// 
"Phone:   "v430^g(9,9)/"Telegraphic address: "v430^h/"Telex:   "v430^i/"FAX:     
 "v430^j/"Director: "n391^f,(||v391^f|: |,||v391^c||,| |v391^b||,| |v391^a||/)%" 
Contact Person(s): "n392^f,(||v392^f|: |,|                   |+v392^c||,| |v392^ 
b||,| |v392^a||/)%"Persons: "n300^f,(||v300^f|: |,|         |+v300^c||,| |v300^b 
||,| |v300^a||/)%(|Founded: |v448^a.4,|Founded: |v448^b,|Ceased: |v448^c.4,|Ceas 
ed: |v448^d/)"Description: "v600/"Classification: "v610+|; |,"Descriptors: "v620 
^a+|, |/"Working language(s): ",mdu,v040%mdl/"Human resources: "v700/"Resources: 
 "v705/"Information resources: "v706/"Financial resources: "v710/"Income compone 
nts: "v715/"Expenditure components: "v716/"Notes: "v500^a/ fi,if v62 : 'PRO' the 
n 'PROJECT'/'======='/mdu,"Project title: ",V200(0,4),mdl/"Director: "d391,(||v3 
91^f|: |,||v391^c||,| |v391^b||,| |v391^a+|; |)/"Contact person: "d392(||v392^f| 
: |,||v392^c||,| |v392^b||,| |v392^a+|; |)/"Personnel: "d300,(||v300^f|: |,||v30 
0^c||,| |v300^b||,| |v300^a+|; |),mdl/("Institution(s): "V310(14,14)/)/"Address: 
 "d430,v430^a(9,9)/v430^b(9,9)/v430^c(9,9)/v430^d(9,9)/v430^e(9,9)/v430^f(9,9) / 
"Phone: "v430^h(9,9)/"Telegraphic address: "v430^i/"Telex: "v430^j/"FAX: "v430^k 
/"EMAIL: "v430^l,"Project no(s): "v125/"Contract no(s): "v130/"Start and end dat 
es: "v448^a/"Duration: "v850/"Current status of project: "v860/("Descriptors: "v 
620^a+|, |)/"Geographical area: "v630^a+|, |/"Discipline: "v832/"Working languag 
e(s): "v040/"Human resources: "v700/"Financial resources: "v710/"Income componen 
ts: "v715/"Expenditure components: "v716/"Resources: "v705%"Class. no(s).: "v610 
+|; |%fi%c70,f(MFN,1,0)/## 
 
Figure 13.7 Print format for factual database 
 
A Field Selection Table for the inverted file should be prepared.  The system is set up to 
implement the subfields of the CCF/F format. 
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if p(v60) then @ccfisb else, 

if v62:'PRO' then @ccfpro else, 
if v62:'PER' then @ccfper else, 

if v62:'INS' then @ccfins else, 
'No format display for this record'  

fi, 
fi, 

fi, 
fi 

 
Figure  13.8 Print format calling other formats 
 
 
13.5 LIBRARY HOUSEKEEPING SYSTEMS 
 
The applications covered so far in this chapter can be implemented using the standard 
CDS/ISIS package. However, if you wish to use CDS/ISIS as a complete library automation 
package, you will have to acquire or develop yourself additional programs most probably 
written using ISIS_DLL. 
 
Full cataloguing facilities are already available; it is a question of setting up the database in 
the correct way and a UNIMARC database such as the one in Section 13.3 could be used for 
this. It is possible to control library circulation, merely by having a field for borrower or a 
borrower code to speed up entering which could be linked using the REF(L) function to a 
borrower database. Date of borrowing and/or return can be put in the catalogue record. You 
could use cut and paste for the date of issue. When the book is returned, the date is deleted. A 
search on this date field will result in the retrieval of all those items borrowed before a 
particular date and not yet returned. A list could be generated automatically and printed out. 
If there is a link to a borrower database, the names and addresses from those can be included 
in the overdue notices. Acquisitions can also be handled. If you link from the catalogue to a 
supplier database, it is possible to have a catalogue database which contains records of items 
on order as well as records of items already in the library. If a code is added to each record to 
show the status of the item as on-order, and if this is changed on the item's acquisition, it is 
possible to hide items that are not yet in the library from public view.  
 
However, to set up and use these without any additional programming could result in an 
unfriendly package. A number of library system applications have been written based on the 
DOS version of CDS/ISIS and packages based on the Windows version are now being 
developed. 
 
 
13.6 PUBLISHING DATA ON THE WEB 
 
There are special programs which use web server tools such as CGI (Common Gateway 
Interface) to search a database in the usual CDS/ISIS format, but these take some effort to set 
up: we refer to them in Section 14.2.2 but they are beyond the scope of this Handbook. 
Nevertheless, if you have access to a web server you can produce HTML data from your 
CDS/ISIS database without going to the trouble of acquiring one of these web-based versions 
of CDS/ISIS. Indeed, even if you do not have a web site, you can try this out since you can 
produce a file which you can then read on your own computer and then send it over the  
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internet, perhaps by e-mail, or on diskette to someone who can publish your file on the World 
Wide Web. 
 
Open any database: we will use the sample database CDS. Choose Edit ⇒ Print Formats ⇒ 
New and enter as PFT Name CDSHTM. Click on OK, and say Yes to launch the Print 
Format Assistant. Choose HTML Table with Headers and click OK and OK a second 
time. You now have a print format which will produce simple HTML code. 
 
Now choose Database => Print. Click on MFN Range and enter a range (say 20/50) in the 
text box. Output to ASCII file (Windows-ANSI) and change the pre-defined format to 
CDSHTM. Leave all the other values as they are. Click on Print and in the Save file box give 
the file a name with the htm extension, e.g. cds.htm. Click on OK. Choose from the 
Windows task bar Find ⇒ Files or Folders Named ⇒ cds.htm (it will probably be in the 
winisis\work folder). If your computer is set up to associate HTM files with a browser 
program it should launch it automatically and you will see the records presented in an 
attractive table layout.  
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UNESCO, 1992 (PGI-92/WS/9) 
3. CCF/F : the Common Communication Format for Factual Information. Paris, UNESCO, 
1992 (PGI-92/WS/8) 
4. UNIMARC manual. London, IFLA, 1987. 
5. UNIBASE: UNIMARC demonstration database: user manual with diskette / prepared by 
the Biblioteca National de Portugal for the IFLA UBCIM Programme. Lisbon, Biblioteca 
National, 1993 
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14 FURTHER INFORMATION AND USEFUL 
ADDRESSES 
 
 
14.1  FURTHER READING 
 
The documents listed here are not all published commercially and may not be easy to obtain 
in every case. Many other documents are available in languages other than English. 
 
There is a bibliography on CDS/ISIS available on the internet updated to 1998: 
 
Spinak, Ernesto. A bibliography on CDS/ISIS, compiled by Ernesto Spinak with the 
assistance of Francesco Dell'Orso. 1998. http://www.bib.wau.nl/isis/biblio.html 
 
14.1.1 DATABASE DEFINITIONS AND SAMPLE DATABASES 
 
These databases were created for CDS/ISIS for DOS but are equally usable under the 
Windows version. 
 
Di Lauro, A., IDIN manual for the creation and management of a bibliographic database 
using Micro-ISIS, Paris, OECD, 1988, 189p (includes diskette) 
 
Di Lauro, A., Manual for preparing records in microcomputer-based bibliographic 
information systems by Anne Di Lauro, with annexes for implementation by Ed Brandon, 
Ottawa, IDRC, 1990 (IDRC-TS67e). Also available in French. Includes a diskette with a 
number of PASCAL programs. 
 
Hopkinson, Alan. International Information System on Cultural Development: CDS/ISIS 
model database: manual and accompanying diskette. Paris, UNESCO, 1994 (PGI-93/WS/16 
 
14.1.2 CDS/ISIS MANUALS 
 
The main UNESCO documentation in English is: 
 
1. CDS/ISIS for Windows Reference manual (version 1.3), Paris, UNESCO, 1998. 
 
2. Winisis - supplement to the Reference Manual: versions 1.0-1.3. Paris, UNESCO, 
November 1998 
 
3. CDS/ISIS for Windows - version 1.4 January 2001: notes and format examples. Paris, 
UNESCO, 2001 
 
4. Mini-micro CDS/ISIS reference manual (version 2.3), Paris, UNESCO, 1989. 
 
This list includes only those in the English language. Older manuals are included for the 
formatting language: although it has been added to as different versions have been released 
the basics remain the same and are therefore not repeated in the later manuals. 
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The documents below complement the official manuals: 
 
Nowicki, Zbigniew M. New features of the WinISIS system: guidebook for users of CDS/ISIS 
for DOS, Geneva, International Trade Centre, 2001  
 
Spinak, Ernesto, Utilities for MICROISIS, 2nd ed., Washington, DC, PAHO HQ Library, 
1992 
 
Thomas, Jeannine, An abridged version of CDS/ISIS reference manual, version 3.0, rev. 
version, Geneva, International Bureau of Education, 1992. 
 
14.1.3 JOURNAL ARTICLES 
 
ASTINFO newsletter has a Mini-micro CDS/ISIS corner 
 
Information development contains a column 'CDS/ISIS information' by Alan Hopkinson 
 
 
14.2  PUBLISHING CDS/ISIS DATABASES 
 
14.2.1 CD-ROM  
 
CDS/ISIS databases have been published on CD-ROM for some time. UNESCO Clearing 
House Centre published the UNESCO Databases CD-ROM which originally used the 
ISISCD software. It has reached its 8th edition which now uses CDS/ISIS for Windows. It 
contains bibliographic references of all UNESCO documents and publications, worldwide 
specialized bibliographies on education, museums, monuments and sites and includes a 
worldwide directory of institutions in social sciences (DARE), and the UNESCO and 
International Bureau of Education (IBE) Thesauri. It also includes UNESCO's sales 
catalogue. The CD-ROM is available for Euros 45.73 from UNESCO Sales agents1. 
 
14.2.2 CDS/ISIS DATABASES ON THE WEB 
 
As we said in the introduction, this Handbook covers only CDS/ISIS for Windows and 
therefore does not include information about how to put your CDS/ISIS database on the 
World Wide Web. There are a number of tools to do this, each with their own documentation. 
The original, official package is WWWISIS from BIREME 
(http://www.bireme.br/isis/I/wwwi.htm) which will allow you to publish a CDS/ISIS 
database on a web server running under HP-UX, Windows NT, LINUX or Sun Solaris. This 
is supplemented by an application, IAH, the Web Retrieval Interface. You can read about this 
at http://www.bireme.br/isis/I/iah.htm 
 
You can see this interface in use at http://www.bireme.br/bvs/I/ibd.htm 
 
Links to other software packages are found on UNESCO’s website at 
http://www.unesco.org/webworld/isis/cds_isis_sites.htm   
 
JavaISIS is somewhat easier to set up though it requires a JavaISIS client to access a Java 
host database.  It is therefore not so universally accessible as server packages which can be  

                                                           
 

http://www.unesco.org/webworld/isis/cds_isis_sites.htm
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used with a normal internet web browser such as Netscape or Internet Explorer. The website 
for this is http://web.tiscali.it/javaisis  
 
 
14.3  EXTENDED ROMAN AND NON-ROMAN SCRIPTS 
 
CDS/ISIS can be customized for different languages (see Section 12.4). The range of 
characters depends on those available on the workstation. Different fonts are available in 
Windows catering for varying ranges of extended roman characters and for other scripts. 
Your computer dealer should be able to help you with Windows fonts. You can change the 
current ones by clicking on Start ⇒ Settings ⇒ Control Panel ⇒ Display. Click on each 
item under Item and ensure that each one which has a font attached has the font which uses 
your desired script. You will also have to ensure that the correct fonts are prescribed in 
System Settings (see Section 12.5.3). 
 
CDS/ISIS for Windows does not yet work with UNICODE. However, the latest version does 
work with right-to-left entry. Some non-roman scripts such as Arabic require this. UNESCO 
have worked on this with the Arab League Documentation Centre who can give advice. 
 
In South-East Asian countries such as China, Thailand and Vietnam, national institutions 
with responsibility for CDS/ISIS and occasionally other users have developed strategies for 
dealing with CDS/ISIS. Sometimes you may find solutions incompatible with each other in 
concurrent use in different institutions.  
 
With many of the non-roman scripts, special solutions have to be found within CDS/ISIS for 
difficulties with indexing (the inverted file) and sorting.  
 
 
14.4  USEFUL ADDRESSES 
 
As stated elsewhere, we have not included the names of national distributors or user groups in 
this Handbook because they are subject to change. 
 
ASTINFO Newsletter 
DOST Complex 
Bicutan 
Tagig 
Metro Manila 
Philippines 
 
IFLA UBCIM Programme 
Deutsche Bibliothek 
Zeppelinallee 4-8 
D-60325 Frankfurt 
Germany 

http://web.tiscali.it/javaisis
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Mr Davide Storti 
UNESCO 
Communication and Information Sector 
7, place de Fontenoy 
75352 Paris 07 SP 
France 
 
14.4.1 UNESCO PARTNERS IN CDS/ISIS 
 
WWWISIS, C-ISIS, ISIS_DLL 
BIREME 
Rua Botucatu, 862 
Sao Paolo/SP 
Brazil 04023-901 
 
 
JavaISIS 
Associazione per la Documentazione, le Biblioteche e gli Archivi (DBA)  
via G del Plan dei Carpini, 1 
50127 Florence 
Italy 
 
Arabization 
ALDOC: Arab League Documentation Center 
E-mail: aldoc2k@menanet.net 
 
Chinese, Japanese and Korean 
KINITI (Korea Institute of Industry and Technology Information) 
206-9 Cheongryangri-dong 
Dongdaemun-ku 
Seoul 
Korea 130-742 
 
 
REFERENCES 
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INDEX 
 
Filenames are printed in bold, e.g. 
syspar.par. Commands are printed in 
Courier font in lower case, e.g. xcopy. 
Menu options are in bold, e.g. Expert 
search. The references are to Section 
numbers and where there are several the 
most important one is in bold. 
 
 
$ (dollar)7.4 
% 6.1.3 
* (and) 7.5 
.csv 9.5 
.exe 2.3 
.exp 4.10, 7.3 
.iso 9.2, 10.7 
.jpg 5.7 
.mst 4.10, 10.9 
.par 4.9, see also syspar.par, dbn.par 
.rtf 8.2 
.stw see stopword file 
.wpr 8.9, 12.6 
: (contains) 7.10 
; (semicolon) 5.4 
^ (not) 7.5 
| (bar) 5.4 
+ (in FST) 8.8 
+ (or) 7.5 
< > (used in sorting) 4.7 
< (less than) 7.10 
> (greater than) 7.10 
 
a (absence of field) 7.10 
AACR 8.10, 13.3 
access to editing 12.8 
added entry 8.10 
address see names and addresses (in 

databases); useful addresses 
all (*ALL*) 7.2.3 
alternate search result tool bar 7.2 
and (boolean operator) 7.5 
ANY file 7.6 
application software 2.1 
arabization 14.3 
articles, ignoring in sorting 4.7 
ASCII 2.9.8. 9.1, 9.4 
authority file 13.3 

 
backing up (database) 9.7 
bg 3.1 
bibliographic information 1.2 
bibliography 14.1 
BIREME 1.1.3, 14.2 
bold 5.6.4 
boolean operator see logical operator 
borrower file 13.5 
box 5.6.5, 12.5.1 
bpict 5.7 
bracket 7.8 
Brazil, see BIREME  
Browse 7.2 
browsing records 6.6, 7.2 
 
C [programming language] 1.1.2 
C++ 1.1.2, 1.1.3 
cards see catalogue cards 
carriage return 9.1 
case (upper, lower) 5.2 
catalogue cards 8.10, 13.3 
catalogue cards, printing of 8.7 
categorization 2.5 
CCF see Common Communication Format 
CD see Compact disk 
CDS/ISIS for Windows passim 
CDS/ISIS for Windows: history 1.1.2 
CDS/ISIS for Windows: overview 1.2 
CDS/ISIS: availability 1.5 
CDS/ISIS: DOS version 1.1.1, 4.4 
CDS/ISIS: DOS version: compatible 

format 4.5 
CDS/ISIS: history 1.1 
CDS/ISIS: name 1.1 
CDS/ISIS: release 19b 1.1 
CDS/ISIS: UNIX 1.1.5 
CDS/ISIS: VMS 1.1.5 
cdscol 7.2.2 
centring text 5.6.5 
Change profile 3.4.2, 12.8 
changing appearance of screens 12.5 
character sets see font 
check box 2.7.7 
China 14.3 
choice 4.4 
circulation system 5.9 
C-ISIS 1.1.3 
cl 12.5.1 
clicking 2.3 
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clipboard 1.4, 8.2 
Close (CDS/ISIS menu option) 1.4 
cmd 5.10.2 
colour 5.6.2, 12.5 
column 8.7, 8.10, 8.11 
combo box 2.7.3 
comma delimited file 9.1, 9.5 
command button 2.7.4 
Common Communication Format 1.8, 

13.2, 13.4 
compact disk 2.2, 14.2.1 
compacting a database 10.7 
compiling Pascal programs 11.2.1 
conditional 5.8 
conditional literal 5.4 
Configure (CDS/ISIS menu option) 1.4 
contains 7.10 
control characters 9.1 
Control panel (Windows) 12.5 
copy (DOS command) 3.5 
copying files 2.9.4 
copying text 2.9.8, 6.1.2 
corrupted database 10.9 
cover (in printing) 8.5 
creating a new record 6.2 
csv 9.5 
ct3dv2.dll 3.3 
ctl3d 3.1, 3.3 
Ctrl 6.1.2 
customization 12 
cutting 2.1, 2.9.8, 6.1.2 
 
data (folder) 3.1 
data element 4.1 
Data entry 1.4, 6 
Data Entry Worksheet 4.2, 4.3 
data entry worksheet font 12.5.3 
data entry: percent sign 6.1.3 
data entry: special keys 6.1.2 
data extraction format 4.6 
data indentation 8.6 
data mode 5.2 
Database (CDS/ISIS menu option) 1.4 
database creation 4 
Database Definition Wizard 1.3 
database locking 3.4.3 
database management system 1.2 
database parameter file see dbn.par 
database structures, importing 3.5 
database, default 12.7.2 
database, sample 14.1.1 
database: reinitialize 3.5 

date(type) (formatting language) 11.3 
datestamp (Pascal routine) 11.2.2 
db (formatting language) 11.3 
DB/Textworks 9.5 
dBase 1.2 
dbase file 9.1 
dbn.par (dbname.par) 3.1, 3.4, 4.9 
Decorated Format 4.5 
default display format 7.2.3 
default menu files 12.2, 12.4 
default messages 12.3, 12.4 
default search display 7.2 
default value (data entry) 4.4, 10.3, 6.5 
deleting fields 6.1.4 
deleting files 2.9.6 
deleting records 6.4 
desk top publishing 8.4 
desktop 2.6, 2.8 
dialog box 2.7 
Dictionary 1.4, 7.3 
Dictionary Assistant 4.6 
dictionary display 7.3 
directory (ISO 2709, MARC) 1.2 
directory: DOS 2.5 
directory database 13.4 
disk drive 2.2 
disks, splitting files across 3.5 
Display Format 4.2, 7.2.3, see also 

formatting language 
display format, default 4.5 
displaying pictures 5.7 
displaying search results 7.2 
distributor 1.5 
dlmexp.pcd 9.5 
doc (folder) 3.1 
documentation 3.1 
dollar sign 7.4 
double clicking 2.3 
dragging 2.3 
drive A, drive B, drive C, etc. 2.2 
drive letter 3.4 
 
editing: files 2.9.8 
editing: records 6.1, 6.3 see also global 

editing 
editor see text editor 
else 5.8 
empty fields, displaying 6.1.1 
entry lock 3.4.3 
EOC (end of column tolerance) 8.10, 8.11 
exchange format 1.8, 13.2 
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exe files 2.3 
Exit (CDS/ISIS menu option) 1.4 
exp file 4.10, 7.3 
Expert search 1.4, 7.1.2, 7.10 
Explorer (Windows program) see 

Windows Explorer 
Export 1.4, 9, 10.6 
exporting in ISO 2709 format 9.2 
extended Roman 14.3 
extension see .exe (etc) 
 
f (function) 12.5.1 
Fangorn 9.1, 9.4 
FDT 4.2, 4.3, 10.2, 13.3 
fi 5.8 
field 1.2, 4.1, 4.6, 4.6, 5.1, 7.9 
Field Definition Table see FDT 
field name 4.3 
Field Selection Table see FST 
field separator 9.2 
field zero see v0 
field, adding: data entry 6.1.3 
field, repeatable see repeatable field 
file 2.9 
file name 2.4 
file, copying 2.9.4 
file, deleting 2.9.6 
file, displaying 2.9.3 
file, moving 2.9.5 
files, editing 2.9.8 
files, recovering 2.9.7 
files, system, CDS/ISIS 3.1 
fileserver 3.4 
filing see sorting 
Find (Windows option) 2.8.6 
finding files and folders 2.9 
floppy disk 2.2 
folder 2.5, 2.9 
folder structure 3.1 
font 5.6.1 
font, extended roman 14.3 
font, non-roman 12.7.1, 14.3 
font size 5.6.3 
fonts table 5.6.1 
forename 1.2 
formatting language 1.2, 5, 14.1.1 
format language, extended 11.3 
format variables 11.3 
free-text searching 7.10 
fs (function) 12.5.1; see also font size 

FST 4.2, 4.6, 5, 8.8, 8.10, 9.1, 9.5, 10.4, 
10.7, 13.3 

full version 3.4.2 
function key F2 6.1.2 
 
General (in Printing) 8.4 
General Information Programme 1.5, 1.7 
German: adding menus, messages 12.4 
gizmo conversion file 9.2, 9.3 
global editing 10.6 
graphic file 5.7 
graphical user interface 2.1 
group see repeatable group 
Guided search 1.4, 7.1.1 
 
heading format 8.8, 8.10 
heading mode 5.2 
heading processing indicator 8.8, 8.10 
heading (sorting) 8.8, 8.10 
Help 1.4 
help message (data entry worksheet) 4.4, 

10.3 
highlighting (retrieved terms) 7.2.2 
hit file 9.2, 9.6 
HP-UX 14.2.2 
HTML normal (print format) 4.5 
HTML Table with Headers (print format) 

4.5, 13.6 
hypertext 5.10 
 
I/F Update (CDS/ISIS menu option)1.4 
icon, small 2.6.4 
IDIN 4.1.1 
IDIS 13.1 
IDRC 1.1, 4.1.1 
if 4.4, 5.8 
IFLA UBCIM Programme 13.2 
Import (CDS/ISIS menu option)1.4, 9, 

10.6 
importing database structures 3.5 
indentation 5.3 
index 4.6 
indexing technique (2) 4.4 
indexing technique 1.2, 4.6, 4.8 
indicators 13.3 
information retrieval 13 
input file 9.3 
input line length 9.3 
installation 3 
installation on network 3.4.1 
inverted file 1.2, 4.6, 6.7, 7.3 see also 

Dictionary 
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ISBD 13.3 
IsisAscii 9.4 
ISISCD 1.3, 14.2.1 
ISIS_DLL 1.1.2, 1.7, 4.4, 11.1, 12.1, 13, 

13.5 
ISO 2709 1.2, 9.1 
iso file 9.2, 10.7 
italic 5.6.4 
 
JavaISIS 1.1.4 
jpg files 5.7 
justifying text 5.6.5 
 
key see sort key 
 
l (function) 5.9 
labels 8.11 
labels, printing of 8.7 
language, default 12.7.1 
language, adding 12.4 
Latin America 1.1 
layout 5.3, 8.10 
length of sort key 8.8 
library housekeeping system 13.5 
link 5.10, 5.10.1, 5.10.3 
linking 5.9 
LINUX 14.2.2 
list box 2.7.2 
literal 5.4 
load 9.3 
loading CDS/ISIS 3.3 
locking 3.4.3  
logging on 2.8 
logical operator 7.5, 7.10 
 
m 5.6.5, 8.11 
mailing list 1.7, 13 
main menu 1.4 
MARC 9.4 
MARC21 1.8 
margin 8.5, 8.10, 8.11 
marked records 1.4, 8.4 
marking records 7.2.4 
master file 1.3 
master file number 5.1, see also mfn 
memory space 3.3 
menu (folder) 3.1 
menu bar 2.6.5 
menu database 12.2 
merge 9.3 
message database 3.1, 12.3 

message file 3.1 
mfn 9.2, 9.3 
mfn range 8.4 
mfn search 7.10 
microcomputer 2.1 
Microsoft Access 1.2 
MINISIS 1.1 
MNENDF 12.2 
MNENSH 12.2 
mode 5.2 
model record 6.5 
modifying database 10 
mouse 2.3 
mouse button 2.3 
moving (files) 2.9.5 
moving text 2.9.8, 6.6.6 
MS-DOS prompt 2.1 
msg (folder)3.1 
mst file 4.10, 10.9 
mstrcv1 10.9 
multi 4.4 
multi-access 1.3 
multi-lingual 1.2 
 
name see field name 
names and addresses 13.5 
national library 13.3 
network 1.1.1, 3.4.1 
New (CDS/ISIS menu option)1.4 
new line 4.5 
new page 5..6.5 
nocc 11.3 
not 7.5 
Notepad (Windows program) 2.9.8 
Novell 3.4.1 
np 5.6.5 
numbering pages 8.7 
numerical applications 13.1 
 
occ 11.3 
occurrence see repeatable field 
occurrence selector 5.1 
Open (CDS/ISIS menu option) 1.4 
Open Dictionary (CDS/ISIS menu 

option) 7.3 
OPENFILE 5.10.1 
operating system 2.1 
or 7.5 
output file 9.2 
output line length 13.3 
output tag for mfn 9.2 
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p (presence of field) 7.10 
page number 8.7 
par file 4.9; see also syspar.par, dbn.par 
parameter files: password 12.8 
Pascal 1.2, 11,13.2, 14.1.1 
Pascal programming library 1.1.1, 11 
password 12.8 
pasting 2.1, 6.1.2 
pattern 4.3 
pbrush.exe 5.10.3 
percent sign, entering in data 6.1.3 
pft see print format 
PGI see General Information Programme 
pick-list 4.4, 10.3 
pict 5.7 
picture 5.7 
pkzip 9.7 
plugin 3.1 
point (font size) 5.3 
pointing 2.3 
postscript 8.4 
prefix (inverted file) 7.3 
presentation 8.5 
preview 8.4 
print format 5, 8.4, 8.5, 8.10, 8.11, 10.5, 

13.3, 13.4 
print format display font 12.5.2 
Print Format Assistant 4.5, 10.5 
Print Format Wizard see Print Format 

Assistant 
Print Setup 1.4, 8.1 
Printer see printing 
printing 8, 8.8, 8.10, 8.11 
printing messages 12.3 
prog 3.1 
programming 11 
Programs (Windows menu option) 2.1, 

2.8.4 
proof mode 5.2 
proximity operator 7.7 
publishing 13.6, 14.2 
 
qc 5.6.5 
 
radio button 2.7.5 
range: mfn 9.2 
read only 12.8 
Recall saved search 1.4 
record (0) 1.3 
record height 8.6, 8.10, 8.11 

record identifier 13.3 
record linking 1.3 
record locking 3.4.3 
record separator 9.2 
record structure 1.3, 9.1 
recovering corrupted database 10.9 
recovering files 2.9.7 
ref 5.9, 10.7, 13.3, 13.5 
reference manual 14.1.2 
reformatting FST 9.3, 13.3 
reinitialize database 3.5 
relational database 9.5 
renumbering records 9.2 
repeat 4.4 
repeat separator 6.1.3 
repeatable field 1.2, 4.1, 4.3, 4.6, 6.1.3, 

9.5, 11.2.2 
repeatable group 5.4, 5.5 
repeatable literal 5.4 
repeatability: headings 8.8 
restoring (database) 9.7 
Rich Text Format see rtf 
right button 2.3 
rtf 8.2 
Run (Windows option) 2.8.5 
Running Pascal programs 11.2.1 
 
Save search 7.11 
saving print format 10.5 
saving print specification 8.9 
saving searches 7.11 
scripts see fonts 
search 7, see also guided search 
search expression 7 
search history box 7.1 
search language 1.2 
search only 3.4.2, 12.2, 12.8 
search, sequential see sequential search 
searching see search 
sequential search 4.6 
serial searching see free-text searching 
shut down (computer) 2.10 
size, font 5.6.3 
size 4.4 
size(format)11.3 
slash (/) 4.5 
sort key 8.8 
sort key length 8.8 
sorted hit file 9.2 
sorting 4.7, 8, 8.3, 8.8 
sorting a database 9.6 
source code: Pascal 11.2.1 
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sources of Pascal programs 11.4 
South-East Asia 14.3 
spin box 2.7.6 
splitting records across pages 8.7 
ss (formatting language) 11.3 
Start button 2.1, 2.8.3 
stopword file 2.9.8, 4.7, 8.8 
string 7.10 
stw file see stopword file 
subdirectory see subfolder 
subfield 1.2, 4.1, 4.3, 5.1 
subfield separator 9.3, 13.3 
subfield, repeatable 4.6 
subfolder 3.1 
surname 1.2 
switching off (computer) 2.10 
syspar.par 1.1.1, 1.4, 3.1, 3.2, 12.2 
syspar.par (parameter 0) 3.4.1, 3.5 
syspar.par (parameter 1) 3.2 
syspar.par (parameter 2) 3.2 
syspar.par (parameter 3) 3.2 
syspar.par (parameter 4) 3.2, 3.4.1, 3.4.2 
syspar.par (parameter 5) 3.2 
syspar.par (parameter 6) 3.2, 12.8 
syspar.par (parameter 8) 6.1.3 
syspar.par (parameter 14) 3.4, 3.4.1 
syspar.par (parameter 101) 12.7.1 
syspar.par (parameter 102) 3.4.2, 12.8 
syspar.par (parameter 125) 12.7.2 
syspar.par (parameter 130) 6.7 
syspar.par (parameter 1001 ff.) 12.7.3 
 
tab 2.6.3, 5.6.5 
table (for displaying search results) 7.2 
tabulation 5.6.5 
tag 4.2, 4.3 
tag (formatting language) 11.3 
task bar 2.6.2 
task bar: features 2.6.4 
temporary file 3.4.1 
text editor 2.9.8 
text entry box 2.7.1 
textbox 5.10.3 
textboximg 5.10.3 
Thailand 14.3 
title (in printing) 8.5 
toolbar 2.6.6 
truncation 7.4 
Turkish 12.7.1 
twip 5.3, 8.11 
type of field 4.3 

 
UK MARC 9.4 
unconditional literal 5.4 
underlining 5.6.4 
UNESCO passim; see also General 

Information Programme,  
UNICODE 14.3.3 
UNIMARC 1.8, 8.10, 13.2, 13.3 
UNISIST 1.5 
UNISIST Reference manual 1.8 
unlocking see locking 
update 9.3 
updating inverted file 6.7 
useful addresses 14.4 
user group 1.7 
Utilities (CDS/ISIS menu option) 1.4 
 
V0 (variable field 0) 5.1 
val 5.9, 7.10 
validation file 1.2, 6.1.5 
validation format 4.4, 10.3, 13.3 
Viet Nam 14.3 
 
while 12.5.1 
Windows 95 2.4 
Windows backup program 3.5 
Windows bar 2.6.1 
Windows Explorer (Windows program) 

2.9.2, 2.9.4, 2.9.5 
Windows: different versions 2.1 
Windows NT server 14.2.2 
WinIDAMS 13.1 
Winzip 9.7 
work 3.1 
working folder 2.5, see also work 
worksheet 12.6, see also Data Entry 

Worksheet 
workstation 3.4 
World Wide Web 13.6, 14.2.2; see also 

WWWISIS 
wpr file 8.9, 12.6 
WWWISIS 1.1.3, 14.2.2 
 
X (icon) 2.6.4 
xcopy (DOS command) 3.5 
 
zip files 3.5 
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